


Customs
Uph(old)ing

■■ editorial

The Indian government recently announced its discovery of the fact
that over 80 per cent of cell phone users in India are using instruments that
were purchased from the gray market.

While this might be a surprise to some, it isn’t exactly news. Every major
metro has its own version of the ‘smugglers arcade’—a Palika Bazaar in Delhi
or a Heera Panna in Mumbai—where people flock to buy anything from the
latest Nokia handset to the PlayStation 2 for a reasonable price.

And this also holds true for the computer industry in India. The difference
in the price of a product in the US and here is considerable. The main reason
for the differential obviously is the customs duties levied on products that are
imported into India. A handheld computer that costs a relatively affordable 
Rs 8,000 in Singapore ends up costing you about Rs 15,000 by the time it arrives
on our shores.

Is it any surprise then that there exists a thriving gray market for digital
devices? After all, the alternative is to settle for something that is older or lacks
features compared to another that we would prefer. This has also resulted in
the Indian consumers having to accept, in some cases, obsolete technology
products that do not find markets in other parts of the world.

The initial purpose of customs duties was to protect the fledgling Indian
industry and create an environment in which it could grow. While there are
still instances in which such a philosophy makes sense, globalisation means
that in some cases it has outlived its purpose. 

Eliminating customs duties might not make sense for products like desk-
top PCs because there exists a thriving industry of local assemblers and man-
ufacturers, but there is no reason that the same rule be applied to components
like processors and graphics cards or other products like digital cameras, which
are just not manufactured indigenously. The likelihood of an Indian manu-
facturer deciding to develop a processor that takes on Intel’s best is extremely
remote.

In the current context, it really makes sense for the government to com-
pletely eliminate customs duties for products or components that are not
being manufactured in India. This would eliminate the need for the exis-
tence of the gray market and will also help us get more value for the rupee
that we spend.

karan_manral@jasubhai.com

“There is no 
reason why
customs duties
should be
applied to 
products which
are just not 
manufactured
indigenously”

Karan Manral
Assistant Editor

27



FEATURES
56 A look into the love relationship

between the Mac user and his
machine

TEST DRIVE
62 Our laptop test and what the scores

said

84 Agent 001 sniffs out the best in
gaming peripherals

INSIGHT
92 Chop that monstrous DVD flick

down to size with DivX encoding

94 A designer's guide to online
resources for fonts, plugins, filters
and the works!

97 Getting to know your PC’s BIOS

98 A comprehensive guide to trou-
bleshooting 

ARCADE
130 Get into the thick of things with

these tips on Diablo II

136 Get a fresh perspective with these
five little-known search engines

INSIDE

Working the Web cam beat 
Lessons on setting up a Web cam,
using it as a security camera and for
still pictures 

89

54

6 MARCH 2002

The games to come
Take a look at what’s coming your way 
in 2002

Working with Windows XP
Tips on getting up close and personal
with XP

109

72

126

32

■ magazinecontents ■

M
A

R
C

H
 2

00
2

86 The Terapin story
Say goodbye to the old VCR and wel-
come the Terapin recorder

All this for FREE
30 FREE software to
add to your kitty

Technology
goes to war
The age of the
Terminator
approaches as
technology alters
the way wars are
fought

GENi beckons
A sneak peek at the GENi



MARCH 20027

NEWS FEED 21

LETTERS 30

DROOLMAAL 54

START UP 60

BAZAAR 79

QUICK START 97

Q & A 98

GAMES, BOOKS AND CDS 132

WIDE ANGLE 136

DIGIT DIARY 138

BACKBYTE 140

To subscribe to Digit, fill out the
subscription form available online at
www.thinkdigit.com/subscribe

R
E

G
U

L
A

R
S Asus V8200 Ti500 Deluxe

Creative PC-CAM 300
HP DVD-Writer 100i
HP ScanJet 5400 scanner
Intel Northwood 2.2GHz
Processor
IOGEAR ShareView
IOMEGA Panther
Logitech Clicksmart510
Maxtor D540X 160 GB
hard drive 
Philips 107B3 Flat 
monitor

ACI Profile 2860
ACI Profile3270
ACI Xtreme
Cerebra
Compaq Armada  E-500
Compaq Presario 1722
Compaq Presario 1725
Sharp AR-50

Sharp Muramasu UM10
Zenith One Up

EasyOffice Premium
ISM 2000 Office
MGI PhotoSUITE 4.0
PowerARCHIVER v7.02
The Sleuthhound! Pro 3.2
WebCam-Control-Center
5.5

Address Organizer
Antivir Personal Edition
AvirMail 1.70
Bookmark Manager
CesarFTP 0.99e FTP 
server
Crazy Browser 
CyberKit 2.5 Network
Utility
Dzsoft Favourites Search 
EmC 5.0
Exact Audio Copy

ICQ Color Picker
ImageWalker 2.01
Interchat 2.1.43
MBM 5.1
MicroDVD 1.2
PhotoPlus 5
Quickdialer
SmartFTP 1.0.966
Sygate Personal Firewall
4.2.872
TaskZip
Turbo Navigator v1.46
UltimateZip 2.6
UltraWipe 1.51
VNC v3.3.3r9 Remote
Control
WebPlus 1 HTML editor 
WebFerret Version 4
We-Blocker 2.0.82
Wingrab 1.5
Xenu Link Sleuth 1.2b
X cleaner

HARDWARE 79

LAPTOPS 62

SOFTWARE 79

FREE SOFTWARE 72

32
Intelligent machines that
do the fighting for you

109
Crank up Windows XP to
work better for you

94
Tap the Internet
for fonts, plug-
ins, filters, stock
images and more

126
Great games that you can look
forward to

98
The PC troubleshooting guide

72
Free alternatives that work
just as good as commercial
software 

56
Why owning a Mac bor-
ders on fanaticism for
some while others remain
skeptical

Reviewed this month



content ■
■ digit interactive

Newsletters
■■  A bunch of newsletters
on the hottest products
out there

Bookmarks
■■ Take a look at what the
future holds for you with a
Tarot reading from these
horoscope sites

Test Drive
■■ 30 of the best free soft-
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Arena: Top Gun
Serious Sam: The  Second Encounter

The locations may be different, the weapons more
effective but the object remains the same. Its time to  get
your hands bloody again with this highly addictive first

person shooter. And this time  round there are a lot more
bad guys to put away!

Inside the CDs
PhotoPlus 5
Get your hands on the full, free version
of Photoplus 5 and really dig into all

your image editing tasks. This sofware
is your best bet if you want a cheap
solution for working with images for
print or the Web

Software

Music
Shake your body to these tracks featuring Gorgeous Girl,
Icebird and John Davies and Nick James

Gallery
Go on a treasure hunt for the coolest of wallpapers,

screensavers, themes and Winamp skins. 

and Droolmaal...
You can stare at these beauties all

you like. They don’t mind!

30 FREE

All that’s FREE
If you’re looking for some  alter-
natives to expensive commer-
cial software then we have just
the round up for you. Browse

through this exten-
sive list of 30 free
software under vari-
ous categories includ-
ing HTML editors,
Hardware monitoring
tools, audio encoders/
converters and more

PLUS
FileAmigo LE v2.3.0, Windows
Help Designer v3.1.24, MusIRC
v4.3, Stellar Phoenix v8.0
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Need tips on buying hardware or software?
Agent 001 is your man. Submit your query
at our Web site and get the advice you seek

A Window to Linux
Struggling with learning to use Linux? Let
KDE make your day.
Our detailed workshop might tempt you to
give up on Windows.

Reviews Forum

Web Special

get your taste of digit online at http://www.thinkdigit.com

Netreturns

The Internet is
a treasure
trove of
resources for
designers. We
guide you on
where you can
find the tools

you need to unleash your creativity. Go ahead and
become a master of digital artistry.

Looking for Designerware?

If you have a passion
for computing
hardware and software
our Radar section is
just the thing for you



service ■
■ colophon

12 MARCH 2002

Chairman and Publisher 
Jasu Shah
Associate Publisher and 
Editor Maulik Jasubhai
Assistant Editor Karan Manral
Editorial 
Writers Anil Patrick R., Sriram Sharma,
Vidyaramanan S., Avina Lobo, 
Prashant Masrani
Features Editor Sveta Basraon 
Copy Editors Anshul Chauhan, 
Julian Vongeyer, Roopa Sukumaran
Design
Art Director Marshall Mascarenhas
Design Shivasankaran C. Pillai, Shyam
Shirsekar, Jaya Shetty, Neeta Wadiker,
Solomon Lewis, Ashwin Boricha,
Mahesh Benkar, Ram 
Photographers Mexi Xavier, 
Jiten Gandhi
Test Centre
Head Marco D’Souza
Deputy Head Hatim Kantawalla, 
Reviewers Aliasgar Pardawala, 
Yatish Suvarna, Mitul Mehta
Co-ordinator Gautami Chalke
Multimedia
Co-ordinator V. Ravi Shankar 
Kabir Malkani, Jo-Ann Rodricks,
Priyamvada K.K., Liu Ai Chin, 
Vaibhav Kapoor
Media Studio
Bimal Unnikrishnan, Priya Ramanathan,
Afzal Mazgaonkar, Prasanth Uyyul
Production
General Manager Shivshankar
Hiremath 
Operations Manager Shailesh Iyer
Circulation and Logistics
Head Akhilesh Singh 
Marketing
Brand Manager Louis D’Mello
Marketing Manager Bhavesh Thakor
Consumer Mktg Nabjeet Ganguli
Head Audience Development
Sarang Dash
Customer Service Namita Shetty
VP, Sales & Client Marketing
Sandip Maiti
Client Marketing Parag Prabhu
Ad Sales support Rakesh Rana

VOLUME 2, ISSUE 3

BANGALORE
S. Saikumar
Raghu Pillai
Phone: +91 80
5325670/88, 2899287
Tele-Fax: +91 80
5325670/688
CALCUTTA
Jayanta Bhattacharya
Phone: +91 33
2822183, 2827842,

2828016 
Fax: +91 33 2827673
CHENNAI
Sahayaraj Prabhu
Phone: +91 44
8235186-89 
Fax: +91 44 8230731
MUMBAI
Rupesh Sreedharan
Bhavesh Thakore
Phone: +91 22

6591849-50, 6591651
Fax: +91 22 6591592
NEW DELHI
Vijay Adhikari
Rajesh Arora
Phone: +91 11
6445320-25
Fax: +91 11 6445321
PUNE
Vinayak Inamdar
Phone: +91 20

4482059, 4494572
Tele-Fax: +91 20
4482059
SECUNDERABAD
S. Venu
Phone: + 91 40
6329190/
6329181 

HEAD OFFICE: EDITORIAL,
MARKETING & CUSTOMER SERVICE
Plot No D-222/2, 
TTC Industrial Area, MIDC, Shirvane,
Nerul, Navi Mumbai 400 706 
Phone: 022-7629191/9200  
Fax: 022-7615225, 7629223/24 
Printed and published by Jasu R. Shah
on behalf of Jasubhai Digital Media Pvt
Ltd, 26 Maker Chambers VI, 2nd Floor,
Nariman Point, Mumbai 400 021,
India.
Editor: Maulik Jasubhai
Printed at Tata Infomedia Limited, 
Prabhadevi, Mumbai 400 025

ADVERTISERS INDEX

CONTACT OUR BRANCH OFFICES

Cover Photograph:
Colston Julian, assisted by

Bajirao Pawar

CLIENT  . . . . . . . . . . . . . . .PAGE
Aditya Infotech  . . . . . . . . . .38
Base Corporation  . . . . . .28,29
C Dac  . . . . . . . . . . . . . . .131
Creative Technology Ltd. . . .57
Dell  . . . . . . . . . . . . . . . .4,5,9
Exabyte  . . . . . . . . . . . . . . .75
Hindustan Times . . . . . . . . .88
ICICI  . . . . . . . . . . . . . . . . .53
IIT Madras  . . . . . . . . . . . .135
Intel  . . . . . . . . . . . . . . .13-20
Invensys  . . . . . . . .Back Cover
Jung Soft  . . . . . . . . . . . . .127
Karma  . . . . .Inside Back Cover
Kobian  . . . . . . . . . . . . . . .61
LG  . . . . . . .Inside Front Cover
Monarch Video Vision  . . . .133
Rashi Peripherals  . . . . . . . . .23
Samsung 37,39,41,43,45,47,51
View Sonic  . . . . . . . . . . . . .25
Vision Multimedia  . . . . . . . .77
Zenith  . . . . . . . . . . . . . . . .11

To Advertise

Write Back
Got feedback on Digit or
www.thinkdigit.com? Have something to say
about an article we published? 
We’d love to hear from you. Send us your
rants and raves at 

readersletters@jasubhai.com

Get Featured
PRODUCT TESTING
Want your product reviewed by Digit?
Contact our Test Centre at 
testcentre@jasubhai.com

SOFTWARE ON CD
To submit software for inclusion
in the Digit Interactive CDs,
contact us at 
cdcontent@jasubhai.com

Help!
Complain about your missing copy
Cover CD not working properly?
Renew your subscription
Report a change in mailing address
Order a back issue

Need assistance on any of these issues? 
Contact our offices listed below or e-mail Customer Service at
help@jasubhai.com

Endorsements/Reprints
The Best Performance and Best Value Awards
are the undisputed stamp of excellence for
technology products in India. If you are a win-
ner and are interested in ordering  article reprints
or using our logos, contact 
parag_prabhu@jasubhai.com

or Page: 9623-987273 (Mumbai),
9624-329229 (Pune, Hyderabad and Bangalore)

STATEMENT ABOUT OWNERSHIP AND OTHER 
PARTICULARS ABOUT DIGIT, REQUIRED TO BE 

PUBLISHED UNDER RULE 8 OF THE REGISTRATION
OF NEWSPAPERS (CENTRAL RULE), 1956.

FORM IV
(See Rule 8)

1. Place of publication : Mumbai 
2. Periodicity of its : Monthly

publication
3. Publishers name : Jasu Ramniklal Shah
4. Printer’s name : Jasu Ramniklal Shah
5. Owner’s name : Jasubhai Digital 

Media Pvt. Ltd.
6. Whether citizen : Yes

of india
Address : 26, Maker Chambers VI,

Nariman Point, 
Mumbai- 400 021.

7. Editor’s name : Maulik Jasubhai
Whether citizen of india : Yes
Address : Plot no. D-222/2, 

TTC Indl. Area, MIDC, 
Shirvane, Nerul, 
Navi Mumbai-400 706.

8. Name & Address of individuals who own the
newspaper & partners or shareholders holding more
than one percent of the capital.

Mr. Jasu Shah Jasubhai Media Pvt. Ltd.
1100 Shanudeep, 3rd Floor, Taj Bldg,
10 Altamount Road, 210, Dr. D.N. Road, 
Mumbai -400 026.        Fort, Mumbai - 400 001.

I, Jasu R. Shah, hereby declare that the particulars
given above are true and to the best of my 
knowledge and belief.

Jasu Ramniklal Shah

Publisher
Dated: February 8, 2002
Printed and published by Mr Jasu R. Shah 
for Jasubhai Digital Media Pvt. Ltd.
Printed at Tata Infomedia ltd., Prabhadevi, Mumbai.
Editor: Maulik Jasubhai 



21 MARCH 2002

If you’ve ever stood in the
middle of the supermarket
aisle, confused and won-

dering about your shopping
list, then maybe the
Klever-Kart will be
useful. This is an
electronic gadget
attached to
your shop-
ping basket
and its pur-
pose is to
inform you about
the products in the shopping
mall. So if you missed that
raspberry jam, it will tell you
where it is. With customer

loyalty cards inserted into the
Klever-Kart system, this super-
market navigator identifies
the user handling the basket

and provides personalised
information to aid

shopping. These cards
track what product

and brand a
customer buys
as well as fac-

tors such as
where, when and

how much money a
customer spends. Call it con-
venience or call it snooping—
the result is helping you shop.
Or is it really?

pulse ■
■ news

■ What is Lindows?
Lindows is a Linux-based
operating system that can
run both Linux and Windows
applications. It’s a move
towards bringing Linux to the
desktop and getting more
users use the Linux OS.

■ Why is it popular?
All popular Windows applica-
tions such as MS Office will
run on the Lindows platform.
Full compatibility would be
achieved within a year for all
popular Windows applica-
tions. It’s in the news not
only because of its functional-
ity in running Windows appli-
cations, but also due to the
fact that Microsoft is up
against Lindows to withdraw
its brand name, as it rhymes
with Windows!

■ When will it be
released?
The preview version has
been released with the com-
mercial version available for
$99. Visit www.lindows.com
for more information.

Supermarket Navigator

hypethesis

Only 2% of Indian

Net users shop

online compared to

a global average of

31%

■ 37 million Americans trade music files ■ IBM discontinues Thinkpad Transnote ■ MIT institutes Dewang Mehta award for innovations in IT
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MIT has developed a
microchip which
can transform heat

into electricity. Undergoing
tests currently, the chip oper-
ates at a low tempera-
ture of 200 degree
centigrade as com-
pared to vacu-
um tube elec-
trodes that
require 1000
degree centi-
grade to pro-
duce a minis-
cule current.
The Indium anti-
monide-based semicon-
ductor would be induced for
a scattering chain reaction
that would turn heat into

current. The inventors are
aiming at tapping heat from
the car’s engine to provide
electricity to other electronic
gadgets in the wagon.
The other calf

project

is to
recycle
heat from

the proces-
sor in a laptop
to charge its
batteries. The

heat generated
in your desktop

computer can, for
example, be used to power

a CD-ROM drive or to ampli-
fy the sound of the speakers.

PSX finally
arrives
The PSX is the first PlaySta-
tion console to be launched
in India, with a partnership
between Sony India and
Milestone Interactive. The
console is available in retail
at an asking price of Rs
7,990, including the Dual-
shock analog controller and
a complementary game. The
PSX, first introduced in
1995, has sold around 88
million consoles worldwide.

End of Spam?
Truste, a non-profit organisa-
tion, and Eprivacy Inc have
launched a service called Pos-
tiva aimed at combating
spam. The group is negotiat-
ing with e-mail program cre-
ators to introduce a new con-
cept to stop spam. And
what’s the concept? Eliminat-
ing spammers from legiti-
mate commercial mail by
attaching digital signatures
with the e-mail sent by any
user. This way, the e-mail
service providers can auto-
matically eliminate spam mail
from legitimate commercial
mail. Companies have to reg-
ister with the group to get
the hardware device that
attaches the digital signature
to the e-mail. Microsoft is the
first company to endorse this
service and is trying to imple-
ment spam-free mail service
for MSN users. But would
this move really translate into
the end of all spam, even if
consumers pay extra?

Morphing Heat
into Electricity
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Don’t get giggy 
This time around, a
JavaScript-based virus threat-
ens to clean your hard disk.
The travel mode for Gigger is
MS Outlook and mIRC. It
spreads across the Internet
via these applications. The
virus attempts to mail itself
to all your contacts as a
security update from
Microsoft. It usually reaches
the recipient with a subject
line ‘MS Outlook update’
along with an attachment
‘mmsn_offline.htm’.
Microsoft often releases
patches and updates
through its sites so look out
for any e-mail with a similar
subject line and delete it.
Protection is available with
all major anti-virus vendors. 

Malicious 
Morpheus
The popular file sharing soft-
ware, Morpheus, has a secu-
rity hole, which throws open
all your personal details to
the outside world. The secu-
rity hole allows hackers to
generate a random list from
the 9-million user base. The
hacker can then access the
victim’s computer and copy
files from any drive on
his/her computer. The priva-
cy risk was reported first to
BBC news online by a group
of security experts. Since the
software is caught up in
copyright issues like Napster,
there is no security patch
available as of now.

redalert

■ Palm promises Macintosh compatibility with PDAs ■ BPL mobile 5th provider of GPRS in the world ■ GeForce4 released ■ HECL has launched 

Vibration White Finger

➜

Doctors in Britain have
judged that playing
games using gaming

consoles is harmful to
health. The latest hand-arm
vibration syndrome, called
Vibration White Finger,
afflicted a 15-year-old
boy in London due to
prolonged usage of a
Sony PlayStation games
console. He played for as
many as seven hours a day.
Doctors have lodged a bill
with the British Medical Jour-
nal asking for such products
to be released with a statutory
warning. 

This syndrome also
occurs as a result of pro-

longed use of pneumatic
industrial equipments. In
racing and other driving
games the gamepad
vibrates to give the rumble
effect. This gives the play-
er the feeling that he/she
is actually driving the
vehicle on the screen.

Sony already has taken
the issue into considera-

tion and has started releas-
ing statutory warnings on its
gaming devices. Users are
now advised to take a 15-
minute break after every hour
of using the console and
gamepad now.

Intel's Israel operation is
working on a new laptop

processor to enable seamless-
ly connectivity with any
available cellular network for
accessing the Net without a
modem. Code-named
“Bania”, this laptop processor
is slated for release in Jan
2003, and hopes to realise
the dream of total connectiv-
ity to the Net—anytime, 
anyplace. 

Bananas over Banias 

Source: NASSCOM

13% of India’s

adult population

accesses the Net

Source: www.jmm.com
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Rejuvenating
Batteries
Imagine charging a battery
with a hand-powered
pump. This is what Max
Smith, an American devel-
oper, has imagined with the
StepCharger, a product
which generates 20 minutes
of battery power when you
brisk the pump for five
minutes. This device can
rejuvenate the replaceable
battery in any electronic
device—mobile phone,
video camera, digital cam-
era, MP3 player, etc. 

Olaf Christ has laid
the foundation for
what he claims to be

an RCX (Robot Command
Explorer). By transferring
Internet capa-
bilities to the
Lego Mind-
storm’s

platform, Christ has created
the first RCX ever. Lego is a
robot with brains, who has
been extremely popular with
hobbyists and hackers. RCX
is the interface through
which the PC connects to
the robot and sends and
receives data packets. Christ
is in the process of building

a Lego brick Web server
that could enable the con-
trol of robots through the

Internet. 

Hyper robot

ILLUSTRATION: Farzana Cooper
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heroes
PALM
Palm scores a winner with
the new i705 wireless PDA
USB 2.0
Speeding ahead with 480
Mbps
PIXAR
Animation stalwart on a high
after the release of the block-
buster, Monster Inc

MPEG-4
Institution of usage fees
for streaming MPEG-4
dampens enthusiasm for
the format

MICROSOFT 
New Windows licensing
rules may impose harsher
terms on PC
manufacturers  

zeroes

➜

satellite-based broadband Internet access service in India ■ PDA-mobile phone combo Treo launched ■ European Union drops Intel anti-trust case 

AOL is no stranger to
interoperability issues.
The latest casualty in

the instant messaging phe-
nomenon is Trillian, which
allows messaging appli-
cations from Yahoo!,
MSN, and AIM to be
accessed through one
interface. AOL claims
that accessing its soft-
ware service through Tril-
lian for messaging pur-
poses is the same as
hacking into its software.
Similar incidents have hap-
pened with AOL in the past.
The company considered this
a security breach and blocked
Trillian from accessing its
software, but at the same

time, it continues conducting
research to create interopera-
ble services. AOL plans to
come up with something
similar to the e-mail (wherein

users can use disparate servic-
es but still contact each
other). Meanwhile, AOL is
restructuring its music and
video products business in
India and has approached
FIPB to set up a subsidiary.

Of AOL and 
Interoperability

Microsoft’s .NET strate-
gy for online services

has been at the centre of
considerable excitement,
debate and even apprehen-
sion for a while now. The
much-touted Visual Studio
.NET, which is a tool target-
ed at developing Web serv-

ices specifically for the .NET
platform, was finally
released on 13th of Febru-
ary 2002 in India. The tool-
kit supports nearly 20 pro-
gramming languages,
including the already popu-
lar Visual C++, Java and
newer ones like C#. As an

increasing number of devel-
opers and companies look
at the development of Web
services, this will allow the
use of existing skills to
move on to the Web servic-
es platforms. A true devel-
oper tool, but God knows
what the hidden tag is.

Visual Studio .NET in India

Cracking XP
Windows Product Activa-

tion was introduced as a
move to prevent piracy of Win-
dows XP. This supposedly
watertight user authentication
system has been recently put to
shame by a key generating pro-
gram that is able to produce
valid activation keys that are
accepted by the latest Windows
OS. Microsoft is again faced
with the task of devising  a
mechanism which will recog-
nise the difference between
genuine  and cracked keys.

Astudent at the Univer-
sity of Sussex, UK, has
built a sensor that can

pick up your heartbeat with-
out making any physical
contact with your body. The
device can pick up changes
in the electric field in the air
due to a shift in voltages on

the skin surface. This is
called the displacement cur-
rent, which is used for draw-
ing the ECG graphs. The
sensor in this device is a
powerful copper disc, 1 cm

in diameter and capable of
picking up your heartbeat
even at a distance of a metre.
The impedance of the sensor
was made 100 times higher
than that of air in order to
retain the signals unlike in
the usual ECG sensors,
which drain the electrical

signals. The
student at
the helm of
this project
states that
normal ECG
suffers a dis-
tortion since
the skin

retards the flow of electrical
signals. The device can be
used to monitor patients,
such as fire accident victims,
who cannot be touched
while treatment.

Wireless ECG
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Usable voice recognition
technology, after a lot of

talk, has finally made an
appearance. Dragon’s Speech
recognition software, version
6, has been launched in
India featuring new tech-
nologies like NBS (Nothing
But Sound), a tool that filters
out fillers and intervals
between dictations. This
helps in the removal of
unwanted words like ‘umm’
and ‘uhh’ which usually

occur during dictation.
Another great feature is the
Acoustic Optimizer, which
allows the software to learn
from all the data that it has
accumulated over time in
order to render greater recog-
nition accuracy. With Drag-
on Speech, connecting to
hyperlinks, controlling the
mouse, editing, etc are easy
tasks—all you have to do is
speak. Now if somebody will
tell us the price… 

Yours Vociferously

Track IR hands-free
mouse helps the physi-
cally challenged use the

computer with relative ease.
This device is
suitable for peo-
ple suffering from
carpel tunnel syn-
drome. The
mouse kit ships
with a silver dot
and a sensor—the
sensor is an IR
device that con-
nects to your USB port and
the silver dot is the medium
through which the sensor
picks up the reflection in

order to move the cursor on
the screen. The silver dot
could be stuck on to your
forehead (or any other part of

your body that
you can use to
comfortably
move the mouse).
As you move
your head, the sil-
ver dot moves
along, and the IR
sensor picks up
the reflection

from the sticker. The sensor
then sends the data to move
the cursor accordingly on the
screen.

Hands-free Mouse 

Olympus has released a
practical DNA computer
that can be used in the
analysis of genes. A normal
computer works on electri-
cal impulses to process
information, but the DNA
computer relies on chemical
reactions between frag-
ments of DNA. 

Multiple chemical reac-
tions between strands of
DNA can happen simulta-
neously leading to massive
parallel computing capabili-
ty. This capability is used in
the DNA computer devel-
oped by Olympus to
analyse genes, a task that
requires enormous comput-
ing power. 

The company developed
the product in a joint ven-
ture called NovousGene
which specialises in genome
informatics. The computer

is divided into two seg-
ments—the Molecular Cal-
culation component and
the Electronic Calculation
component. 

The former analyses the
genes, initiates chemical
reactions and brings out
DNA results while the latter
does the extreme processing
and analysis of the final
results. 

Olympus plans to test
run the computer for a
complete year and then
hopes to provide the servic-
es in early 2003 on a com-
mercial basis.

Studying genes with 
DNA computersSony is getting ready to

release Linux OS kits.
The company aims at

helping Linux
programmers
develop appli-
cations based
on the OS for
the PS2. Start-
ing May 2002,
disks for installa-
tion of the OS and
tools for developing
applications for PS2
will be available commer-

cially. The company plans to
roll out the gaming console
as an extended version with

more common applica-
tions such as word pro-
cessing and spreadsheet

capabilities. Wait
for the Tux to
make its way

into the
game con-
sole mar-
ket and

you can start
expecting some surprises.

Tux on PS2

■ Final Fantasy moviemaker closes studio ■ Microsoft launches MSN mobile portals in Europe ■ ICANN releases .coop domain naming system 

➜

Ahidden feature in
MSN Messenger
allows Internet

Explorer users to be identi-
fied on the Microsoft Web
sites. A clever netizen has
found that a small VBScript
or JavaScript code can easily
reveal the user’s details. The
malicious feature can be
abused by any Web master to
obtain your username along
with all the contacts. If the
code fails to fetch the user-
name it fetches the e-mail ID
of the user and his contacts,
making the situation worse.
A small piece of software can
make a registry entry in your

computer that can throw
open your messenger details

to its associated Web site.
This malicious program can
introduce a .org, .com or any
other domain suffix to the
registry and allow any site in
that domain to access your
Messenger details.

Flaw discovered 
in MSN
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■ Animated cartoons as Oscar nominees ■ IBM unleashes Meta Pad, a camouflaging computer  ■ Kevin Mitnick to plead for HAM licenses

This is the name of the latest
server processor from Intel.
Covering an area of 464
square millimetres, it is the
largest processor ever made.
The fabrications will not be
easier than the earlier prod-
ucts—McKinley will not be
a cheap processor. Intel
researchers believe that it
certainly is a mammoth
task and a great challenge
to produce chips of such

surface area. McKinley, the
third child in the Itanium
series, will be followed by
newer siblings; namely
Madison, Montecito and
Chicanos. The processor
consists of a substantial
amount of cache-data reser-
voirs near the processor for
rapid data access. The chip
would be integrated with a
3 MB level 3 cache, 256 KB
level 2 cache and 32 KB

level 1 cache, respectively.
All these additions and
integrations contribute to
the size of the actual
processor. 

McKinley would be fab-
ricated with 221 million
transistors embedded on it.
Intel adds that the success of
the processor will depend on
the availability of software
that can squeeze out the
capabilities of McKinley. 

Itanium’s third child—McKinley
tomorrow’stechnology

■ Isamu Sanada
A Mac fanatic who has been
creating speculative models of
Apple products. He designed
a laptop which gave a pre-
view of the Titanium
PowerBook G4 months before
it was released. Sanada’s
Apple clones are remarkably
accurate, down to details
such as the CD/DVD drive slot
and the stylish cooling vents.

■ How does he define his
role?
He visualises himself as
another Steve Jobs and
would like to work for Apple
for a meager salary of $1 per
annum, which is incidentally
Job’s annual salary too.

■ What’s his vision?
Apple has been creating PCs
of the future and will always
be revealing future PC con-
cepts to the world. He
believes that one day he will
work with Apple, designing
stylish Macs. Check out
Sanada’s work at
www.applele.com

WhoIs?

“Linux can’t beat
Windows.”
Bob Young, Red Hat Chairman

“Internet is 100 per
cent backward from
what it will be in 10
years from now.”
Steve Ballmer,
President and CEO, Microsoft 

“When a company
is very small, you
focus on the who,
the what and the
how... Over time
you give up on the
how, give up on the
what, and focus on
the who.”
Jeff Bezos, CEO, Amazon.com

quoteworthySecurity without
privacy?

Pacific Northwest
National Labora-
tory (PNNL) has

developed a holo-
graphic imaging sys-
tem for scanning peo-
ple at airports for secu-
rity purposes. The
scanning is done
through radio waves.
The waves penetrate the
clothing and the items 
concealed within. The
reflected signals from the
body and the items in your
clothing are collected by a
computer, which recon-
structs the data into a 3D
bitmap. Though this is an

effective system, the person
at the computer can see not
only concealed items if any,
but also a nude image of the
person being scanned. This
leads to privacy issues and
PNNL is working on a soft-
ware solution that can solve
this issue.

3 million
Internet subscribers

in India as on

March 2001.

Expected growth by

2003:

7.5 million

Texas Instruments is working
on a 0.09-micron logic
process that sup-
ports nine layers
of copper inter-
connects with organo-silicate
glass (OSG). The logic
process will produce 400 mil-
lion transistors on a single

chip. The 90-nanometer
process will allow the com-

pany to push the
operation frequen-
cies of its DSP and

RISC processors to ultra high
speeds. The new process was
developed for 200 mm and
300 mm wafer fabrication.

UUllttrraa  hhiigghh  ssppeeeedd  DDSSPP

snapshot

Hackers have started send-
ing a malformed message

in Chinese characters that
crash Siemens mobile phones.
The security bug affects the
3568i (or below) range of
Siemens cell phones. A rogue
message sent to this mobile
can render it useless. The mes-
sage cannot be simply delet-
ed. It can be deleted using a
specific software that has to
be downloaded from the Web.
This seems very much like a
sequel to the havoc wreaked
on Nokia mobile phones in
Japan last year.

CHINESE
c r a s h e s

Source: NASSCOM



Missing the ListDear Karan,
I noticed that you have stopped printing the full contents of your

CDs in a sidebar in the magazine. I find this very disappointing

as I used to cut and file the list for easy reference. Now I am

unable to do so. Hope you start printing them again.

DONALD
Via e-mail

Dear Donald,
We haven’t entirely done away with that idea.
While the ‘Inside the CDs’ page highlights the
special content on the CDs, you can still find
the full content of the Digit Interactive CDs at
the back of the CD pouches.

Money Matters
Dear Karan,

While I largely agree with your editorial in the February issue,

I have a few concerns of my own. You have proposed that

companies could offer basic or older versions of software for a

lower price. Though that may sound good, there are certain

places where this approach may not work.

For example, I have to upgrade my operating system at

some point of time. I simply cannot keep using Windows 95

(for which I have a license) with newer hardware for reasons

of stability and compatibility. It is the same case with applica-

tions such as OCR software, system utilities and tools, which

have to be upgraded if you have to keep abreast of the latest

developments in technology.

Also, companies could sell software to large enterprises and

commercial institutions at higher rates and subsidise the price

for individual users. 

HRISHIKESH THITE

Via e-mail

Dear Hrishikesh,
My editorial suggested that companies could offer older soft-
ware at better prices. Obviously this applies to software that
have a certain amount of functionality and suitability. Would-
n’t you be willing, for instance, to pay Rs 1,500 for an origi-
nal copy of Windows Me? Or perhaps, Windows 2000 at Rs
3,000 that offers most of XP’s functionality at half the price? 

As far as your suggestion of subsidising the prices for indi-
viduals is concerned, it wouldn’t be fair for a business to
penalise their regular/large customers by over-charging them.
The point is that while companies are trying to tackle the issue
of piracy by reducing the price for their software, they need
to re-evaluate their pricing strategies for older products that
have already earned their share of development costs.

Magazine No 1
Dear Karan,
I have been a keen reader of your magazine for a long time. The Febru-

ary 2002 issue of Digit was sim-ply great. All the articles werechosen perfectly and renderedbeautifully.
The feature on DVDs in‘Technology Next’ wassmoothly written and did agreat job of explaining the dif-ferent standards and their signifi-cance. Droolmaal really did its joband had me salivating. The article by Avina Lobo onhow to earn money using thehome PC was excellent. The ‘Top10 Downloads’ really broughtmy PC up to the mark and the‘Test Drive’ on CD-Writers wascomprehensively done.I could go on about the rest of the stories but I

don’t have enough words to congratulate the authors of the respective

articles. All I can say is that you certainly know how to keep us glued to

the magazine for hours together. Now I am assured that my decision to

go for the two-year subscription has not been a bad one at all. Looking

forward to more such wonderful issues. Kudos to the entire Digit team.JAYANTH
Via e-mail

Dear Jayanth,
Shhhh! Not so loud, the team might let your
praise go to their heads! And surely you wouldn’t
tolerate their complacency one bit. But seriously,
such appreciation is what drives us to bring you
the best technology magazine month after month.
Team Digit

The Web Site StoryDear Sir,
I started my career as a professional Web designer and as

a desktop designer a few months ago. The articles and

tutorials provided in the earlier issues of your magazine

relating to Web and multimedia designing were very help-

ful to me as a beginner in learning the tricks of the trade.

But today the magazine lacks articles that explain

domain name registration, server side techniques, upload-

ing Web pages to the server, etc which would be very

helpful for a Web designer.I request you to consider covering these subjects in

forthcoming issues.JAYASHRI K.V.Via e-mail
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Dear Jayashri,
We’ve touched upon each of these issues in isolation, but
you’re right—we’re still to feature a comprehensive article
covering all aspects of registering and maintaining 
your Wseb server. We’ll definitely cover it in one of the
upcoming issues.



Short Bytes

Ask Away
Dear Sir,
While I am a reader of Digit,
I’m not a subscriber of your
magazine. I need some
advice on buying a CD writer.
Is the Smart Buyer’s Forum on
your Web site meant only for
your subscribers, or can I also
ask my questions there?
S. JATANIA
Via e-mail

Dear Jatania,
The Smart Buyer’s Forum at
thinkdigit.com is open to every-
one. Just go ahead and post your
question there and Agent 001
will get back to you with the
advice you need.

Addicted!
Hi,
I have just finished the Febru-
ary issue of Digit. The prob-
lem is my addiction to Digit. It
takes me a whole day to read
it from end to end and anoth-
er day to go through the CDs.
Thanks a lot for issues like this
and I hope you can keep it up.
SABYASACHI MUSTAFI
Via e-mail

Dear Sabyasachi,
Most of our readers claim that
the issues occupy them for days
on end. Are you sure that you
didn’t miss out on some of the
magazine?!

■■ Uh oh. We goofed. Although we mentioned The Sleuthhound!
Pro 3.2 in the contents page of the February issue of Digit in the
software section of the box ‘Reviewed this month’, we failed to
carry it. However, the review is being carried in this issue in
Bazaar. 

■■ Some of our readers have complained that the software .NET
Framework SDK included in the Mindware CD does not function
correctly. We apologise for the inconvenience caused. This will be
carried again in the future.

Notice any goof-ups? Write to goof@jasubhai.com

Send your letters marked ‘Readers Letters’ to the Digit office: 
D-222/2, MIDC, TTC Industrial Estate, Om Sagar Building, Nerul, Navi Mumbai 400 706, 

Phone: 022-7629191/9200;  Fax: 022-7629224 
E-mail: readersletters@jasubhai.com 

Dear Karan,

I was a bit disappointed with your editorial

in the January 2002 issue. Being just 15 years

old, I have far less experience than anyone in

the Digit team, but I have been using Linux

for over four years and I am a die-hard Linux

lover. 
When you refer to the constant need

command prompt mode, you are forgetting

the simplicity of using the excellent X Win-

dows System, which comes bundled with

almost all Linux distributions today. Also you

haven’t considered the fact that there are

thousands of programs that come along

with the Linux CD.For a magazine like Digit,

which is considered by novices and experts

as their monthly morsel of computing food,

it is unjust to project Linux as a user-

unfriendly operating system.

VIVEK SAXENA

Via e-mail

Dear Vivek,
Like I mentioned in the editorial, while Linux has made great
strides in usability over the last couple of years it still isn’t close
to the level of user friendliness that Microsoft has managed to
achieve with Windows XP.

A long time Linux user like yourself would be familiar with
the fact that despite the progress made by KDE and Gnome, the
command line is still the most convenient (and in some cases the
only) way to get things done in Linux.

Also, few of the applications that come bundled with the
Linux distributions match up to their Windows counterparts in
either feature sets or ease-of-use.

Goof Ups

Double Standards
Hi Karan,
I was shocked to read the article ‘10
Crimes you may have committed’ in your
January issue. I think the article is a clear
case of double standards at Digit. Most of
what you have described as crimes (like ille-
gal downloading, CD ripping) are topics on
which you have yourself published articles
educating your readers. SHANTANU ADHICARYVia e-mail

31

Dear Shantanu,
Double standards at Digit? We think not.

That particular article highlighted what the law has to say on these
subjects. What that article is meant to  do is show that thanks to archaic
laws, almost anything that you do on your computer can be considered
illegal...

Three cheers for Linux!

MARCH 2002

ILLUSTRATIONS: Mahes Benkar
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T
he cutting edge of technology has affected the
equations of a war so dramatically that the motiva-
tions and conventions of a typical ‘war’ have
become vastly different from what they were earli-
er.Despite this apparent shift, the fundamental

nature of war does not change with technology, and under-
standing how war does not change is key to understanding
the art of war itself. In this article, we take the ancient
Chinese wisdom of Shang Tsu, and draw parallels with the
present day scenario of laser-guided bombs, night vision,
mechanised warriors, and killer warplanes. 

This statement needs some revision, especially in the wake of spy
satellites, reconnaissance planes, and surveillance systems. Today’s
intelligence gathering is much more passive in nature, and does-
n’t involve using spies that much. Take the example of Echelon.
Several credible reports suggest that this project attempts to cap-
ture staggering volumes of satellite, microwave, cellular, and fibre-
optic traffic, including communications. This vast quantity of
voice and data communications is then processed through sophis-
ticated filtering technologies. Most of what is known—or believed
to be known—about Echelon is based on rumours and allegations,
such as the claims that the system intercepts 3 billion e-mails
every day, or sorts through 90 per cent of the traffic on the
Internet. Echelon’s computers are supposedly capable of recognis-
ing key words, names, telephone numbers, and voices. They 

gather information from listening posts all around the world, with
additional input from about 120 US satellites.

The high-tech foot soldier of the near future will bear a closer
resemblance to the Terminator. That is the promise of the Land
Warrior, a 9-pound ‘back-top’ computer that manages a global
positioning receiver, miniature camera, laser rangefinder, video
and thermal weapons sights, and a radio. The 21st Century
Land Warrior (21CLW) is the name given to the concept of new
future military development for the man on the ground. This
concept has been a study and a progressive objective for the
past decade for many Western military forces. The weapon sub-
system is built around the M-16/M-4 modular carbine. It has a
laser range finder/digital compass, a daylight video camera, a
laser aiming light, and a thermal sight.

Cables run from the battery-powered backpack to a soldier’s
helmet or sunglasses, where a tiny ‘heads-up’ display monitor is
mounted, and his weapon holds video sight (for daytime), ther-
mal sight (for nighttime) and laser rangefinder capabilities. Land
Warrior is years away from the troops in the field, but its replace-
ment is already on the drawing boards. The designers of Future
Warrior 2025 think they can make individual infantrymen as
deadly as tanks and much more comfortable than today’s foot
soldiers. One day in the future, a Marine may be able to send
cockroach-like robotic critters into a building to send back video
images of the enemy. These creatures could also set off 

The battleground of the future will not be soaked with human blood—intelligent 
machines will do the fighting, and the killing

The Future of 

Knowledge of the enemy’s dispositions can
only be obtained from other men

“ “

The art of war

The skillful soldier does not raise a second
levy, neither are his supply-wagons loaded
more than twice

“ “

The art of war
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non-lethal intoxicants to subdue the enemy.
The modern soldier on the ground still has to wade through

mud, endure rough terrain and fight enemies, just the way
armies fought with each other throughout the centuries. The
difference is that the soldier of today has heightened senses,
highly accurate and effective weapons, and an extensive array

of communication technologies. Body armour gets stronger and
lighter; rifles, though still based on technology that’s more than
50 years old, are now much more effective and equipped. 

As air power has developed, so have the armaments that give
aircrafts their firepower. Missile systems offer a mixture of
effects and ranges depending on the needs of the mission.
Close-range sidewinders, long-range cruise missiles travelling
several thousands of kilometres, laser guided bombs (LGB) that
can be targeted from the air or by ground forces—the arsenal for
air attack is ever increasing. 

Laser guided bombs (LGB) such as the GBU-27 are specifi-
cally designed to be used with the F-117 Stealth Fighter. It is
supplied with a 2000-pound bomb as armament, which holds
550 pounds of high explosive. A delayed action tail fuse
allows the bomb to penetrate 6 feet of reinforced concrete
before detonation. In association with the specialist F-117 air-
craft, the GBU-27 can hit a square metre target from an alti-
tude of 25,000 feet.

Stealth. The ability to strike quickly and with surprise. Today’s
surface-to-air (SAM) missiles are equipped with tracking devices
that are more sensitive—these missiles are able to chase down
aircrafts from hundreds of miles away. So how does a warplane
avoid detection? How do you make a huge plane disappear?

That was the challenge when research for the B-2 bomber
began in 1981: to make an airplane invisible to the radar. The
Pentagon originally wanted 132 planes. Only 21 were made. 
B-2 bombers are second-generation stealth bombers, made of
carbon-graphite composites lighter than aluminium but
stronger than steel. 136 separate computers onboard help the
two crewmen handle the complex plane. With just one air refu-
elling, a B-2 can reach and strike accurately any target in the
world. It has a capacity to carry up to 40,000 pound of weapons,
including conventional and nuclear weapons, precision-guided
munitions, gravity bombs and a range of maritime weapons.
The B-2 can also carry the AGM-129 Advanced Cruise Missile,

Information warfare is a battle no longer done
on a physical plane but a virtual one. Information
technology is being developed as a weapon for
‘logistics attack’ as a means of disrupting the
infrastructure on which an enemy’s military
apparatus depends. However, information war-
fare is a double-edged sword—the countries
most capable of waging it are also the countries
most susceptible to it. 

Information warfare opens up new horizons of cost effectiveness
for terrorists and enemy governments. Attacks on information 

technology are unsettlingly easy to carry out. The
means are relatively inexpensive, easy to smug-
gle, virtually untraceable, and completely deni-
able. This, coupled with the fact that the civilian
networks are the most attractive to terrorists since
they are the most vulnerable, makes ‘Infowar’ the
perfect weapon in any terrorist’s arsenal. 

Future weapons of information warfare could
include nano machines, electronic jamming,

high-energy radio frequency guns, and electromagnetic pulse
bombs.

Information Warfare

The 21st Century Land Warrior, equipped with a GPS receiver,
miniature camera, laser rangefinder, video and thermal weapons
sights, and radio  

Let your plans be dark and impenetrable as
night, and when you move, fall like a thunder-
bolt

“ “

The art of war

All warfare is based on deception“ “

The art of war



which is a strategic cruise missile with range estimated at up to
1,500 miles.

Given its radar-evading ability, the Stealth fighter has been
used in attacks deep behind enemy lines. It is said that the first
Iraqi anti-aircraft weapons were fired after bombs from the 
F-117s hit their targets with an astounding rate of success. 
F-117s were the first aircrafts to strike Baghdad in the opening
minutes of the Gulf war. Footage from onboard cameras shows
a number of 200-pound bombs from F-117s scoring direct hits
on Iraqi strategic targets and mobile missile launchers. Air Force
commanders reported that the F-117 flew 3 per cent of total
missions but destroyed over 43 per cent of total targets.

Robot planes called Predators circled slowly in the skies above
Afghanistan, transmitting live images of Taliban troops with no
risk to the pilots. Predators are capable of staying aloft for 40
hours, lingering over no-man’s land, snooping on a single tar-
get or a hundred of them and transmitting back vivid, live pic-
tures. This plane is a sign of things to come, when troops made
of metal and electronics do the fighting, not humans. It’s only
a matter of time before fighter planes without any pilots joust
in some robot dogfight in the sky. 

iRobot of Somerville, Massachusetts, is a small machine
modelled on the crab, which is devoted to minesweeping. It
can be used in amphibious assaults as it has the ability to nav-
igate difficult terrain, attach itself to a mine, and detonate
itself. To imitate an ant farm, iRobot is building a swarm of tiny
robots called ‘joeys’. Possessing very simple intelligence, the
joeys are meant to work together to explore a battlefield or dis-
aster area. They communicate by ‘pheromones’ which are
transmitted by infrared beacons, and each joey has a small tank
of water, called a bladder, from which it dribbles a trail that

shows other joeys where it
has gone. Like ants, the
joeys know little of their
universe. But when they
find something interesting,
they tell others around
them. 

The most incredible sta-
tistic of the Afghanistan war
was that the first American
soldier died after three
months of combat! Thanks
to the Predator spy plane
and other unmanned
drones and gunships along
with satellites and thermal
imaging devices, battlefield
robots can do all the dirty
work in future wars—from
minesweeping to reconnais-
sance, from killing to guard-
ing. They would be exposed
in risky situations, and
would be expendable. 

The challenge lies in
designing machines with enough intelligence and mobility
to handle the unpredictability of the real world. At Sandia Lab
in New Mexico, scientists are at work to start a robotics revolu-
tion by 2020, with advances in biometrics, swarm intelligence
and AI. 

Such advances could further divide the gap between warring
factions. As it is, the actual battles today are not decisive or
heroic anymore, and a proxy war through machines would
make war even more confusing, distant, and one-sided. The
actual battles, with its paradoxes, and infomania, would seem
best described as postmodern.

SRIRAM SHARMA
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This technical rendering illustrates one of several advanced con-
cepts Northrop Grumman’s Integrated Systems and Aerostruc-
tures Sector is examining under a 12-month US Air Force study
contract for a future strike aircraft that could replace the current
US long-range bomber fleet. This rendering depicts a vehicle that
would operate in the hypersonic speed range with a video-
enhanced, visual-aid cockpit

Global Hawk is a high-altitude, long-endurance, unmanned aerial
reconnaissance system designed to provide military field com-
manders with high-resolution, near real-time imagery of large
geographic areas

Be subtle! Be subtle! And use your spies for
every kind of business

“ “

The art of war

With the thermal sight at night or
video sight during the day, the
21st Century Land Warrior can
shoot with great accuracy while
exposing only his hands
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Cutting-edge technology becomes mainstream...
GENi promises to showcase some of the best droolmaal available in
the Indian market. Here’s a look at some of the select pieces. Check
out www.zdnetindia.com/geni for more.

Nokia 7650
Photos on the phone
A colour display with complete
GUI control, a digital camera,
adherence to wireless connectivi-
ty standards such as Bluetooth,
infrared and GSM, support for
GPRS and HSCD networks... what
more can you ask of a phone!

With a potential for surfing
the Net and working with e-mail
and images, Nokia 7650 is as
compact and feature-rich as a
phone can get.

Thomson 44RW65ES Rear
Projection Systems
More of the screen, more fun!
Nothing really matches the joy of watch-
ing a movie on a big screen, but Thom-
son’s new Rear Projection display system
comes close. Boasting of a 112 cm size,
this 16:9 aspect display system features a
100 Hz digital scan, providing you the
sharpest video displays you’ll ever see. It
also pleases the audiophile in you with an
integrated 80 Watt Virtual Dolby Sur-
round audio system. Get that eye-full
right in the comfort of your living room.

Sony PlayStation 2
Gaming power
Packing one of the most powerful graphics engines on the planet,
the PlayStation 2 with its 48 GBps memory bandwidth can render
movie-quality images in real time and also comes with support for
DVD playback. All this is made possible with innovative rendering
features in the 150 MHz graphics processor coupled with 32 MB of
dedicated RDRAM. Get ready for a unique gaming experience. 

▲
▲

▲ ▲
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LG GR 1267 Internet Refrigerator
The coolest one

The LG i-Refrigerator takes your kitchen to the next
level of automation. It lets you connect via LAN,

ADSL, modem or even cable and browse the Net via
the integrated 15.1-inch touch-sensitive screen.
A built-in camera and microphone allow you to

videoconference. Sporting full-colour functionality
and a GUI-driven interface, you can check your 

e-mail and grab a snack simultaneously!

Sony AIBO ERS-220
My dog!
Technology turns man’s best friend in Sony
AIBO, a robo-pet that can be trained to
recognise its owner’s voice and face and is
sensitive to its environment. Equipped
with a 64-bit RISC processor, advanced
robotics, and numerous pressure, light and
motion sensors, the AIBO gives you the
pleasure of owning a pet without having to
worry about toilet training it!

Nike psa[play120
Just play it
A digital audio player for the music-loving sportsman, the MP3/WMA
player features 64 MB of built-in Flash memory and can be worn on
your person. The LCD Screen on the remote control displays track
information and controls the functions. Since it has no moving parts,
it is skip-resistant and highly resilient to physical shocks. 

▲
▲

▲▲
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11 33Steady as a horse 
Forget what you learned. A Mac is stable. It does not
‘hang’ like the PCs of ‘other’ people. Like a horse, the
Mac’s stability increases, and as Apple gets a firmer foot-
ing in the computing market, it releases products like
the UNIX-based Mac OS X, which is far more stable than
its predecessors. The fact of the matter is that iMac is
more stable than Windows XP, professional or home 
edition.

Prettier than the prettiest
Apple is the master of industrial design. At Apple, you
don’t make ordinary-looking products. Conversely, are
you that proud of your individuality? The Mac cult will
want you to believe that a Mac is more than a computer:
it is a lifestyle. Maybe you don’t want to impress your
girlfriend like that Compaq ad shows, but what the
heck, maybe you do want to. A case in point is that
iMac has won several international design awards, which
shouldn’t look bad in anybody’s room. Don’t forget the
‘Neighbour’s envy, owner’s pride’ line that Onida made
famous. And face it, a lot of things sell in the world
today just because they are pretty.

Originally different
Do you hang out with the crowd at the risk of not being
original? Do you have it in you to innovate? Are you
afraid of change? What is your personality like? Apple’s
personality as reflected through its products has been
worthy of attracting a cult. An Apple is for those 
who realise what it means to be different, especially cre-
ative people, who need to be different in order to make
a difference. 

Reasons 

Mac
And 5 Reasons

Why You Shouldn’t!

You Should
Buy a

There is one thing you simply can’t deny: a Mac looks as
good as it performs, if not better. Since its arrival with a
bang in 1984, the computing scene has never been the
same. A whole generation of Mac users—over a remark-

ably consistent period of innovation in design and quality—
turned into a cult. A cult, which in the form of millions of Mac
users worldwide, keeps the tradition and spirit of an Apple alive.
Maybe that’s why the designers at the company have managed to
jolt, electrify and revolutionise the computing world time and

again, and so has the renowned and rebounding Steve Jobs. 
Apple has left no stone unturned in its attempts to make sure that
radical, aesthetic and offbeat designs work, and work better than
anything else! One need not conform. The best part is that over
time, Apple’s ideology hasn’t changed. The company still wants
to think different, combine eye-appeal with rock-stable perform-
ance, and offer a choice in the Windows-weary world. But enough
already, let’s see why owning a Mac is much more fun than any-
thing else!

1
22 Always outperforming

The Mac outperforms, consistently, and in all real-world
applications despite lower processor clock speeds. It has
proved time and again that the processor speeds don’t
really matter when it comes to bringing home the bacon.
A Mac is capable of running more ‘heavy’ applications at
the same time—and it does it faster than ordinary PCs.
This, if nothing else, is the one big reason why profes-
sionals, especially designers, love the Mac. They worship
it. True colour reproduction is another factor that adds to
the cult worship. What they see on the screen is what
they get in real life. It’s hard not to get affected by the
Mac’s unblemished performance, if you own one.
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Plug and play
The Mac offers superb plug-and-play capabilities—no
missing drivers, no resetting jumpers or bothersome IRQ
conflicts, nothing—thanks to the complete control and
clearly defined vision that Apple has for the architecture.

Apple had plug-and-play on their machines since the
mid 1980s (Microsoft had plug-and-play only Windows 95
onwards). This early advantage has helped them perfect
the technology to a very fine tune—you can hear it
almost. Just plug in any number of devices to a Mac and
get away with it—adding (or removing) hardware is not a
problem with Macs.

It’s virusproof
A Mac is comparatively more secure; it has limited vul-
nerability to viruses as compared to Windows. Mac users
have been protected from most of the chaos wreaked by
virulent viruses worldwide. The main reason is that there
aren’t many viruses, worms or Trojans around that target
the Macintosh OS. The OS is very secure, as in, it’s not
lucrative enough for hackers to make viruses for the Mac.

Great multimedia capabilities
Games and multimedia look and sound great on a Mac.
Though there are fewer games available for the Mac plat-
form, the most popular games nowadays have also been
ported to the Mac platform. The games that are available
on both platforms (Windows and Mac) run really beauti-
fully on a Mac. You get extremely realistic graphics and
sound reproduction on Macs, which makes multimedia
and movie playback quite an experience.

Simple, yet elegant
Apple made the GUI. A well-designed, neat, and easy
graphical user interface makes all the difference between
instant liking and disliking. An iMac is easy; it has won
awards for best design and the designers have kept the
utilitarian aspect in mind. You won’t get lost in there try-
ing to figure out what you were doing in the first place. 

Chances are, you won’t be put off by the new iMac.
One wonders what the purpose of computing is if it’s not
keeping it easy and simple, yet elegant.

Easy to setup
It’s easier and faster to set up a Mac than a Windows
machine. This has been proved more than once in real
time tests where the Mac took lesser time to set up and
run than a Windows machine. The proprietary architec-
ture adopted by Apple makes it easier and quicker for a
user to set it up. The OS comes preinstalled and the 
connection points for the peripheral devices are clearly
marked so that you can put a Mac together all by 
yourself.

It’s cool
A community or a cult is always close-knit. Likewise,
Mac users have, and will claim, more affinity within
themselves than ordinary Windows users. In other
words, it’s cool to own a Mac. First of all, you’ve got to
reach that position when you can afford it, and second-
ly, it looks so good and handles even better! What else
does cool mean?
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Hell’s Angels is not the ultimate cult, in case
you thought it was. You probably haven’t
met Mac owners yet. These are people
absolutely passionate about what they are
doing. They do not tolerate insults against a
Mac easily, and you can’t blame them. They
are trying to do things differently, after all!

It’s not common to overhear a conversa-
tion about an iMac in your college corridor.
If you have worked on or owned a Mac,
you’d know exactly what we mean—the
exalted status, the enthusiasm brimming
over when words issue from a frothy mouth
talking animatedly about the latest iMac
wonder...It’s rare to see this in India because

to get into this silly, spasmodic state, you
have to be a part of the Mac addicts club.
From the graceful simplicity of the iPod to
the easy-to-install AirPort to the formidable
OS X—Apple’s idea behind all products and
designs is a very simple and basic one: mix
beauty with performance. An iMac is not a
machine, it is a treat. Hence the addiction.

Mac Addicts

WHEN MY MAC 
WENT BUST

Do you have to send my
Mac to Bangalore? Is
there no other way to

repair it?

No sir, this is India!
Don’t worry, it’ll be

back soon.

It’s been 
2 weeks since 

you promised to
have the Mac

delivered. What
happened?

These things 
take time sir. They have

no technicians there
right now. You’ll have to

wait, sir.

I’m still waiting for
my Mac. What?! You
are NOW telling me
that my hard disk’s

crashed?!

Sorry sir! 
Took time to

figure out the
problem. IL

LU
ST

R
A
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O

N
:
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Far too expensive
The Windows world is not as expensive as Apple, delivers
a reasonable performance, and more importantly, takes
pains to welcome you. On the other hand, there are no
assembled Macs available, and the price of an entry-level
Mac desktop is Rs 58,000. Windows is cheap, and it sells.

Limited choice of software
If you are big, you can offer more choice. Compared to the
PC platform, Mac has limited software available. Although
you will get almost everything you need, the choice will
still be lesser—it’s a comparative difference, but it’s still a
difference. Microsoft offers a much wider choice.

Thin service
PC problems with Windows-based machines are easy to
solve. Just call a technician and ask him/her to fix your
computer. But Macintoshes require trained technicians to
take care of them. Such technicians are unheard of in
India, and for that matter, so are Apple showrooms. This
single has been a major turn off for prospective buyers.
The service factor has to improve, before anything else. 

Non-upgradable
Macs, unlike Windows, are not meant to be upgraded,
except probably for the hard disk and the RAM, and you
can’t do much of an upgrade on an iMac anyway.
Windows, on the other hand, makes sure it offers you a
choice (sometimes thrusts it at you) to upgrade. You can
upgrade your way through the entire 9x series, literally. In
short, if you have a hardware problem with your Mac in
India, you are gone!

Not a great team player
While Apple constantly receives a lot of compliments from
professional users all over the world, organisations have
been wary of adopting Macs as the platform lacks tools—
server applications, collaborative tools, and industrial
strength database applications—that address the needs of
any modern organisation.

So that’s it, the points are all here for you to see and
decide: is there room in your life for a Mac? If not, you can
carry on and if yes, you’ll have to change your lifestyle!

ANIL PATRICK R.

5 Reasons not to buy a Mac
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It’s almost 80 per cent
cheaper to buy a Mac

from abroad than in India.
The problem is that most
of the local Mac vendors
do not recognise the global
warranty

C. Radhakrishnan
PHOTOGRAPHER AND MAC
DEVOTEE

■ First steps: Apple I, the first commercial computer from
Apple, is launched in April 1976. 
■ Tasting success: Apple II, the first computer to use a plastic
case, including colour graphics support, is launched. It is Apple’s
first major commercial success. 
■ Mainstream GUI: Macintosh 128 k, the first affordable com-
puter with a Graphical User Interface, comes out with a floppy drive.
■ Stepping outside: The PowerBook series launched in ‘91 is a
runaway success.
■ Computing muscle: The PowerMac debuts in ‘94 and is the
first computer to be powered by PowerPC processors.
■ Winning consumers: The iMac made a million hearts skip a
beat in May ‘98 and stormed the lower-end consumer market. 
■ Super powered: The PowerMac G4, a ‘supercomputer on a
chip’, arrives in September ‘99, capable of executing more than a
billion instructions per second. 
■ OS X: Releases in 2001 with a redesigned user interface (called
Aqua) and the rock-solid UNIX core (called Darwin).

Landmarks @ Apple

There are several pitfalls a Mac user has to get used to, like
money, which you need lots of, and service, which you hard-

ly get in India, and perhaps the most important one: common
availability. How many Apple showrooms have you seen? People
definitely have reasons to stay with Windows, yet.

I lost all data, 
missed out on work,

and now you tell me I
STILL have to wait?!

Relax sir! Take this CD of 
recovered files and listen: Why

not buy a new iMac for only 
Rs 80,000? Think sir, and have a

thanda Coke sir.
Enough! You 

see that 
showroom? I’m going 

to buy a PC from
there right now!

No sir! Wait!! Look, I’ve
got Windows right here!

So
I went
back to
Windows



test drive ■
■ start up

60 MARCH 2002

Reviewers at the Digital
Media Test & Research
Centre (DMTRC) spend
many manhours every

month testing hardware and soft-
ware to guide Digit readers to
make an informed choice when
faced with a buying decision. At
the core of the tests is the usabili-
ty and the relevence of the tech-
nology for the readers of Digit.

To ensure that the Indian read-
ers do not have to compromise on
qualiy, engineers  at DMTRC evalu-
ate and review the latest hardware,
software and technology services in
accordance with the most cutting-
edge evaluation processes and
methodologies used around the world.

Demystifying the 
ratings 
The DMTRC conducts two
kinds of tests/reviews in 
the Test Drive section of the
magaz ine—standalone
product reviews as well as
comparison tests. The test
process is elaborate. We test
an assortment of hardware
and software products from
the Indian market, and 
the evaluation processes
involve parameters such as
sheer performance, build
quality, value for money
and the features of the prod-
uct. A set of weightages are
applied to these evaluation
parameters to arrive at an
overall score. The table

given below is used in applying the overall
grades to these products based upon the over-
all scores.

In the case of the comparison tests, the
weightages are applied to the various test
parameters according to their importance. This
is explained in the magazine articles and in the
Test Process section of the CD, where the
benchmarking methodology is explained in
detail.

The Awards
Digit rewards exceptional per-
formance in each comparison
test by picking a Best Perfor-
mance winner. This award goes

to the product that outshines the competition
in our performance benchmarks. The Best Value
award, on the other hand, is awarded to the
product that we feel has the best combination
of price and performance. Consider this your
yardstick if you are looking for more value for
your money.

How we Test
For this months compari-
son test we have an
assortment of laptops.
We got to lay our hands
on a selected
group of 10
laptops,
from the
classy Com-
paqs to the
sleek Sharp!
As a matter of
fact, the Sharp Muramasu
PC UM10 literally had
the entire Test Centre
and the rest of the team
drooling. A complete
opposite was the brute
force solution from ACi—
the ACi Xtreme was truly
a bully of a laptop with
its rather oversized LCD
screen. 

In the software com-
parison, we scrounged
the Internet for great
freeware—the best that’s
available. Some were old
favourites while for other
categories we were pleas-
antly surprised to find
some new alternatives
that offered great func-
tionality. The freeware
revolution clearly contin-
ues to thrive.

In Test this Month

Featured in the Test
Drive section of the
Mindware CD are 30
great freeware. Go
ahead. Try them out for
yourself. 

It looks good and the technology is glitzy, but does it do the job?

Excellent: a brilliant combination of price, performance and features, far 
beyond expectations
Good: a good buy, better than most products in its category
Average: reasonably competent but nothing spectacular about the product
Mediocre: does not live up to expectations, needs improvement in many areas
Poor: contains serious drawbacks and needs improvement before it can be 
used for the target application

Mindware
STAR RATINGS



62 MARCH 2002

test drive ■
■ laptops

Our reviewers roll up their
sleeves and set to review the
sleekest laptops and
notebooks in the market. The
criteria is very simple: both
performance and looks 

0bil
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G
ourmet dinners, beluga
caviar, attractive flight
attendants, movies
playing at 15,000 feet
altitude, a jetsetting
lifestyle. If you think

this is the kind of person who uses lap-
tops, wake up! It’s as easy churning out
corporate presentations as it is easy play-
ing crispy-clear DVDs or battling a war-
crazed alien race from conquering plan-
et earth, and all of it an affordable price.

It’s now possible to have that chic note-
book, and enter some serious entertain-
ment (and work) phase. Desktops are
passé—step up that corporate ladder and
take a check on your dated computer. 

If you are confused about which fea-
tures to choose, don’t worry. We have the
features all sorted out. Also, you shouldn’t
be fretting over how to get software—all
major applications are bundled free and
the service and support network is better
than what any desktop user can expect. 

PHOTOGRAPH: Mexy Xavier



MARCH 200263

So if you think it’s time to decide
which laptop will work the best for you,
depending on your needs and personali-
ty, then you’ll find the products lined up
here seriously fast and stylish. They’ll
match your lifestyle provided you match
theirs—anything between Rs 70,000 to Rs
1,50,000.

Core configuration
There is a minimum level of computing
power that is required for most modern
applications. If you plan to use the laptop
extensively for office productivity-related
applications, then you should at least look
at a machine that offers you 500 MHz or
more computing power. This along with a
decent amount of RAM (128 MB) will get
you through most applications without a
hiccup. The hiccupping starts when you
have a poorly configured system (read
chipset and processor combination)
internally which you will simply have to
live with, considering the fact that with
laptops you don’t have the option of
changing motherboard chipsets.

Models from Compaq and ACI were
decently configured in terms of pure pro-
cessing power. Both the Compaq Presario
1722 and the Compaq Presario 1725 came
with 1 GHz+ Pentium III processors. In
fact, the Compaq Presario 1725 came with
the top-of-the-line Tualatin Pentium III-
M 1.13 GHz processor. ACI, on the other
hand, has all its models configured with at
least 1 GHz and above class processors.
The ACI Profile 2860 comes fitted with a

Celeron 1 GHz and the Profile 3270 comes
with a Pentium III-M 1.26 GHz (Tualatin)
processor. Also, models from ACI featured
GHz class processors, the ACI Profile 3270,
and the ACI Xtreme came configured with
1.26 and 1.2 GHz respectively. The ACI
Profile 2860 came configured with a
Celeron 1 GHz processor.

All the notebooks that we received
had decent computing power and did not
behave sluggishly, even though some of
them had Windows XP Home edition as
their standard operating system. 

Let’s move on to the next critical com-
ponent in a laptop: RAM. SODIMM (small
outline dual inline memory module), as it
is called with 144 pin and 3.3 V (instead
of regular 168 pin SDRAM and 184 pin
DDR-SDRAM), voltage rating is what is
used in laptops. RAM is usually placed
under the keyboard so that it can be easi-
ly removed when upgrading. Sometimes
the RAM is placed near the bottom, like
the Sony Viao, for easy access. To save
space and reduce width of the laptop, the
RAM is fixed flat on the board and not ver-
tically as in a desktop. 

All the laptops except for the Compaq
Armada came configured with at least 128
MB RAM, and some even came config-
ured with 256 MB RAM. Of course, this
fact showed in the scores. Two out of the
three models from ACI came with 256
MB RAM, and so did the Compaq Presario
1725. The rest were quite stuck in the
ordinary computing territory and came
configured with 128 MB of RAM.

The last of the critical component in a
laptop is the hard drive. The hard drives
of laptops are smaller than that of regular
desktops—they are of 2.5-inch rather

Mobile CPUs 
The CPU is without doubt the most criti-
cal component. Its integration into the
laptop has major implications as it draws
a lot of power, drains resources, and out-
puts considerable heat. Since space is
restricted, adequate cooling while main-
taining low noise levels is important. The
‘mobile’ processor is much smaller
(Micro FCPGA2 and FCBGA2 Packaging.
These special miniature packages enable
thinnest and the lightest notebooks) and
has some very nifty instructions built in
for conserving power and reducing heat
output. For example, the Pentium III uses
Enhanced Intel SpeedStep Technology
wherein the processor automatically
switches between two core frequencies
based on CPU demand, optimising bat-
tery life and application performance.
Another great feature is ‘QuickStart’
which simply extends battery life by
reducing power during pauses in user
activity, such as between keystrokes and
minor idle states. Deeper Sleep alert state
is a dynamic power management mode
which is enabled during less than a mil-
lisecond of inactivity by the user, such as
between keystrokes, thus delivering
longer battery life.

Just the thought of seeing primitive ren-
dering and lacklustre performance puts off
most users when it comes to 3D graphics
on a laptop. 

The primary reason for dated graphics
on laptops was the fact that most laptop
manufacturers used chipset solutions that
provided no AGP functionality. If included,
it would be integrated in the chipset so as
to consume less space and generate little
heat so that there would be no need for
extra cooling. So if you planned to show
that amazing rendering in 3D Studio Max
on a laptop, you simply couldn’t. 

Integrated chipset-based shared mem-
ory architecture-dependent graphics cards
are still the norm for laptops. But the trend
is slowly and steadily moving towards bet-

ter and faster solutions with top 3D graph-
ics chip manufacturing companies show-
ing an increasing interest in this area. 

ATi, the world’s largest provider of
OEM graphics chips for laptops, has
released the ATi Radeon Mobility, a chip
which came integrated in the ACi Xtreme
laptop that we received for testing. The
results were simply astounding. Not only
was the quality of 2D top notch but the
Xtreme had an uncanny knack of running
Quake III at a whopping speed of 105 fps
in normal mode.

The Mobility packs in a single pipeline
architecture with the ability to render three
texture units in one pass. The ACi Xtreme
featured 32 MB of dedicated graphics DDR
memory to boot.

So what’s the hit, you ask? Well little, if
any. The Radeon Mobility has some really
cool features to ensure that battery power
consumption still remains at low levels by
using what ATi calls the ‘Voltage/Frequen-
cy Modulation’ feature. This feature basi-
cally allows the chip to run much slower
and hence consume less power when the
laptop is being used for mundane desktop
tasks. But the minute you crank up a 3D
application, the Radeon Mobility kicks in,
unleashing all of the power that even
some desktop PCs don’t have. 

Features like alpha sub-picture blend-
ing and adaptive de-interlacing provide
picture-enhancing quality, and other fea-
tures like iDCT and motion compensation
augment performance. You can now final-
ly run cool graphics and games, and ren-
der that high polygon count object in 3D
Studio Max right on your laptop!

VIDEO CARDS FOR LAPTOPS

ATi Radeon Mobility Comes out Trumps!



than the regular 3.5-inch form factor. This
also adversely affects the maximum
capacity available: to have a 40 GB or
higher drive in a laptop is a really tough
achievement. The power requirements
have also been modified—this makes the
drives run slower, averaging a seek time of
13 ms, and only 4,200 or so rpm.

All the notebooks came with at least
20 GB drive space. Compaq Presario 1725
stood tall by providing a whopping 40 GB
drive. The ACI Profile 3270 and the ACI
Xtreme were not too far behind with 30
GB drives.

Performance
What really matters in day-to-day tasks is
the core configuration. Let’s take a look
at the tests.

The scores for Business Winstone 2001
are important: it is a system-level, appli-
cation-based benchmark that measures
overall performance when running a suite
of office productivity applications. Here
we sought a range: scores of 20 and below
were considered average, between 20 to
30 were adjudged good, and 30 and above
were clearly excellent. 

Anything that logs a score near 20
should be considered a notebook that can
handle most office applications with ease;
it wouldn’t have problems running the
latest OSes. Here we found most note-
books cleared the 20 mark without any
difficulty. The Compaq Presario 1725
scored an amazing 53.4. 

Next, we ran Content Creation Win-
stone 2001. Here too you can apply the
same rule for scores as Business Winstone
2001. Content Creation is a more multi-

media-heavy benchmark and the
scores are generally expected to
be low. Despite this, we dis-
covered that most of the note-

books could clear the 20 figure with rela-
tive ease. The Presario 1725 was no sur-
prise, as it again scored high (51.3). The
ACI Profile 3270 and the ACI Xtreme
faired well too, scoring 37.4 and 36
respectively. All said and done, the Com-
paq Presario 1725 showed its pedigree by
truly stamping its authority all through
the benchmarks. It is a notebook power
users would love to possess (and display).

While considering a new laptop, you
should be aware of enjoying a computing
experience with better display screens and
graphics cards. All major laptop manufac-
turers are integrating formidable graphics
cards with full OpenGL and Direct3D
functionality, coupled with hardware-
based DVD decoding capabilities.

To test the ability of the graphics card
to run OpenGL and Direct 3D games and
applications, we ran 3DMARK 2000 and
Quake III: Arena as part of a passive test
(passive because the test was only to judge
whether the notebook was able to run the
application). Surprisingly, we found that
most notebooks could actually run Quake
III—and some could run it pretty well! As
a matter of fact, the ACI Xtreme came out
as the top dog: it blazed away in Quake III

test drive ■
■ laptops
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Laptops have to be functionally competent
besides being really small, portable and
easy to use. To evaluate such purposeful
devices purely on the basis of performance
seems unfair—we can’t be blind to the fact
that laptops are severely handicapped in
terms of space and power. Hence, we have
accorded more weightage to features as
well as the ability to add more peripherals.
When choosing a laptop, you should first
determine the features that are important
to you. 
1. Performance: We ran office productivity-
related benchmarks like Business Winstone
2001 and Content Creation Winstone 2001,
besides the BatteryMark 4.01 which tests
the battery output. To test for 
OpenGL and Direct3D compliance,
we ran Quake III Arena and
3DMARK 2000 to determine
whether the laptop was capable of
decent graphical output or not
(remember no benchmarks 
were run).
2. Core configuration: The core
configuration should be well
matched with the critical compo-

nents (CPU, Chipset, RAM and the drive
space offered). We set a minimum of 500
MHz of processing power, 64 MB of RAM,
and 10 GB of hard drive space as the nec-
essary requirements. This is the least one
can expect for running the latest Operat-
ing Systems and applications. 
3. I/O functionality expandability: With-
out this the notebook would become an
isolated computing device with no ability
to communicate with others. These come
in the form of serial, parallel, USB, and
PCMCIA ports. Our list of minimum
required ports is: one Type-II or Type-I
PCMCIA slot, one serial port, one parallel
port, one PS/2 port, one Mic In / One
audio output, two USB ports, one RJ-11

modem jack, one RJ-45 LAN
jack, one S-Video out, one 4

Mbps IrDA Comm port.
4. Package contents and accessories:
Here we noted the software bundle and
package contents of the notebook.  
5. Build quality and ergonomics: This is
the most subjective part of the test; hence
opinions from three individuals were taken.
Extra points were awarded for exceptional
looks and design. 
6. Software bundling: We focused on the
operating system here:  higher marks were
awarded to Notebooks that bundled the
Windows XP home edition. Also, more
marks were awarded to notebooks that
offered office suites, management tools,
and some sort of system recovery software. 
7. Display: This was checked for the maxi-
mum possible resolution, screen size, and
the number of inactive pixels, if any. 

8. Extra goodies: Extra
points were awarded to lap-
tops bundling a lot of
extras—DVD, CD-RW,
Combo, Superdrive, extra
external storage devices,
MP3 player capabilities, USB
2.0 functionality, and so on.

Digit Test Process

“Convenience, mobility and
stamina in terms of battery
life takes precedence over
performance”

Hatim Kantawalla,
Deputy Head, Test Centre, Jasubhai Digital Media
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making a mockery of some poorly pow-
ered desktops. This model comes built
with an ATI M6-P Integrated AGP 4X
graphics card which has a fully DirectX 8
compliant graphics engine, coupled with
32 MB of ultra fast DDR memory. 

Direct3D functionality was pretty
decent too, and some notebooks like the
Compaq Presario 1725 even went on to
complete the 3DMARK 2000 benchmark. 

Just goes to show that if you are in the
mood for that odd game or two while
traveling at 35,000 feet altitude, you
won’t be disappointed. 

Battery power
The ability to put your laptop on in a
remote location with no electrical source
is true computing freedom. NiCad (Nick-
le Cadmium) and NiMH (Nickle Metal-
Hydride) were the more popular types of
batteries used in laptops. These have now
been replaced by the ever-popular Li-Ion
(Lithium-Ion) batteries, which provide a
longer life and cannot be overcharged.
This makes it ideal for laptops. Also, due
to higher density, these batteries are
smaller and lighter than NiMH batteries.

All the laptops came fitted with lithium
ion batteries. To drain the notebook’s bat-
tery, we ran BatteryMark 4.01, which uses
the tests of Business Winstone 2001. This
benchmark is scripted in such a way that it
runs applications which drain a notebook’s
battery—it mimics real-time usage.

We warmed up the notebook by run-
ning it for an hour; the battery was then
left to charge overnight. All power man-
agement software was disabled and the
notebook was then disconnected from
the mains. Expect an extra 10-20 per cent
battery performance if you have power
management enabled.

Almost all the notebooks
had a battery life of about
one-and-a-half hours under
this test. Except for one, the
ACI Xtreme truly took battery
power to an ‘extreme’. This
notebook comes specially fit-
ted with a 5-hour rated bat-
tery and it ran admirably in
our tests for an amazing 3
hours 43 minutes. Using power
management, this notebook can
easily cross 4 hours of nonstop usage.
The ACi Xtreme comes with another 5-
hour battery as an extra—this gives you
nonstop usage of over 8 hours!

Another notable mention was the
Cerebra notebook, which came close to

crossing the 2-hour barrier in non-stop
usage by scoring 1 hour 56 minutes. The
Compaq Presario 1725 scored a
respectable 1 hour 52 minutes. 

I/O functionality, features and
expandability
Laptops also come with additional docking
connections which allow users to connect
an extra monitor, keyboard, mouse, print-
er, etc to the laptop and use it as a regular
desktop PC. Most computers have the
infrared port so that other infrared devices
like PDA can be used with the laptop.

The I/O functionality of the laptops
was tested against a minimum require-

ment of certain ports and
features. 

Most of the laptops ful-
filled our minimum criteri-
on and were well
equipped. Notably, both
the Compaq Presario note-
books featured an IEEE

1394 FireWire port.
This port also

came standard
with the Sharp
AR-50, ACi

Xtreme and the ACi
Profile 3270.

The ACi Xtreme, Zenith One up, Sharp
AR-50 and the Compaq Armada E-500
also came with two PCMCIA Type II slots.
The rest came with only one.

In terms of raw features the Compaq
Presario 1725 towered over others, fea-
turing JBL Pro Audio with Bass reflex and
Dolby Digital certified sound that was
hard to beat. The musical output of this
notebook was truly inspiring, a far cry
from the tiny speakers that came with the
remaining models.  Nevertheless, the ACi
Xtreme wasn’t far behind: it featured one
Sony standard Memory Stick along with
one Panasonic SD Memory card, support
for optional 802.11b Wireless LAN, and a
3D enhanced sound system using a
Sound-Blaster PRO interface. The ACi
Xtreme that we received had a DVD-ROM
drive attached. The Compaq Presario
1725, on the other hand, came fitted with
a hot swappable 4x4x24x6xCD-RW-DVD
combo drive. The Sharp AR-50 too had an
8x/4x/24x CD-Writer.

Quality and display size 
The thin flat LCD (Liquid Crystal Diode)
display on a laptop or notebook is the
most delicate of all components, and also
a major chunk of the cost component of
a notebook. While the performance was-
n’t comparable to CRTs earlier on, the lat-
est developments in size and transistor
response times have made displays pretty
comparable. Bad transistors and pixels are
a part and parcel of the entire laptop
experience. Though this problem has
been fixed to a certain degree with more
expensive notebooks, you still need to be
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careful while using them. However, you
will always know a good LCD screen
when you see one. The screen size avail-
able today is as high as 15.1-inch and the
resolution supported due to a good inte-
grated graphics sub-system can go as high
as 1600x1200 wide screen.

Since looks matter more, the compe-
tition in this space is fiercer. Every inch is
important, and resolutions and sizes of
screens have become critical factors in
buying decisions. 

In terms of pure size, there was no
question as to who the winner was: The
ACi Xtreme. It showed how much
‘extreme’ can stretch with a uniquely fit-
ted 15.1-inch SXGA TFT screen support-
ing a maximum resolution of 1400x
1050. 

The rest of the notebooks were using
standard 14.1 Active Matrix XGA TFT
screens with support for a resolution of
1400x1050 and 16 million colors. The
build quality of the Compaq and the ACi
screens was top-notch. Sharp screens had
impressive clarity, especially the Mura-
masu PC UM10, which had a 12.1-inch
TFT screen with excellent sharpness and
colour rendition. None of the laptops had
any artifacting on the screens or, more
notably, bad pixels.

The responsiveness of the TFT screens
was also checked for. This was done while
running Quake III. There was only a slight
motion blur on most screens when there
was excessive movement in the game.
This made watching DVDs or VCDs an
enjoyable experience. Overall, the Sharp
AR-50 was the winner in terms of screen
clarity and sharpness.

Accessories and software bundle
Most of the notebooks came pre-
installed with the top-of-the-line Win-
dows XP Home edition as the standard
operating system. Sharp’s notebooks
came bundled with Windows Me while
the Zenith 21A and the Compaq Arma-
da E-500 came with the dated Windows
98 SE as the OS.

The Presario series came bundled with
the most impressive software—Microsoft
Windows XP Home Edition, coupled with
Microsoft Works 6, Win DVD, and sepa-
rate CDs of Money 2001, Norton Anti-
Virus 2002, Studio DV as well as an
impressive CD documentation explaining
the entire package in detail. One more
thing, the software bundle came along
with a special OS crash recovery CD to
minimise downtimes.

Sharp AR-50 had software bundled
with Adaptec Easy CD Creator, MGI Pho-
toSuite III SE, TCI Fax Talk, Voquette
Media Manager, and McAfee VirusScan. 

The Zenith 21A was the barest mini-
mum in these terms. It just had a Win-
dows 98 SE licensed CD and a manual.

Build quality, ergonomics and
weight
This is probably the most subjective of all
the tests. But a few things here stand out
immediately. For example, there was no
doubting the supreme build quality of the
Presario notebooks. The clamshells of
these notebooks were truly professional
and aesthetic. From the way you open the
notebook to the manner in which the
keyboard is laid out—everything about
the Presario oozes confidence and flam-
boyant design. It weighs 2.36 kg, is easy to
work with, possesses a superior key lay-
out, and its beveled and softly curved
palm rests easy on the wrist. Working
with the Presario is made pleasurable with
a four-way Internet scroll, instant Inter-
net, and audio and e-mail launch keys. It
has a special digital one-touch control for
volume control and a full size keyboard
with separate cursor control keys. The
speakers too are intelligently placed on
the front side, unlike some other note-
books where the palm itself rests on the
speaker and hinders the audio output. 

The Sharp series has focused more on

test drive ■
■ laptops
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Like any other device, laptops too need a fair
share of care and maintenance, sometimes a
little more than desktop PCs.

Try to keep the computer as clean as
possible. Avoid transporting or using it in
dusty environments. Use the carrying bag
provided or some other clean container
when you transport the laptop.

Make sure the computer is turned off
before unplugging it. When you discon-
nect cords, remember to pull them by the
plugs and not by the cords themselves.
This will prevent damage to the cords,
plugs, ports, and jacks.

Use a high-quality electrical surge protec-
tor, if possible, when the AC adapter powers
your computer. It is also a good idea to

unplug your computer when it is not in use. 
How do I clean the display? 
Use a soft damp cloth, clean the surface of
the screen gently. If there are stubborn
dirt stains, do not put more pressure.
Instead, use ISO Propyl alcohol to clean
the stain. Do not use gritty, rough-tex-
tured cloth or paper to clean the screen as
this can leave permanent scratches. 
How do I dust the keyboard? 
Blow hard into the keyboard and then
gently turn the laptop upside down. This
should get rid of all loose dust and grit
that may have accumulated between the
keyboard keys. Alternatively, you could
also use a vacuum cleaner to blow out any
dirt that might deposited on the keyboard. 

What about the battery?
A common problem faced by most laptop
users is the progressive deterioration in
reliability after the first year of service. This
loss occurs gradually without the user
knowing. Even though the battery may
show as fully charged, its capacity to hold
that charge diminishes to the extent that it
may sometimes hold less than half its orig-
inal capacity. 

Batteries work best if they are com-
pletely discharged before recharging, and
that goes for all types (though Lithium-Ion
needs this less frequently). When you start
using your battery for the first time, drain
and recharge it entirely at least three or
four times.

Laptop Maintenance and Care



the simplicity of design. The PC-UM10 is
an ultra-light notebook weighing less
than 1.3 kg, and so is the lightweight
Muramasu. With a thickness of about 16
mm, there is almost no competition to
this notebook. Couple this with the fact
that it features a really cool magnesium
clamshell casing and a brilliant keyboard.
Then add to the fact that Sharp makes
some excellent build quality screens. Put
all these points together and this note-
book becomes a statement by itself. 

The ACi Xtreme—though the name
doesn’t tell you that—is built like a rock.
It is big and robust with a matching colour
combination and weighs all of 3.6 kg. It
actually makes a desktop look skinny! 

The bottom line
When it comes to performance in a com-
plete package, the Compaq Presario 1725
is the thing. Configured like a desktop
and built like a portable, it lives up to all
the expectations that you would have
from a neat little notebook. The only
gripe we had was that it lacked a decent
graphics card, but then that’s a minor
gripe. Worthy mentions here are no
doubt the ACi Xtreme and the Sharp AR-
50. The ACi Xtreme loses out because of
its relative lack of finesse and rather bulky
design. 

If you want a laptop without spending
too much, then the Zenith 21A is your
best bet. It wins the Digit Best Value
award hands down for very simple rea-
sons: a decent looking laptop for 
Rs 75,000 that bundles almost every pos-
sible external peripheral that you would
desire. The Zenith 21A really takes the
cake by bundling a set-top TV tuner mod-
ule with a remote and cigarette lighter
battery charger!

The Winners!
Compaq Presario 1722
This is a slickly designed machines with a
vibrant colour combination of silver and
dark blue. Configured with a P-III-M 1GHz
processor, 128 MB RAM and a 14.1-inch

XGA Active Matrix Display (as well as an
ATI Mobility Radeon 8MB DDR graphics
card), this is one of the fastest notebooks.
Highlighted here are the JBL Pro speakers
that reproduce crystal clear sound with
crisp notes and deep, bassy lows. Storage
is taken care of by a 30 GB hard disk as
well as an 8x DVD swappable with floppy
drive. The Presario also has a plethora of
bundled applications including Norton
AntiVirus 2002, MS Money 2001 Stan-
dard, Pinnacle Studio version 7SE, as well
as 30 hours of bundled Internet account
from Satyam.

In the tests, the Presario displayed fair-
ly good results in both office productivi-
ty and gaming. In Content Creation
2001, it generated an index of 34.9 and
36.7 in Business Winstone 2001. In short,
this is a machine which works excellent-
ly both as a desktop replacement as well
as a notebook. 

Rating: A-
Verdict: The Compaq 1722 oozes class
in build quality and performance.

ACi Xtreme
This notebook features an amazing dual
battery pack bundle that theoretically
gives users 10 hours of battery power
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Radical designs and innovation. That’s
what everybody expects from Apple. Last
year Apple came out with the PowerBook
G4—its inventiveness ranging from the
simple magnetic hinge holding the screen
in place to the one-touch battery status
indicator and the glowing light behind the
screen. Now, when you look at the iBook,
it automatically becomes clear how far the
designers have come from the G4. The
clear white shell looks nothing less than
stunning, the finishing inside is appeal
redefined, and the design reiterates
Apple’s position as the industry leader in
design. Even though the iBook is slightly
bulkier and slower
than the G4, it is
still way ahead of
any other laptop(s)
we received in this
test. The 1024x768
TFT display is
bright and respon-
sive (like the G4),
there’s a G3 600

MHz processor
inside which is
twice as power-
ful as the last
iBook, you have
all connectors
you would ever
require, and it runs 5 hours on a full
charge. The high-end series comes with a
DVD CD-RW combo drive, 256 MB of
RAM, built-in wireless antenna, and…well,
so much more that you’ll have to see it all
yourself. Not to forget that it comes pre-
loaded with OS X 10.1. The iBook. Intelli-
gently beautiful. 

The New iBook

Specs
CPU
RAM
Graphics
HDD
Optical
Screen

iBook
G3 600 MHz
256 MB
ATI Rage Mobility 8 MB
30 GB
CD-RW DVD Combo
12.1-inch Active Matrix
TFT, 1024x768

PowerBook G4 
G4 550 MHz
256 MB
ATI Radeon Mobility 16 MB
30 GB
Slot Loading DVD
15.2-inch Active Matrix
TFT, 1152x768

iBook vs PowerBook G4

➜
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while on the move. However,
this does not come across as
uninterrupted, since there are
two separate 5-hour rated bat-
teries provided with the note-
book.  The test for a single bat-
tery charged to the maximum
gave us a result of 3 hours and
43 minutes, which is excellent.
Another great thing about this
laptop is the 15.1 XGA Active
Matrix screen with the ATi
Mobility Radeon graphics card
supporting a maximum reso-
lution of 1400x1050. For those
who enjoy an odd gaming ses-
sion, this notebook is a proper
delight with Quake III per-
forming excellently at scores of
105 fps in normal settings. 

Configured with a P-III 1.2 GHz
mobile processor, 256 MB RAM, 30 GB of
hard disk space, 8x DVD and all the stan-
dard features and connectors, this laptop
is a perfect desktop replacement besides
tough a mobile workhorse. But with a

weight of 3.5
kg, it is a little
bulky. Another
ment ionab l e
feature is the
availability of a
Sony memory

stick slot

along with Pana-
sonic SD Memory card, which can be very
useful if you use a digital camera or MP3
player. As far as benchmarking goes, it
generated an index of 36 in Content Cre-
ation 2001 and 32.7 in Business Winstone
2001. Overall, users looking  for a feature-
rich desktop replacement with very less
mobility would prefer this. 

Rating: B+
Verdict: Xtreme is a great desktop
replacement in the truest sense.

Zenith One Up- 21A
This brand came in armed with a band of
goodies and freebies—an external USB TV
Tuner with remote, Vehicle Power
Adapter (for charging laptops while on
the move in a vehicle), CD for relevant
drivers, Windows 98SE and an Internet

starter pack with 25 hours of free surfing
time. This laptop was configured with a P-
III 850 MHz processor, 128 MB RAM, and
a 20 GB hard disk. A floppy drive and an
8x CD-Writer make the notebook a per-
fect portable companion. It has a 14.1-
inch XGA TFT display and the battery
supports a lifespan of almost one-and-a-
half hours (1:35 mts).

This laptop was fully configured and
came pre-installed with Windows 98SE.
At one point we noticed here was that the
battery not getting fully charged. We
spoke to Zenith and the laptop was
replaced with a perfectly  working battery
within a short span of time (approx 2
hours). That’s service, one might say!

In the tests, Content Creation gener-
ated an index of 28.7, which could be
mentioned at quite par, as the average
score for this configuration machine hov-
ers around an index of 30. A decent
machine, nevertheless, for its price.

Rating: B
Verdict: Packed to the hilt with any
external peripheral you can dream of.

Sharp Muramasa – PC UM10
This laptop from Sharp is one of the 

sleekest notebooks we’ve received, literal-
ly. It has a thickness of only 16 mm and
sports a bright silver color. It sports a
brushed aluminium casing and the design
looks clean and elegant. 

The floppy drive as well as the CD-
ROM drive bundled along have a special
USB interface and can be plugged into the
laptop using just one USB port, so you
would have to keep shuttling either of 
the drives. 

Another noteworthy feature in this
notebook is the high-resolution Active
Matrix display which allows you to view
the screen from an angle of 90 degrees.
Bundled along are applications like Win-
dows Me, MS Money, Internet Starter Kit,
and so on. Configuration with a P-III 

600 MHz proces-
sor, 128 MB RAM, and 20 GB Hard disk,
this machine definitely cannot be pitted
against P-III 1 GHz warriors, but with its
stunning looks and stylish features, 
it comes out on top as far as portability
goes.

Rating: B+
Verdict: Cute-looking laptop that
comes with a crisp TFT.

HATIM KANTAWALLA

You need

Look for

The models

Price range

General
A lightweight model but
don’t want to sacrifice
screen and keyboard size
A model that has an
extra bay that would
hold a CD/DVD-ROM,
floppy drive, add-on bat-
tery, or even a CD-RW
drive. These will general-
ly offer a 13/14-inch
XGA display and weigh
less than 3 kg
Zenith 21A, Sharp AR-
50
Rs 75,000-1,00,000

Desktop replacement
Something that gives you all
the functionality of your
existing desktop PC
Something that weighs
about 4 kg and has a 
15-inch (1280x1024) dis-
play. Most peripherals are
within the laptop’s chassis
itself. A graphics adapter
with 16 MB or more VRAM
and a DVD-ROM drive.

Compaq Presario 1725, ACi
Xtreme
Up to Rs 1,75,000

Ultra-portable
A bit more panache, an
ultra-light notebook might
hit the sweet spot 
You need a notebook lighter
than 2 kg and, therefore,
will have to suffer cramped
keyboard, smaller (lower)
resolutions. You will have
limited connectivity options

Sharp Muramasu PC UM10

Rs 1,00,000-1,50,000

Making a Choice
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H
ave you just spent thou-
sands of your hard earned
rupees on a new computer?
Well, brace yourself and get
ready to fork out some

more if you intend to do something use-
ful with it. Equipping your computer
with even the most basic set of applica-
tions can end up costing you a pretty
packet. Need a word processor? How
about trying out Microsoft Office at
almost Rs 20,000 per user? That’s big
bucks in any language.

Fortunately, there are a lot of pro-
grammers out there who choose to offer
software at no cost. And unlike what you
may have been led to believe, not all
freeware forces you to deal with
annoyances such as irritating pop-
ups, numerous bugs or limited fea-
tures. No matter what kind of
software you are searching for, there
is likely to be a free alternative out
there on the Internet that will fulfill
your needs and lead to big savings.
Since finding these free programs and
applications can be a trifle difficult, the
Digit Test Centre has scrounged the Inter-
net and picked out the best of the lot. Just
go ahead and try them out.

YATISH SUVARNA

ILLUSTRATION: Ram

test drive ■
■ free software

Presenting 30 software that work as good as any
commercial software and come at just the cost of 
a download

30 BEST

FREE
S O F T W A R E

The prices mentioned for the commercial software are approximate. The actual cost to users in India may vary. 
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HTML Editor
Serif WebPlus 1
Would you like to create a Web site of your own? WebPlus 1
makes it an absolute delight to create professional looking Web
sites by providing wizards for
almost every component
you wish to add to your site.
One nice feature it includes
is the Layout Checker which
analyses any problems such
as overlapping objects and long download times, and prompts
you to rectify the mistakes before you finally upload the Web
site. The inclusion of animated GIF files with a huge library of
images makes this software a pleasure to work with. 

Size: 15.2 MB
Web site: www.serif.com/webplus1/index.asp
Best Commercial Alternative: Macromedia Dreamweaver 4

Audio Encoder/Converter
Exact Audio Copy
This is an easy-to-use audio grabber. The software features
jitter correction, detection of pre-track gaps and silence in
pre-track gaps. It also includes a built-in Wav editor with
the basic functions for
editing audio. Another
feature of the software is
that it uses the Windows
95 and Windows NT ASPI
Interface, which enables it
to support both SCSI and
ATAPI CD-ROM drives.

Size: 2.65 MB
Web site: www.exactaudio-
copy.de
Best Commercial Alterna-
tive:  AudioCatalyst
You save: Rs 1,440

BACKUP TOOL
TaskZip
TaskZip is a system 
tool that automatically
archives specified files
and folders into a single
zip file. It also allows you
to backup files through
the network across different PCs, or even on to a Zip or Jaz
drive. TaskZip also supports scheduling of backup jobs. Anoth-
er good feature in this software is that in case of data loss, you
can highlight a backup job and with the click of a button, bring
up your default Windows zip shell to restore the corrupt files.

Size: 1.54 MB
Web site: www.jupiter.drw.net
Best Commercial Alternative: Active Backup Expert
You save: Rs 2,160

HARDWARE MONITORING TOOL
MBM 5.1
If you have a penchant for keeping track of your CPU and
mainboard temperature, you
will find this software handy. It
displays your chassis fan speeds
as well as RAM and CPU volt-
ages; it also displays the effec-
tive CPU speed in a graphical interface. You just need to speci-
fy your personal settings—the software automatically sends an
alarm notifying the user, thus helping him/her save the PC’s
vital components. You could alternately choose to start a pro-
gram automatically in case your machine bypasses the maxi-
mum threshold limit predefined in this program.

Size: 3.10 MB
Web site: http://mbm.livewiredev.com
Best Commercial Alternative: None

WEB SEARCH TOOL
WebFerret Version 4
If you’re looking for software that ferrets the exact
information you need from the Web, then WebFer-
ret it is! WebFerret uses search words that you can
choose from four radio buttons: all keywords, any
keyword, exact phrase, or boolean expression. It will
query popular search engines and simultaneously display unlim-
ited results. You can save your search history and filter pornog-
raphy and foul language. Once the search is complete, the dupli-
cate results are discarded and final results are displayed. 
Size: 1.22 MB
Web site: www.ferretsoft.com
Best Commercial Alternative: Copernic 2001 Pro
You save: Rs 3,838

FILE MANAGEMENT
Turbo Navigator v1.46
This is an advanced and highly customisable file manager for
Windows. It works just like
Windows Explorer but the differ-
ence is that it uses two file panels.
The software features full drag-and-
drop capability as well as the abili-
ty to wipe files from the disk so
they cannot be undeleted. You can
also preview movie or audio files
through the built-in Media Player,
which supports popular formats like WAV, MID, MP3, AVI, and MPEG.
This eliminates the need for any separate application for playing these
files. The software also sports a strong built-in encryption capability for
quick file encryption.

Size: 712 KB
Web site: http://198.76.30.115/download/index.html
Best Commercial Alternative: FileQuest XP file manager
You save: Rs 1,678

Rs 14,352
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ANTI-SPAM TOOL
EmC 5.0 
If you are tired of the junk crammed up in your
mailbox, EmC (Email Control), an anti-spamming
tool, will help you clean your inbox. It reduces
the number of junk mail which arrive in your
inbox using a combination of filters which can
be easily customised by the user. The good thing
about EmC is that it checks the mail while it is
still on your ISP’s server, and based on the filter
criteria that you have specified, it processes the
mail and optionally deletes all Spam or marks it
for deletion. 

Size: 2.82 MB
Web site: www.abreuretto.com/anti-spam/indexi.htm
Best Commercial Alternative: Mail Talk X
You save: Rs 958

BROWSER ADD-ON
Dzsoft Favourites
Search 
This is an Internet Explorer plug-
in that adds a convenient explor-
er bar using which you can search
in Favourites. This add-on is a
great tool if you are an active Web
surfer and have a lot of stuff in
your Favourites folder.

Size: 424 KB
Web site: www.dzsoft.com/
favseek.htm
Best Commercial Alternative: SurfSaver
You save: Rs 1,438

ANTI-VIRUS TOOL
Antivir Personal Edition
This anti-virus program provides effec-
tive protection against viruses and has
an easy-to-use interface. It can detect
and remove more than 50,000 viruses.
It has an Internet update wizard which
ensures that you are protected against
new viruses also. The Virus Guard fea-
ture provides background scanning,
thus your system is constantly moni-
tored for viral activity. 

Size: 6.19
Web site: www.free-av.com
Best Commercial Alternative: Panda Antivirus Titanium
You save: Rs 1,198

PERSONAL FIREWALL
Sygate Personal Firewall 4.2.872
Sygate Personal Firewall is designed to protect your comput-
er from hackers. The software
renders your protected
machine invisible to the out-
side world. It works in the
background, constantly look-
ing for intruders and Trojan
horse applications. In case an
intrusion attempt occurs, it detects it in real-time with built-
in host- and application-based intrusion detection technolo-
gy, while blocking it by default. The software immediately
notifies you and adjusts your Internet connection with your
approval, thus preventing further attacks. 

Size: 5.97 MB
Web site: www.webattack.com/get/sygatefw.shtml
Best Commercial Alternative: Zone Alarm Pro
You save: Rs 1,918

E-MAIL NOTIFICATION TOOL
AvirMail 1.70
You are exposed to many virulent viruses while surfing the Net,
especially while checking your e-mail. With AvirMail, the risk
is reduced because it lets you read,
print or even delete your mail while
it’s still on the server and before it is
downloaded into your computer.
The software also sports multi-user
ability and password-protected
startup. Remember, prevention is
the best cure.

Size: 828 KB
Web site: www.avirmail.com
Best Commercial Alternative: The Bat Email Client
You save: Rs 2,160

MULTIMEDIA PLAYER
MicroDVD 1.2

This software allows you to play ripped DVD movies from CD
or HDD. It also gives you the look-and-feel of a DVD by letting
you rip the navigation menu of the DVD to video and still
images and display it. Special feature DVDs containing extra
movie files of background information can also be included and
played by this player. This software also supports playing of
multi-language movies and subtitles.

Size: 2 MB
Web site: www.tiasoft.de
Best Commercial Alternative: Cyberlink Power DVD xp4.0
You save: Rs 2,398



URL ORGANISER
Bookmark Manager
Are you a frequent surfer? If yes, then this software will be of
great help to you as it maintains all your book-
marks in a hierarchical tree format and also pro-
vides the facility to add comments to it. The
software further extends its capabilities by offer-
ing you FTP support—you can easily transfer your
bookmarks between your home and office computers.

Size: 440 KB
Web site: www.paneuropean.com/bm/index.htm
Best Commercial Alternative: Powermarks
You save: Rs 1,438

WEB BROWSER
Crazy Browser 
Love the speed of IE but wish that it had multiple tabbed win-
dows? Well, this browser gives you the best of both worlds by
using the IE engine to
render Web pages and
display them within
its multi-tabbed inter-
face. It  includes sup-
port for P3P and has
the ability to elimi-
mate the annoying
pop-up ads.

Size: 768 KB
Web site: www.crazybrowser.com
Best Commercial Alternative: Opera 6.01
You save: Rs 1,872
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ZIP TOOL
UltimateZip 2.6
Home users are more con-
cerned about their hard
disk space now than they
were earlier. This is where
UltimateZip comes in
handy—it provides func-
tions such as compressing
multiple Zip files at one go through the batch compressor. It
also features a unique feature called filemask which allows
one to hide files within the archive. For example, if you
want to hide compressed software, simply type .exe in the
filemask option and the rest of the files will automatically
not be displayed. You can also automatically send the com-
pressed files to your e-mail client.

Size: 3.5 MB
Web site: www.ultimatezip.com
Best Commercial Alternative: WinAce 2.11
You save: Rs 1,392

1/2 pg Ver. Ad
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INFORMATION MANAGER
Address Organizer
This software is a great tool for organising and managing contacts
and addresses. It can be used for both SoHo as well as corporate

users. Through the user-friendly interface,
it’s easy to arrange information in any
desired way. The software also features fil-
ters and multilevel sort functions. The built-
in HTML generator wizard lets you create
great looking documents, Web pages,
inventory reports, etc. Apart from browser
and e-mail program integration, Address

Organizer also supports direct entries from TWAIN-compliant
devices and features support for popular image formats.

Size: 4.87 MB
Web site: www.primasoft.com/32org/32ado.htm
Best Commercial Alternative: Book Organizer Deluxe
You save: Rs 3,120

IMAGE VIEWER
ImageWalker 2.01
Managing a collection of images, which can
range from pictures in a photo album to
desktop wallpaper, is a common problem.
ImageWalker is an image viewer-cum-man-
ager that can help bring order to the chaos
by letting you arrange images visually.
Other  notable features which separate it
from its peers are the ability to catalogue
and publish digital images. It also supports
Web page creation, generates thumbnails,
allows batch image conversion, and runs
slide shows.

Size: 2.19 MB
Web site: www.imagewalker.com
Best Commercial Alternative: ACDSee 4
You save: Rs 2,398

CHAT ADD-ON
ICQ Color Picker
This application allows you to easily pick any RGB true colour
for ICQ’s Send Message
Dialog’s text box (ICQ
itself lets you choose from
only one of the 16 basic
colours). It also has some
nifty tools such as preset
font customisation and
editing chat settings. The
application also provides
command line support. 

Size: 496 KB
Web site: http://pcsoftware.hypermart.net
Best Commercial Alternative: GabPager
You save: Rs 478

LAN CHAT TOOL
Interchat 2.1.43
This utility allows one to chat with all the people who
are hooked on the same network connected through
LAN. One can create groups and this form of chatting
is ideal for com-
panies that have
a large employee
base hooked on
LAN  as no infor-
mation is passed
over the Internet.   

Size: 732 KB
Web site: www.conware.org
Best Commercial Alternative: LanTalk XP 
You save: Rs 718

INTERNET DIALER
Quickdialer
If you do not want to use your Windows connection man-
ager, you should try out this program. It has an extremely
simple interface and requires lesser amount of details to be
fed in, which makes it
much easier to work with.
On connecting to the
Internet, it will automati-
cally display the download
and upload rate, thereby
allowing you to know the
exact status of your con-
nection speed.

Size: 48 KB
Web site: http://am-productions.yi.org
Best Commercial Alternative: Advance Dialer
You save: Rs 1,392

GRAPHICS EDITOR
PhotoPlus 5
An ideal software for retouching photographs, adding special effects, and
doing professional image editing
work, PhotoPlus 5 makes working
with multiple layers easy. This
graphics editor has a thoughtful
set of predefined selection tools
and gamma correction capabili-
ties. It features a simple interface
does not scare novices away.

Size: 8.57 MB
Web site: www.serif.com/photoplus5/index.asp
Best Commercial Alternative: Adobe Photoshop 6.01

Rs 39,000
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REMOTE COMPUTING
VNC v3.3.3r9 Remote Control
This software allows
you to remotely con-
trol your PC over an
office network or even
over a dial-up connec-
tion. You can install
the VNC server pack-
ages on your Windows machines, Linux, Solaris,
or now even on OS X on the Mac, and access
the GUI remotely over an Internet connection.
Very simple to set up and amazingly effective
even over an internet connection, VNC also
provides http-based monitoring.

Size: 864 KB
Web site:
www.uk.research.att.com/vnc/index.html
Best Commercial Alternative: PC Anywhere 10.0

NETWORK TOOL SUITE
CyberKit 2.5 Network Utility
CyberKit is a 32-bit network utility. It combines Ping,
TraceRoute, WhoIs, Finger, Quote of the Day, Name 
Server LookUp, Time Synchronizer, NetScanner, DBScan-
ner, Check for New Mail and Keep Alive in one easy-to-use
utility.

Size: 1.5 MB
Web site:
http://www.cyberkit.net
Best Commercial Alterna-
tive: SolarWinds Profes-
sional Edition

FTP CLIENT
SmartFTP 1.0.966
This FTP client features the drag-
and-drop facility and is very user
friendly. The software also supports
multi-connections, transfer queue,
scheduler and recursive downloads.
The other features include firewall
support, resume broken transfers
and URL watcher, and support for
Windows XP themes.  

Size: 2.35 MB
Web site: www.smartftp.com
Best Commercial Alternative: Cute FTP 4.2
You save: Rs 1,918

1/2 pg H Ad
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SECURITY
UltraWipe 1.51
This is a digital electronic shredder that allows you to com-
pletely wipe out unwanted data, leaving absolutely no trace of
it. The software uses the US DoD
5220.22 erasure algorithm. This
utility also provides the user with
features such as freeing of memo-
ry, space and other magnetic traces from the disk surface. It
also clears your Internet cookies and temporary Internet files.

Size: 1.4 MB
Web site: www.redstrike.com/home
Best Commercial Alternative: Advanced Encryption Package 2002 
Professional
You save: Rs 1,918

CACHE AND CCOOKIE MANAGER
X cleaner
Every machine has loads of
unwanted files which the
user forgets to delete, espe-
cially the clutter of tempo-
rary files and cookies that accumulate while surfing. 
X cleaner not only cleans up the clutter but also shreds
the unwanted files. It also clears one’s AIM username—
if you exercise this option before logging out, no other
user will be able to logon to AIM with your ID. You can
also clear the startup program list without having to
edit the registry. 

Size: 278 KB
Web site: http://aboutyourbreakup.com/xcleaner.html 
Best Commercial Alternative: Amnesia Cache & Cookie 
Manager
You save: Rs 958

CHILD SAFE WEB
We-Blocker 2.0.82
With more and more children using
the Internet, parents have become
more apprehensive about access to
dubious Web sites. We-blocker pro-
vides one with the facility of blocking Web sites containing
unsafe material for children. It does this on the basis of its own
database and it provides the parent (or the user) with the facili-
ty to password protect the configuration settings, thereby mak-
ing it impossible for the child to override the customised set-
tings. One can also block Web sites containing foul language,
weaponry, etc. Overall, this software is very easy to use and offers
quite a few configuration options. 

Size: 2.42 MB
Web site: www.we-blocker.com
Best Commercial Alternative: Krowser
You save: Rs 1,250

SCREEN CAPTURING TOOL
Wingrab 1.5
This nifty little utility not only lets you take screenshots but
also lets you edit them as well as manage them in an html
image gallery (it supports
a maximum of 32,700
images). It also lets you
print images in batches.
You can save the images
to four different formats
(.jpg, .tif, .png and
.bmp). A built-in timer
lets you trigger a capture
at predefined intervals.
Using Wingrab, you can read and write text directly to and
from JPG files without decompressing the image, which means
there will be no deterioration in image quality. You can also
store notes regarding the images.

Size: 1 MB
Web site: http://home.chello.no/~wingrab
Best Commercial Alternative: SnagIt 6.0.1
You save: Rs 1,918

FTP SERVER TOOL
CesarFTP 0.99e FTP
server
This FTP server doesn’t require
mastery of difficult settings and
command lines. Ban/authorise
user access rules based on IP a and/or hostname rules. Just a few
clicks let you configure your server to share even specific files.
CesarFTP also supports quotas and ratios, download speed lim-
itation, limitation of the number of connects, and many other
miscellaneous things. With events handling, you can configure
automatic processing of uploaded files.

Size: 768 KB
Web site: www.aclogic.com
Best Commercial Alternative: Surge FTP
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LINK VALIDATION TOOL
Xenu Link Sleuth 1.2b

If you are looking for software which checks
for broken links, then link up with Xenu, a
multi-threaded program that checks Web sites
for broken links. The software does link veri-
fication on ‘normal’ links, images, frames, plug-ins, backgrounds, local
image maps, style sheets, scripts, and java applets. It also displays a con-
tinuously updated list of URLs which you can sort by different criteria.

Size: 432 KB
Web site: http://home.snafu.de/tilman/xenulink.html
Best Commercial Alternative: The Broken Link Doctor
You save: Rs 1,296

Rs 18,480
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The HP ScanJet 5400 is a
2400-dpi, 48-bit scan-

ner. It supports a resolu-
tion up to 2400-dpi, which
makes it extremely useful
when you need to scan
images at high resolutions
in a short time.
It has one
of the lowest
lamp warm-up
times, resulting
in an amazing pre-
view time of 8.37 sec-
onds only. The scanner
picked up all five colour
blocks in the resolution
test. In the image quality
evaluation test, it picked
up the sharp bumps and
wrinkles on the face in the
test photograph and even
scanned the reflection of
the dress on the bracelet,
which very few scanners
have been able to do.

In the IT8 card test, the
scanner picked up the RGB
colour tones very well in
the dark region but degrad-
ed slightly in quality in the
green colour mode in the
light region. This happens
when the CCD of the scan-
ner is unable to read the
green component correct-
ly in the light region. This

scanner is the first of its
kind to have an LCD dis-
play on board for setting
the number of colour
copies to be printed when
clubbed with a printer. The
scan to mail, scan to Web

and scan to print but-
tons, and the copy

buttons are also
present on

the front
face. The
scanner
is slick

but longer
than others. It

comes with both parallel
and USB interfaces. The
package comes complete
with a lot of useful soft-
ware such as the HP Preci-
sionscan Pro 3.0, HP scan-
jet copy utility, HP Share-
to-Web software, Corel
PrintOffice 2000, Trel-
lixWeb Express, HP Print
Creator, ACD systems, and
ACDSee (Mac) ArcSoft Pho-
toPrinter Pro 2000. 

SPECIFICATIONS:
2400x2400 dpi optical resolution,
48-bit colour depth, A4 size scan
area, USB and Parallel interface,
weighs 4 kg

Price: Rs 14,499 
Contact: Hewlett-Packard India Ltd 
Phone: 080-5216121
E-mail: princy_bhatnagar@hp.com 
Web site: www.hp.com

If cutting edge were the only
measure, then the

HP DVD-Writer
would outperform
all existing storage
solutions. The HP
DVD-Writer 100i writes to
DVD+RW discs at an amazing
speed of 3.32 MBps (2.4x) and
fills up a 4.7 GB DVD+RW in
under 20 minutes! 

The DVD was written
using Nero Burning ROM
5.5.5.1, which detected the
writer without any problems.
Quick erasing the DVD+RW
took not more than 2 minutes.
The DVD-Writer also works as
a 12x/10x/32x CD-R/RW drive
and as an 8x DVD-ROM drive.
The only problems  we faced
were of compatibility issues
with various DVD-ROM drives.
Drives such as the Hitachi GD-
7000 did not have problems

reading the DVD+RW but the
ASUS E612 could not

detect the
DVD+RW and
simply failed to
read through. 

The package
comes complete with

one free DVD+RW and HP’s
software suite, which included
MyDVD (for easy creation of
DVD-movie discs) and Record-
Now for writing data. At Rs
40,000, it is expensive but con-
sidering that you get storage
options you’ve never even
dreamt of, this is a truly desir-
able option.

Price: Rs 40,000 
Contact: Hewlett Packard
E-mail: rajiv_rao@hp.com
Phone: 080-5216121 - 25
Fax: 080-5276802
Web site: www.hpindia.com

SPECIFICATIONS:
Write: 4/8/12x as a CD-R; 4x/10x as
a CD-RW; 2.4x (CLV) as a DVD+RW 
Read: 4/8/10/20/32x (CAV) as a CD-
R; 2/4/8/20x (CAV) as a CD-RW; 8x
(CAV) as a DVD+RW

HP DVD-Writer 100i

Performance
Build Quality
Value for Money 1/2

Features
OOVVEERRAALLLL
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HP DVD-Writer 100i
Speedster of a Writer

The ASUS V8200T5
Deluxe fea-

tures a souped up
version of the
GeForce3 GPU, known
as the Ti500. This is the
most advanced graphics chip
from nVidia. The Ti500 core
runs at 240 MHz (40 MHz

faster than the original
GeForce3) and can

crunch 960 billion
operations

per second.
Featurewise it

resembles the orig-
inal GeForce3, apart

from a few additional features

ASUS V8200 Ti500 Deluxe (64 MB
DDR)
One great package

Train your sights on these speedy processors, multifaceted Web
cams, spacious hard drives and much more

Bazaar
HP ScanJet 5400 scanner
(2400 dpi, 48-bit)
Take a preview

HP ScanJet 5400
Performance
Build Quality
Value for Money 1/2

Features
OOVVEERRAALLLL

A-A-
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This is a nifty little kit that
allows you to add one

more monitor to your exist-
ing machine. It can simulate
two separate PCs by creating
single and multi-user modes.
The software even has its
own messenger which allows
you to message another per-
son using the same CPU. The
box came complete with an
additional VGA card, the SiS
6326 PCI card. The kit
included a multimedia key-
board, which had a PS2 port
integrated into it for the
mouse, a 15-feet USB/VGA
cable, and ShareView soft-
ware and drivers. The instal-
lation was easy and the sys-
tem was up and running in a

short time. The price is rela-
tively high though. The VGA
card and multimedia key-
board bundled with it would
not cost more than Rs 2,500,
which means that the soft-
ware comes at a rather high
premium.

Intel’s new 2.2
GHz processor is

the fastest processor
as far as clock speed
goes. The processor
uses the latest 0.13-
micron fabrication
process, which
enables the proces-
sor to run cooler,
consume less power (the
processor now runs at 1.5 V),
and scale higher speeds.
Another remarkable addition
to this processor series is the
huge, performance improving
512 KB of L2 cache.  Not sur-
prisingly, Northwood’s score
stood out among others. It
stood tall in the Quake III
Arena test, scoring a massive
359.2 fps in normal mode.
The P4 loves gaming, as can
be seen by another whopping

score in 3DMARK
2001, beating the pre-
vious best set by the
Athlon XP 1800+ by
almost 400 marks
(7444 as against 7060).
The processor was also
tested with Intel’s DDR
solution (D845BG,

with 256 MB DDR
SDRAM). We found a differ-
ence of about 7-10 per cent in
the overall result. Gaming was
the only place where the DDR
solution lagged behind (by
almost 25 per cent). This
enhanced P4 truly is a proces-
sor that needs applications to
push it. 

Price: $600 (approximately Rs 28,800)
Contact: Nebula Technologies
Phone: 022-6347156
E-mail: sandip@nebulatech.com
Web site: www.intel.com

Price: Rs 36,000 
Contact: Rashi Peripherals
Phone: 022-8260258
E-mail: ho@rptechindia.com 
Web site: www.rptechindia.com 

Intel Northwood 2.2 GHz 
Processor
Standing tall in Quake

Price: Rs 15,000
Contact: J.S. Equipment
Phone: 022-3810713/18
E-mail: jse@vsnl.com 
Web site: www.iogear.com

IOGEAR ShareView
Performance 1/2

Build Quality
Value for Money 1/2

Features
OOVVEERRAALLLL
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SPECIFICATIONS:
4 MB PCI VGA card, multimedia key-
board, supports Windows 95/98SE

IOGEAR ShareView
The two-PC simulator

(driver enabled) such as shad-
ow buffers and 3D textures
without compromising on
frame rate. The onboard 
64 MB of DDR memory is
capable of a total memory
bandwidth of 8 GBps. The
card features the proprietary
ASUS Smart Doctor, which
monitors the health of the
card. The heat generated
while benchmarking is well
dissipated by the heatsink-fan
combo. The card comes bun-
dled with 3D VR glasses, with
the VR circuit embedded in
the graphics card itself. The
packaging included a com-
prehensive manual, games

(Sacrifice, Messiah and Star
Trek New Worlds) and the driv-
er CDs. The card also came
with all the necessary cables
for the integrated VIVO
(video in video out). Any
machine slower than a 
1.5 GHz  will bottleneck this
card.

The Intel P4 2.2 GHz is by 
far the fastest processor in
terms of both, pure speed 
and performance

“ Hatim Kantawalla
Deputy Head, Test Centre

”

IOMEGA Panther (16/10/40) USB 2.0
A middling performer

The IOMEGA Panther is a
16x CD-Writer and comes

with the latest USB 2.0 inter-
face. However, it did not
come bundled with a USB 2.0
compliant card, which is a
major drawback since very
few motherboards support
this relatively new standard.
The drive’s performance was

on par with other 16x exter-
nal drives (SCSI). The writer
took about 288 seconds (4
minute 48 seconds) to burn
an audio CD, which is slight-
ly on the higher side for its
speed and took 488 seconds
(8 minute 8 seconds) to burn
assorted data on a CD-RW at
10x. The writer was  a bit slow

ASUS V8200 Ti500 
Performance
Build Quality
Value for Money 1/2

Features 1/2

OOVVEERRAALLLL

A-A-

SPECIFICATIONS:
Test machine P4 2.2 GHz, 512 MB
RDRAM 
Benchmarks: 7444 in 3Dmark 2001;
154.7 fps in Evolva benchmark (non
bump-mapped); 359.2 fps (normal
mode), 278.4 fps (high-end), 163.3
fps (max settings) in Quake III

SPECIFICATIONS:

0.13-micron fabrication technology,
1.5 V core voltage, 478 Pin

Intel Northwood 2.2 GHz
performance
Build Quality
Value for Money 1/2

Features
OOVVEERRAALLLL

A-A-
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The Logitech ClickS-
mart510 camera offers a

1.3 mega pixel still image res-
olution (software rendered)
and a built-in microphone
that can be used for video
conferencing on the Net. The
camera has a USB interface for
quick transfer of photos to the
PC. The camera is equipped
with an 8 MB SmartMedia
card, which stores over 120
images at a decent resolution
of 640x480. It has two focus
settings, Close up and Dis-
tance mode.  While the qual-
ity was pretty neat for a cam-
era of its type, indoor photo-
graphs were a little dark
despite there being a fair
amount of ambient light. The
camera comes bundled with a
host of software such as the
MGI PhotoSuite SE, MGI
VideoWave SE, Digital Radar
motion detection software,
and Intelligent QuickSync. It
has good ergonomics and the

buttons are smartly placed. If
you are going to use it for fun
and as a Web cam, then its
quality and bundled software
will definitely impress you.
However, a price of Rs 15,000
makes it very expensive for
the resolution it offers. 

Logitech Clicksmart510 
Picture hoarder

Creative PC-CAM
300 comes with

8 MB built-in mem-
ory, which can
store up to 120
photographs at
a resolution of
640x480. The
camera can take
the snaps at a resolution of
1024x768 and has a built-in
flash with a setting for red-eye
reduction. It comes bundled
with a host of software to
build Web sites, edit photo-
graphs, capture images, and so
on. The software, however,
will take some getting  used to.

The installation
process was too
long and we
had to restart
the system
for it to detect
the camera.
The camera

also has a built-
in microphone for capturing
audio while recording a
movie. The movie can be cap-
tured at resolutions ranging
from 160x120 to 640x480 
pixels. The images were very
dark even in a well-lit room
and distant photographs were
a bit washed out and hazy, as

Creative PC-CAM 300
You deserve a better shot

The 107B3 is the new flat
screen monitor from

Philips, featuring LightFrame
II technology. This feature
brightens a select part on the
screen. LightFrame II consists
of an integrated circuit hard
wired in the monitor, which in
conjunction with software dra-
matically increases the bright-
ness of the selected region.
This works beautifully while
watching movies, images or
playing games, as it makes the
display very crisp and clear.
However, if the area is left
bright and you start using
applications that involve a lot
of text, then the ghosting

effect becomes prominent and
puts a lot of strain on the eyes.
The monitor was put through
the Display Mate test wherein
it performed satisfactorily. In
the screen regulation test, the
screen size increased by at least
1 mm, which is tolerable. The
monitor even showed a promi-
nent moiré pattern in the hor-
izontal and diagonal resolu-
tion test. During normal func-
tioning (without Lightframe
II), the monitor didn’t show
any streaking or ghosting
effects. This monitor is capable
of an amazing maximum reso-
lution of 1600x1200 at 75 Hz.
Very few 17-inch monitors can
claim to run at such a high 
resolution at any decent
refresh rate.

Philips 107B3 Flat Monitor with
LightFrame II
Who’s the bright one?

Price: Rs 15,000
Contact: Rashi Peripherals
Phone: 022-8260258
E-mail: ho@rptechindia.com 
Web site: www.rptechindia.com 

Logitech Clicksmart
Performance
Build Quality
Value for Money 1/2

Features
OOVVEERRAALLLL 1/2

B+B+

SPECIFICATIONS:
640x480 pixel resolution, 8 MB Smart-
Media card, USB interface, adjustable
swivel base included, 4 AAA batteries,
640x480 pixel video capture

in extracting
tracks from an
audio CD. The
Panther comes
with an ample
onboard buffer of 
2 MB. The writer man-
aged to reach an average
read speed of 30x in the
Nero CD Speed test. It comes
bundled with a host of soft-
ware such as HotBurn (CD
Writing suite), Iomega
QuickSync  (protects files
from deletion, viruses etc),

MGI PhotoSuite, Adobe
ActiveShare and

Musicmatch Juke-
box. It also

bundles one
blank CD-R
(but no CD-

RW) and a detailed
user manual.

Price: Rs 18,000 
Contact: Neoteric Informatique
Phone: 022-4172600
E-mail: saxena@neoteric-info.com 
Web site: www.neoteric-info.com 

SPECIFICATIONS:
16/10/40x speed, USB 2.0 interface

backward compatible, 2 MB buffer

IOMEGA Panther
Performance
Build Quality 1/2

Value for Money
Features 1/2

OOVVEERRAALLLL 1/2
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Price: Rs 16,000 
Contact: Philips India Ltd
Phone: 022-6912255
E-mail: debasish.mitra@philips.com
Web site: www.philips.com

Philips 107B3
Performance 1/2

Build Quality 1/2

Value for Money 1/2

Features 1/2

OOVVEERRAALLLL 1/2

B+B+

SPECIFICATIONS: 
Maximum resolution of 1600x1200 at
75 Hz resolution, 16 inch viewable
area, 240 MHz video bandwidth, 96
KHz horizontal scan rate
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bundled with many scanners
and cameras for low level
image editing. 

At a price of $49.95 it is a
bit expensive considering the
features it offers. 

EasyOffice Premium is a
complete office suite

with a long list of sub-
suites. To start off, it has
two word processors: Easy-
Word, which is compatible
with Adobe Acrobat PDF
files and comes with fea-
tures such as voice read
back of incorrect spellings,
and SimpleWord word proces-
sor for low-end machines.
Both of these are fully com-
patible with Microsoft Word
documents. The sub-suites
include an integrated image
editor, voice recognition soft-
ware, Easy Spreadsheet
(which is fully compatible
with Microsoft Excel), Easy
Presentation (an integrated
PowerPoint viewer), Easy
Contact Manager for import-
ing contact lists from
Microsoft Outlook, and a lot

m o r e .
The interface
is easy to
learn even
for a newbie.

The package
offers a complete solution for
small offices and places where
there isn’t a high demand for
features. EasyOffice is avail-
able for free download, but
many features such as Easy
VoiceRecognition and Easy
Backup are not enabled in it.

EasyOffice Premium
All too easy

Price: $49.99 (approx Rs 2,400)
Web site: www.e-press.com

SPECIFICATIONS:
33 MB download size, Win
98SE/Me/2000/XP compatible

EasyOffice Premium
Performance
Ease of use
Value for Money 1/2

Features
OOVVEERRAALLLL
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MGI PhotoSuite 4.0 is the
latest image-editing tool

from MGI. The software is a
low-end tool and comes with
very few filters and effects for
editing photographs. The
software can acquire images
directly from a digital camera
and scanner. There are six cat-
egories of special effects
included in PhotoSuite 4.0,
which in turn have a few

effects that can be directly
applied to photographs. The
software has a simple inter-
face and working with it is
easy. This software comes

ISM 2000 installs dif-
ferent Indian fonts

such as Devnagri,
Tamil, Gujarati, etc on
your PC for use with
any applications such
as Microsoft Word,
WordStar, Adobe Page-
Maker, etc. The soft-
ware comes with a hard-
ware dongle, which made the
installation process a little dif-
ficult, but once up and run-
ning, it did not give any fur-
ther problems. The software
comes bundled with a nifty
Hindi ‘type’ sticker for the
keyboard. The package had
two CDs, one an installation
CD and the other containing
clipart images. The manual

has detailed instruc-
tions on how to use
the Devnagri fonts,
complete instructions
on changing 8-bit
ISCII code to ISFOC
(Indian Script Font

Code), and other such
conversions. The software

has a built-in dictionary for
spell checks and has bilingual
support, which can be selected
from the ISM 2000 dialog box.
It supports a wide variety of
fonts and is a good buy for
people in the DTP field.

Price: $49.95 (approx Rs 2,398)
Web site: www.mgisoft.com

MGI PhotoSUITE 4.0
A can-do image editor

ISM 2000 Office 
Multilingual manager

MGI PhotoSUITE 4.0
Performance 1/2

Ease of use
Value for Money
Features
OOVVEERRAALLLL 1/2
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SPECIFICATIONS:
63 MB install size, Win
98SE/Me/2000/XP compatible, works
with Kodak Picture CD

Price: Rs 10,000 + taxes
Contact: Centre for Development of
Advance Computing
Phone: 020-5694090
E-mail: info.gist@cdac.net.in 
Web site: www.cdacindia.com

ISM 2000 Office
Performance 1/2

Ease of use
Value for Money 1/2

Features 1/2

OOVVEERRAALLLL 1/2

SPECIFICATIONS:
Support for almost all Indian lan-
guages, supports Win98SE/Me/2000
and Novell Netware

the lens doesn’t have any
focus settings. You’ll find
many other brands available
in the market that can do a
better job for less.

Price: Rs 10,000
Contact: Compuage Infocom Limited
Phone: 022-8305501
E-mail: info@compuageindia.com
Web site: www.compuageindia.com

SPECIFICATIONS:
640x480 pixels CCD, 8 MB built-in
memory, built-in microphone, works
as a Web cam, USB 1.1 interface

Creative PC Cam 300
Performance 1/2

Build Quality
Value for Money
Features 1/2

OOVVEERRAALLLL 1/2
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ISM is the most formalised
package which allows you 
to create even bilingual 
Web pages

“ G.S. Virdi
Editor, Smart Computing

”
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PowerArchiver’s
archiving utili-

ty reads most file
formats such as
ACE, RAR, Zip,
TAR, etc. It has a
simple skinnable
interface. We test-
ed it using a 1.89 MB folder
containing Excel files. The
folder was compressed to 1.2
MB—a compression efficien-
cy of around 30 per cent. The
best part is that the file can
be saved as a Zip, CB, LHA,
TAR or BH. We saved the file
in the Zip format and got the
above-mentioned results.
PowerArchiver also inherent-
ly uses the anti-virus loaded
on the system to check for
viruses (this has to be defined
by giving the correct path for

the anti-virus during installa-
tion). This archiver also lets
you perform smaller tasks
such as renaming and delet-
ing files from within the
application itself.

PowerARCHIVER v7.02 
More power to the archives

Sleuthhound! Pro is a search
engine plugin for the desk-

top that can search anything
on the local hard drive,
like the Windows
search engine.
You just
need to
type in a
keyword
from any
document present on your
hard drive. Sleuthhound! will
display all documents with
links to the documents and a
preview (first four lines).
Boolean operations like AND,
OR and NOT work with
Sleuthhound!. You have to
remember to create search
zones. This means assigning
relevant folders or partitions
as a particular zone and nam-
ing them accordingly in order

to speed up the process of
finding files. You can even
search the Web by right-click-

ing on the main win-
dow, which launches

the Sleuthhound!
Web page where
subcategories such
as MP3 search and

image search
engines are avail-

able. The program doesn’t
take up much disk space and
isn’t too heavy on the system
either. But it comes at a price
of $79.95.

The Sleuthhound! Pro 3.2 
Top dog

This hard disk is current-
ly the largest avail-

able in India. It has
four platters aggre-
gating 160 GB.
You will
need to buy
an additional Ultra
ATA/133 IDE PCI con-
troller card because most
motherboard BIOSs don’t
detect a drive larger than 130
GB. The drive can only be
detected using the proprietary
application (MaxBlast Plus)
bundled with it. 

With Windows 2000 Pro-
fessional, its performance
matched that of similar speed
drives available at a lower
capacity. It logged a low CPU

utilisation of 2.04 per cent in
SiSoft Sandra Professional. Its

average access time of
8 ms was almost
on par with most

other 5,400-rpm
drives. With a rupee

to MB ratio of 10 paisa
per MB, this drive is a steal. 

Maxtor D540X 160 GB Hard Drive 
The biggest of ‘em all

Price: Rs 18,500 + tax
Contact: Karma Distributors
Phone: 011-6420450
E-mail: naresh@esysmail.com
Web site: www.karmasg.com

SPECIFICATIONS:
160 GB capacity, Ultra ATA/133 inter-
face, 2 MB cache, 5400-rpm rotation-
al speed, four platters
Benchmarks: 5500 in High-end Disk
Winmark 99; 34 MBps sequential
read; 6 MBps random read; 29332
Kbps sequential read speed and
2543.8 Kbps sequential write speed
in HDTach; 0.95 per cent CPU Utilisa-
tion (Iometer); 124.91 total I/O per
second

Maxtor D540X 160 GB
Performance
Build Quality
Value for Money 1/2

Features
OOVVEERRAALLLL 1/2
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Price: $19.95 (one license) (aprox Rs 958)
Web site: www.powerarchiver.com 

SPECIFICATIONS:
Supports most compression formats,
has a skinnable toolbar, has complete
integration with Windows

PowerARCHIVER
Performance
Ease of use 1/2

Value for Money
Features
OOVVEERRAALLLL
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Price: $79.95 (approx Rs 3,838)
Web site: www.isleuthhound.com

SPECIFICATIONS:
5.6 MB install size; Boolean search
supported; schedule feature built-in
for zone update

The Sleuthhound! Pro
Performance 1/2

Ease of use
Value for Money
Features
OOVVEERRAALLLL 1/2

B+B+

This software controls 
different elements of

a Web cam such as
adjusting the brightness,
contrast, hue, etc. The
software is plain and
simple. You can select
from 10 different com-
pression modes includ-
ing formats such as DivX
Codec 4.12, Cinepak Codec
by Radius and so on. 

You can select from the
different resolutions offered,
ranging from 160x120 to
640x480. The software even
has a motion detection facil-
ity built-in, which lets you
use your camera as a security
camera when you’re away. It
lets you select the sensitivity
of motion when it starts
recording and even select the

area within the frame. The
software lets you take 
pictures from its own inter-
face without having to click
the shutter button on the
camera.

WebCam-Control-Center 5.5
A Web cam controller

Price: $29.95 (approx Rs 1,438)
Web site:
www.webcam-control-center.com 

Webcam-Control-Center
Performance
Ease of use
Value for Money
Features
OOVVEERRAALLLL
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SPECIFICATIONS:
3.15 MB install size, Win
98SE/Me/2000, supports resolutions
up to 640x480 pixels
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Asecret agent needs to be on his toes
always and what better way to keep
the mind and reflexes razor sharp

than a spot of gaming and matching wits
and skills against worthy adversaries?

And I have the best of all the neces-
sary paraphernalia that an ace gamer
should have—a GeForce3 graphics card,
all the RAM I could ask for and a machine
tweaked to perfection. But something’s
missing. For a truly immersive gaming
experience what I need is something that
will let me feel the bump and grind of the
game. Hence I asked to be put on ‘Mis-
sion: Gaming Peripherals’.    

Early on in the mission I realised that
there isn’t a one-size-fits-all, versatile
peripheral in the market. If it’s versatility
you are looking for, nothing really beats
the old keyboard and mouse combina-
tion. Most PC games are not originally
designed with gaming controllers in
mind; they work better with the mice and
keyboard arrangement. This is especially
true with first person shooter (FPS) and
strategy games, although you do get tai-
lor-made mice like the Razer Boomslang
and the Strategic Commander, one NRI
uncle away. 

An excursion to the Mecca of hard-
ware, Lamington Road, and this is what I
found: the gaming hardware was of two
broad categories—cheap and functional,
and feature laden and expensive. If
money is no issue for you, there are
peripherals that cost more than the
PlayStation. Logitech and Microsoft
have gamepads, steering wheels, and
joysticks that are rugged, easy to use,
feature rich, with reprogrammable
buttons and force feedback. The
Microsoft SideWinder Precision Pro
Joystick had a price tag of 
Rs 5,000. The Logitech Wing-
man Extreme Digital 3D
(nothing ‘extreme’,
‘digital’, or ‘3D’ about
it) had an asking
price of Rs 2,600.
These are the
most expen-
sive non force
feedback joy-
sticks I came
across. The force feedback upgrade came
at an average of Rs 3,000 more. Games are
a lot more gripping with force
feedback—you can feel the

bumps on the road while driving on a
force feedback wheel, or the rumble of
your aircraft when it gets hit. Great for
enhancement freaks, but of course all this
comes at a price 

There’s a glut of lesser-known imports
at Heera Panna, an imported goods shop
in Mumbai, and you get pretty much
what you paid for. The price range for joy-

sticks started from Rs 500. The
expensive ones had more

buttons and thicker plas-
tic. Frontech had a good

selection of joysticks in the
price range of Rs 550 to Rs 1,300.

The cheaper makes of joysticks
from A4-Tech, Frontech and Dexxa

will get the job done but the work-
manship and precision on the joy-
sticks and steering wheels is not as
durable as those from Logitech and
Microsoft. 

If I were to buy something
cheap, I’d go for a gamepad as

they can stand a lot of abuse
and can work for a wide vari-
ety of games. The E-Z

gamepad from A-4 Tech was just
for Rs 350, a must buy if you’re tired of
playing console games on the keyboard. 

There are a lot of other extras you
could go for, like Virtual Reality (VR)
glasses. These aren’t available as a sepa-
rate add on, only select ASUS cards have
this feature. The 3D VR glasses can make
all your Direct 3D games jump out from
the screen and the newest beta drivers
will also work with OpenGL. It takes
some getting used to at first but the
effects can be really amazing. It would be
wise to invest in a headphone and micro-
phone set, now that voice in multiplay-
er games are becoming a widely accepted
standard.

You can never have too much of a
good thing can you? Now that my report
is ready, my next mission is to convince
the Big Boss to finance my new arsenal of
gaming peripherals.

Game

Flight Simulator,
Space Sim

Sports, Arcade,
Fighting, Console
Ports
Racing

FPS, Strategy

Best suited
peripheral
Joystick

Gamepad

Force feedback
wheel

Keyboard and
mouse

Price Range

Rs 500-8,000

Rs 350-4,500

Rs 2500-10,000

D-uh, you already
have it 

Caveat

An unexciting range of games
and lack of versatility means
that only flight sim enthusiasts
will opt for this
The high-end gamepads
aren’t all that they're cracked
up to be 
A steering wheel without force
feedback is an utter waste of
your time 
Buy a wireless mouse and key-
board combo, or an optical
mouse

What to Buy

Hard Disks
If you’ve been looking to
upgrade to a higher-capacity

hard drive, now’s the time to pull
out your wallet and spend some

money.
Hard drives are crashing to prices as

low as Rs 4,650 for a 40 GB capacity
and prices are expected to fall further. GripGE

T A

ILLUSTRATION: Mahesh Benkar
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Finally a device that can record
your movies and music on CDs

and play them back—
absolutely hassle-free 

PHOTOGRAPH: Jiten Gandhi

VIDEO
O N DEMAND

It looks like something that resulted
from a cross between a VCR and an
iMac. Available in three colours—
raven grey, ice blue (featured above)

and lava red—the terapin from Terapin
Technologies (www.terapintech.com) is a
neat device that combines amazing
functionality with great looks. The Ter-
apin works like a digital VCR and records
both audio and video on CD-R/RW. The
Terapin, in one stroke, brings together
the functions of a VCR with a better
quality and higher degree of reliability.

It uses the now phenomenally popular
and inexpensive CD-R/RW media for
recording.

The joy of recording
Learning how to use the Terapin to record
and playback songs and movies is easy. It
behaves just like any ordinary VCR in
your house. You can stop it, start it again,
play any track you want, and even rewind
and forward at variable speeds. You can
also switch to specific tracks—there 
was no way you could do this with a

magne-tic tape. And once you’ve finished
recording, press ‘Finalize’ to complete the
process. This allows you to play back the
CD on computers and VCD players. 

The Terapin is also multi-system com-
patible with support for both NTSC and
PAL video formats. For audio applica-
tions, Terapin features automatic record-
synchronisation from an external digital
audio source via its coaxial or optical
inputs. It comes tightly packed and well
equipped with a remote control and a
manual listing of all the functions. 

■ terapin recorder
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The best part about
the Terapin is that it is
the first home recording
device that lets you
record audio and video
directly to a versatile dig-
ital media such as  the
CD. While PC users with
the right kind of hard-
ware (video capture
cards) have been able to
record video on CDs, the
Terapin delivers this
functionality to everyone in a single
device. It does not need any third-party
software; users don't need a PC to record
or play music and movies. Everything
good comes at a cost, of
course. Terapin comes
at Rs 29,000. 

Like the VCRs
that most of us are
familiar with, Terapin
works well with a variety
of analog sources such as
Cable TVs, VCRs, as well as dig-
ital sources such as Camcorders, Hi-
Fi music systems, and so on. It is
media-friendly and it allows you to use
the re-writeable CD-RW media too. 

Taking versatility further, the CDs
that Terapin records, run without a fuss
on any CD/VCD player or computer, irre-
spective of whether you have used CD-R
or CD-RW media. While testing, we faced
no compatibility issues with the Terapin,
which speaks volumes in this standards-
plagued age. 

The Terapin, like any other VCR, also
comes with a fully functional remote 
control. The only difference is that the

Terapin remote control has probably
every single function that the main panel
has, right at your fingertips. 

Aiming for perfection
While it might be asking for too much,
there are still a couple of things that we

would love to see incorporated into
the Terapin. First of all, adding

the option of MP3 Playback
would make Terapin a

complete modern
home entertainment
system. Including
preset recording

modes will ensure
auto-finalisation of a

CD-R as soon as the CD
nears completion. Perhaps the most
important factor would be enabling on-
the-fly MPEG-4 compression. Enabling
this using hardware could be relatively
easy and would allow recording of nearly
2 hours of  video content on a 700-MB
CD-R instead of the current 60-minute
limit, without any reduction in quality. 

Lastly, another wonderful addition to
the Terapin would be the inclusion of a
TV Tuner module. This would allow the
routing of cable TV signals directly
through the Terapin. The ability to then
tune or program channels directly from
within the Terapin would make it the ulti-
mate VCR replacement. 

Apart from that, the Terapin is the
most perfect recording and playback
device in the market. No reason why you
shouldn’t go Terapinning, if you don’t
mind the cost, that is.

HATIM KANTAWALLA

■ Convert VHS to VCD
If you have some pre-
cious home videos or
movies on video tape,
you might want to
ensure a longer life for

them by transferring them to the more
reliable CD medium.
■ Record live TV broadcasts
This is where the Terapin
really emulates the VCR.
You can record your
favourite TV pro-
grammes, or maybe the
World Cup Finals onto a CD and enjoy
it over and over again.
■ Digitise and edit home videos

You can now transfer
videos from your cam-
corder or another video
source and convert it
into the ready-to-edit

digital format. Use a video editing tool
to edit and manipulate them. 
■ Create audio CDs
Compile your own Top of
the Pops collection CDs
by recording directly from
any audio source, and
even from TV or VCD.
■ Audio and video playback
Use it as a player for your home enter-

tainment system.
Whether it’s movies on
VCD or the latest Metalli-
ca album, the 
Terapin plays it all.

What you can do with 
Terapin

Want to own a Terapin?
You can buy the Terapin in India
through Monarch Video Vision by send-
ing an e-mail at viren@bom2.vsnl.net.in
or calling 022-2619022.

The Terapin’s rear panel resembles that of a traditional VCR
and in addition it also includes digital in/out ports 
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Connecting a Web cam to your
PC used to be a complicated
task, what with the dedicated
cards or parallel ports. Today,

however, most cameras are USB compat-
ible (USB is a faster data communications
port best suited for video) and come bun-
dled with manuals, supporting software

and driv-
ers. Now, con-

necting your camera
to your machine is as simple

as plug-and-play. Your Web camera
to PC connector cable will usually have a
flat rectangular pin that you can connect
to your computer’s USB port. The other
end of the chord is generally attached to

the camera and cannot be removed. In
case of combo cameras, which are used as
still cameras, video cameras and Web
enabling devices, the chord is detachable. 

Once you have successfully installed
the camera, all you need to do is install the
appropriate drivers and software. When
you boot your computer after installing

the hardware, the operating system
will detect the new hardware

that’s connected. The OS
will then take you

through the
process of setting
up the drivers for

the camera. If your
camera is not detected,

install the software appli-
cation that accompanies your

camera. This should help you
install the drivers automatically. If the

device you bought did not have any
accompanying driver CDs, log on to
www.drivershq.com and try locating the spe-
cific driver for your camera or a generic
driver.

After the hardware and software are in
place, check the equipment. Launch the
software that accompanies your camera
and see if you are able to view the image
that is being captured by the camera.
Adjust the settings to your requirements—
they are more or less the same across all
cameras. Frame rates and other cosmetic

A three-in-one workshop on setting up your Web cam to
broadcast images, work as a security device, and take still
photographs

SPY!
eYe

Things you need
1. A computer with more than 400
MHz clock speed and minimum
128 MB RAM.
2. A Web camera of your choice.
3. Preferably an ISDN line (64 Kbps)
since video broadcasting requires
more bandwidth than normal text
data transfer. 

PHOTOGRAPH: Mexy Xavier
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adjustments can be tweaked using the soft-
ware. Usually there are no controls on the
camera except perhaps the latest combo
models, which have a few buttons for
recording video and clicking photographs. 

Look world! Here I am
You might want to use the Web cam to
let the Net world get a look at you, to
monitor your house, check on the baby
sitter while at work, and so on. In fact, if
there is something that you would like to
monitor remotely, then broadcasting via
a Web camera is the best option. You can
use certain software to capture the image
from your camera at regular intervals and
then upload it to your Web server. The
principle is simple. Someone
views a Web page on
your site. The page
has an image,

which is also located on the
Web site. When you constant-
ly update the image on the site
and at the same time refresh
the Web page the user is view-
ing, the viewer feels as if he is
seeing a moving video in slow
motion. A high-speed Net con-
nection can aid you in stream-
ing the video live instead of
capturing images and drop-
ping them on the Web site. 
FTP upload: Webcam32 (trial
version available for download
at www.webcam32.com) is a
good broadcasting software that allows
you to do FTP image uploads and even
live audio-video streaming. Download
the software from the site and install it.
When you launch the application, it asks
you to enter some details about the FTP
server, username and password. If you
have Web space (you need to have one for
this exercise), either rented or otherwise,
you can use it to upload your images. In
this example we used a free FTP Web
space provided by Yahoo-Geocities
(ftp.geocities.com). 

Before the application can actually get
into action, you need to perform certain
tweaks with the Webcam32 software.
Enter your appropriate FTP server, user-
name and password when prompted. 

You can link the Web cam to a Web
page on your site for others to see. For
instance, your Web site might have a page
with an image link such as <IMG
SRC=http://www.geocities.com/vidyara-
manan/digit/thinkdigit.jpg> via which
your acquaintances can see your image
captures through the Web camera. The
command instructs the browser to fetch
the image from www.geocities.com/vid-

yaramanan/digit. As the file thinkdig-
it.jpg on the Web site gets updated

based on the upload intervals
setting, the viewer will see

newer images

every time the page refreshes. Since con-
tinuity is maintained, it will appear as if
there is a live stream of video. The draw-
back of FTP uploading of images is the
lower frame rate. You really can’t have
faster refreshing and uploads as it would
flicker and provide very bad output to the
viewer. The solution? Streaming!
Faster video via streaming: Webcam32
has the ability to camouflage itself as a
Web server. Unlike the FTP uploads where
a static image is stored and uploaded, in
this method, an image is captured by the
camera and directly delivered to the brows-
er without waiting for a refresh time. The
browser is instructed by the Webcam32
software to accept the images till it sends
an end signal. Since this is a continuous
process, the frame rates are better. 

How exactly does this happen? Let’s
take an example of a link that would be
available on a typical Web cam page, say,
<IMG SRC=”http://www.thinkdigit.com:
port/video/push>. Here www.thinkdig-
it.com is the computer on which the
Webcam32 software is running and port
would be any number via which the soft-
ware listens for requests. So when a view-
er is trying to view the camera from this
page, his browser is linked directly to the

machine on which your
Webcam32 soft-

ware is running.
N e t w o r kSome popular

online Web cams
http://cn003461. phid-

ji.com/ wow/index.asp
Launched in 1999, this site

gives you single-click access to
Web cams hosted across continents.

http://www.earthcam.com
Outdoor cams are categorised and listed
alphabetically here.
http://dsc.discovery.com/cams/cams.html
This is Discovery channel’s Web cam, which
takes you into the wilder side of the world
in the safety of your computer monitor.

If you are a proud Web site owner, you
might want to post images on your
site. There is software available that
helps you grab frames which can be
used to take still shots with the aid of
your Web cam. Webcam32 can also be
used to grab still images. Set the focus
of the camera on the object you want
to take a low-resolution image of. Click
on the ‘Camera’ icon in the main win-
dow of the software—this will throw
open the Preferences window and
point to the ‘Capture’ option. Click on
‘Still Grab’ if it’s not selected. Your
object is shown on the left-hand side of
the window. Adjust the camera settings
if necessary. Click on the ‘Grab’ button
to take a photograph of the image and
save the image on your hard disk in
JPEG, BMP or PNG format. Now when-
ever you want a low-res image on your
site, you know what to do.

Posting Photographs

FTP upload of images using Webcam32 

✔✔ Resolution: A camera’s quality is
weighed against the resolution it supports.
So choose a camera with a good resolution.
Most Web cams offer a resolution of
320x240, which is good enough for normal
applications.
✔✔ Connectivity: USB connectivity, since it
makes connecting a Web cam as easy as
plug-and-play. Your PC needs to have a USB
port too, of course. 

✔✔ FPS supported: Watch out
for the frame rates that the camera
will support (at least 25 fps at 320x240).
This is important or else the video quality
would suffer. Dial-up users will have to bear
lower frame rates.
✔✔ Software and drivers: Buy a camera that
comes with software drivers and spare your-
self a long-drawn Web hunt. Also check for
bundled applications.

When buying a Web cam, check for…
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bandwidth is consumed and a con-
nection established with the Web-
cam32 software for each client
connected to your camera. The
transmission of the image should
however be stopped at some point
of time to avoid network hogging.
Webcam32 has a configurable
option using which you can termi-
nate the connection with a browser
after a particular time frame or after
delivering defined kilobits of data,
whichever comes first. 

You need to spend some time
configuring the TCP/IP settings in
the Webcam32 software. To do this,
go to File > Preferences and choose the
TCP/IP option on the left. In the features
subsection, make sure
all options are
enabled

except RCM Control. Thereafter, choose
the Access tab, enter the Remote Access
Port, and in the server push tab, enter
appropriate push interval and size. You
are done. 

What about dial-up users? 
All that we have stated before
works perfectly for some-

one using a fixed IP
c o m p u t e r

with a permanent connection to the
Internet. 

When you connect to your ISP
through a dial-up connection, your com-
puter is assigned an IP and the IP changes
each time you connect. Now a Web cam
viewer connects to your streaming video
service through the IP entry available on
your Web page. Since the IP changes
every time you reconnect on a dial-up,
does it mean you have to change the IP
entry on your page every time manually?
Not in the least. Webcam32 has a solu-
tion. Make a standard page with an entry
such as <IMG SRC=http://%%IP%%:
8888/video/frame> locally on your hard

disk. From the File menu choose Pref-
erences. There choose FTP > IP UpLoad.
On the right hand side enter the path
of the file with the above-mentioned
entry. Check the appropriate boxes
below, which state whether to upload
pages while Webcam32 starts up or to
upload it when the software detects an
IP change. 

Once you are done with the set-
tings, connect to the Internet by
dialling your ISP number. Once the PC
connects to the Internet, it’s assigned a
new IP. Webcam32 reads this new IP
address and replaces the ‘%%IP%%’
entry in the above HTML image tag
and uploads the page to your site. 
There are several other uses you can

put a Web cam to. As you become more
comfortable with the operation and han-
dling of this device, you will find more to
do with it.

VIDYARAMANAN S.

Looking for a security device? Use your
Web cam to build your own security and
motion detection system. A webcam cou-
pled with a software capable of detecting
the movements and raising an alarm
based on movement can prove a worthy
security system. Download motion detec-
tion software like Gotcha and Inetcam
from www.gotchanow.com or www.inet-
cam.com. 

After you have installed Gotcha and
launched the software, select Properties
from the Options menu. Click on the

Detection tab in the window that pops
up. By default, Gotcha is set to capture
one frame for every 5 minutes. You can
choose to set the time frame according to
your needs. Once you have set all the
other options, click on the Observe button
on the tool bar (the small button with an
eye on it). Gotcha starts monitoring your
area of interest through the eyes of your
camera. You can choose to e-mail the
images to your mailbox and also raise an
alarm in case an actual intrusion is detect-
ed. The sensitivity of detection can be set
in the Detection Properties option. 

Your own Private Eye

Creative Webcam CLA USB
Price: Rs 2,600
Contact: Compuage Infocom 
E-mail: info@compuageindia.com

D-Link - DSB c300
Price: Rs 3,500
Contact: D-Link India 
E-mail: ssehgal@dlink-india.com

Logitech Clicksmart
Price: Rs 8,000
Contact: Rashi Peripherals 
E-mail: ho@rptechindia.com

The other options 
A cheaper alternative always exists. People
who just want to have a feel of the Web cam
without spending too much can try various
Taiwanese and Chinese models that can be
found in computer hardware shops.
Typhoon (Easy Web cam): Rs 1,650
Rookie: Rs 1,800
Dialbox Arisoo: Rs 3,000

W
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Live streaming using Webcam32
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DVDs, though excellent for play-
back and storage, are not exact-
ly infallible by nature. They
meet with accidents, get

scratched, and the chances of you dam-
aging your favourite DVD
are as high as all those CDs
that you’ve already dam-
aged. A back up is a back up,
always important, so would-
n’t it be better if you had a
safe place to store that
gigantic movie collection
you’ve been busy hoarding?

Well, you do have a
place, a format, that’s not as
large and is of high quali-
ty—the DivX format. This
will give you a backup file
that is of very good quality,
is not too big and more importantly, eas-
ily stored and played.

Necessary ingredients
Encoding a DVD to DivX involves major
processing power and loads of free hard
disk space. You can forget about any con-
versions unless you have a processor of 
1 GHz or more and a big hard disk (any-
thing above 40 GB). At least 256 MB of
RAM would be nice, although you can get
by with 128 MB, but no compromises on
the processing power and hard disk space.
Encoding takes up almost 100 per cent of
a processor’s capability. 

Our test bench was a Pentium-III run-
ning at 1.12 GHz with 256 MB RAM and a
20 GB hard disk. On this bench, it took
around 2 hours and 26 minutes to convert
a 112-minute DVD into DivX (DivX 4 con-
stant bit rate) using the default resolution
and settings. The same movie took around
5 hours and 22 minutes to convert on
DivX 4 2-pass. EasyDivX was the only
application running on the PC during the
conversion process! We didn’t try the 

DivX 3.11 VKI encoding option due to
legal issues.

Now for the things you need to install
on the PC other than the conversion soft-
ware. First of all, you need to have a good

software DVD player like Pow-
erDVD. You will need to have
the DivX Codecs (DivX 4.12
and DivX 3.11 VKI) installed as
well. Windows Media Player is
yet another essential tool for
playing back the output file.

DivX-ing those DVDs
The software we will be using
for converting DVD to DivX is
EasyDivX. You can get hold of
EasyDivX v0.792 (a 1.93 MB
download) from http://easydi-
vx.does.it. A link for down-

loading DivX 4.12 is also present on the
same page. It is perfectly legal to use Easy-
DivX if you are only making a single back-
up of your own DVD. (Have a look at the
box, ‘DVD conversion essentials’ to get the
DVD to DivX conversion basics right) 

Get, set, DivX
Time to start the encoding process. Play the
DVD using PowerDVD. In order to start
EasyDivX, click on the Advanced tab and
then again on the General Settings tab.
Here, click on AVI Settings.

Check the ‘Delete temporary files’ and
‘Delete VOBs’ options to delete the 

Convert your DVDs to DivX format and preserve your favourite movies in top-notch condition forever

DivX is a Codec that helps you com-
press those big media files into a very
small size. For example, while convert-
ing your DVD into DivX, you will be
able to convert the MPEG-2 video and
audio files to about one-eighth their
size or less (an approximate measure).
If you have a DVD that runs to about
7.5 GB, you will be able to convert it to
DivX to fit onto a CD of 650 or 700
MB. Of course, the quality won’t be as
good as that of DVD, but the picture is
still pretty good—much better than the
other formats around. You will be able
to get quality ranging from the kind
used for streaming over the Net to
near-DVD quality. The most common
form of the DivX file is .avi. 

Technically speaking, DivX is a digi-
tal video compression format (called a
Codec), which is based on the MPEG-4
standard from DivX networks. There are
two versions of DivX around. One is the
original version of DivX, which has ver-
sions in the form DivX 3.xx. For exam-
ple, DivX 3.11 is the original format.
This format is basically a hacked version
of Microsoft’s MPEG-4 v3 Codec, since
MPEG-4 v3 did not allow encoding into
the .avi format. 

The other and newer DivX version is
DivX 4.xx. Project Mayo, an open
source initiative, developed this format
from scratch. The latest member in the
4.xx family is DivX 4.12. We have used
this Codec in our workshop. Please
note that versions 3.xx and 4.xx are not
compatible with each other.  

You can download the DivX Player
and the DivX Codec 4.12 from
www.divx.com or directly from
www.download.com.

What is DivX?

DivX-encoded
movies

are half the
size of
MPEG-1
and give 
twice as
good quality

Save space; get rid of temporary files and VOBs
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temporary files from your hard disk after
the conversion is done. Now select the
‘Maximum CD size’ you would like. The
default value is 635 MB. Leave it at this
value if you are using a 650-MB CD. Else
change it to the required value.

EasyDivX does the conversion in a
series of steps. Let’s take a look at them,
one step at a time.

The default option is ‘Auto Select
Movie’. Leave this option on until you’re
familiar with the fine art of ripping. This
option selects all the VOB files you need
to rip onto the hard disk. You can close
PowerDVD once you see the .vob files
under ‘Available Files’. 

Select the VOB files you want to con-
vert if you’re using the ‘Manually Select
VOBs’ option. If you are not sure about
which VOB files to convert, select all of
them. Use the ‘Select Files From Hard
Disk’ option if you have VOB files already
on your hard disk.

Click on ‘Next Step’ once you are
through with the selection. 

Enter the length of the movie in
minutes in the text box. You can get the
movie length from the DVD pouch. Select

the type of sound format you want from
Stereo and AC3. Select the AC3 option
only if you have a multichannel sound-
card or if you are burning two CDs. Click
on ‘Next Step’. 

Here, select the number of CDs you
want the DivX file to come in. If you want
to compress the file in a single CD, leave
the ‘Single CD’ option on. This will be 
of lower quality because of the smaller 
file size.

If you want to play the output of your
DivX movie on a TV, change the ‘Frame
rate’ or ‘Video system’ option to PAL. This
is the video system we use in India. If you
will be playing it only on your PC, leave
the default option (NTSC 29,976) on. 

Specify the Aspect ratio as 4:3 if
you want the output display to be the
same as that of your DVD. Set the Codec
option to DivX 4 2-pass for the best qual-
ity. Keep in mind that this will take
longer than the other two Codec
options. (On our test bench it took near-
ly 2 hours 30 minutes to encode using
the DivX 4 Codec at constant bitrate
option.)

Set the Primary language as 
English.

Select the ‘Create subtitle files’ if
you want to see subtitles in your movie. 

Select the directory where you
want to save the output DivX movie.
Click on the ‘Go for it’ button and the
process starts. The whole process will take
more than 2 hours at the least. Our
machine took about 5 hours and 24 min-
utes to convert a 112-minute DVD. The
time taken will depend on the quality you
are encoding at (the default is 342x240
pixels at 523 Kb bitrate) and the machine
you are using. If you are converting a
DVD of around 8 GB, it is always better
that you have spare space of at least 10
GB on the particular partition that you
are storing the conversion output in.

Now go to the folder you specified for
the output, click on the file, and Win-
dows Media Player will play the file for
you. Voila! Your own DivX backup is
ready for your viewing pleasure. Store it in
your hard disk or burn it onto a CD for
safe storage.

ANIL PATRICK R.

The term ripping is used while converting
DVDs to other formats. It is important to
understand that ripping is just one part of
the conversion process. The other impor-
tant steps involved are encoding of
audio/video and multiplexing. 

DVDs consist of VOB and IFO/BUP files.
VOB video files consist of video and audio
streams combined (multiplexed) together.
IFO files have information about how the
DVD has to be played. BUP files are backup
files for the IFO files in case they get cor-
rupted. It is important that you include
IFO/BUP files during ripping, otherwise the
ripped files will play incorrectly. 

Now comes the (g)ripping part! DVD
files are encrypted using a method called
CSS (Content Scrambling System) encryp-
tion. CSS allows you to copy DVD files
onto your hard disk, but you won’t be able
to play them. Ripping lets you get around
this encryption and copy the files onto
your hard disk. The copied files will be in a
format that can be played by software
DVD players. The video files are then
encoded by EasyDivX. The next step is to
decode and encode the audio files into
stereo/AC3 format as you have specified.
The last step is to multiplex the video and
audio files. 

DVD Conversion Essentials

Specify how many CDs the file should take

Your DivX copy can even have the subtitles

Tailor file size to your requirements

Do not convert unless the DVD
belongs to you and make only one
back up for personal use. You break
copyright laws if you lend, rent out or
sell your backup to someone else. 

You CANNOT use DVDs that are
not of your region. India’s region code
is 05. If your DVD’s case has a code
other than India’s, do not use or con-
vert it. If your DVD does not have a
region code on it, it can be played in
any country.

Watch out for...
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Downloads
 for

Designer
From design tips to fonts and stock photography, here is a collection of sites that deliver just that… 

and everything else in-between 

Are you an aspiring page or
graphics designer but lack the
money to set up your own util-
ity-rich studio? If so, you have

company. There are many out there who
hold the same dreams (small-time maga-
zines included) for whom plunking down
a few lakhs for the equipment and its
upkeep is a major hurdle. Besides, finding
skilled and talented personnel to get the
job done right is another painstaking
task. The Internet however can be a teem-
ing resource for all those design elements
you are seeking. Thousands across the
world, all experts in their field of design,
regularly contribute to the Web products
replete with their diverse talents. Samples
of art, photography and fonts are easily
available both for commercial use or sim-
ply to add to your own collection. Some
material can be obtained freely, while
others need to be bought and sometimes
licensed. We marched through a maze of
design sites and have returned to offer
you some guidelines that will help you
utilise the Internet as a virtual design
super-store.

Typography rules
Sometimes, words can illustrate a point
with greater emphasis than a picture.
Whether it’s a title, quote or just plain
body text, you need the right typeset, one
that perfectly matches up to the tone of
the story. Of the many facets of design, it
is perhaps easiest to get hold of free fonts.
Your search for pretty character faces
begins with www.fontfreak.com, a site
abounding with thousands of free PC and
Mac fonts, dingbats and font control soft-
ware. It’s updated several times a week,

with freeware as well as shareware fonts,
ensuring that you receive a fresh batch of
originally crafted typefaces.

Fontsite.com has a polished
look and substance apt for the type
and graphics professional. Not only
do they offer high-quality typefaces in
TrueType and PostScript formats, but
FontSite also features a series of informa-
tive articles ranging from choosing the
right typeface to managing the life of a
production artist. 

For fonts that go against the grain,
check out www.acidfonts.com. You won’t
find any of the standard fare of Arial and
Verdana. Each fortnight, Acidfonts keeps
you posted on what’s cool as far as fonts
are concerned. They even have a section
dedicated to the sci-fi genre. Going a step
further, www.abstractfonts.com offers its
own share of unconventional characters
neatly arranged in categories such as 3D,
Cartoon, Celtic and more. Unlike other
font sites, Abstract Fonts has an interac-

tive forum where users can help each
other in searching for a particular typeset

or helping identify the names of some
of the more unfamiliar ones.

If you are scouting the Web for
typefaces that have a conservative

and professional touch, your best bet
would be the International Typeface Cor-
poration, or www.itcfonts.com. In addition
to their collection of 1,000 odd fonts, ITC
keeps a staff of designers for custom font
designing if that is what you’re looking
for. However, note that ITC Fonts doesn’t
offer much in terms of free stuff. Most of
their products are sold through a wide
variety of licensing options.

Those nifty essentials—plugins
and filters
To a designer, applications such as
QuarkXPress, Adobe PageMaker and Pho-
toshop are the enabling tools for their
skills and creativity. But at some point,
the standard fare of functions and fea-

tures tends to taper down the cre-
ative ability of a designer. Thank-
fully, there are hundreds of free
(and otherwise) plugins and filters,
which can add new facets to a pro-
gram’s functionality. From image
filters to conversion utilities, these
nifty add-ons often deliver real
value to the application and its
purpose.

Adobe Photoshop plugins are
some of the most easily accessible
of all design applications. Head
towards www.actionxchange.com.
This is a unique community site
where you can download and
share several easy-to-installA treasure trove of royalty-free fonts exists online
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actions, extensions, modules, and more
for Adobe Photoshop software.

www.extensis.com is another resource
for professionals serious about design. The
tools available here are not free—in fact,

they cost quite a bit. But one look at
these utilities and you might think
you are looking at some commer-
cial stand-alone software. Extensis’

product line is comprised of plugins
for a wide range of page layout and

graphics design software such as QuarkX-
Press and Adobe PageMaker.

Visual appeal
Unlike the Web, just any picture or pho-
tograph will not do for offline publishing.
As the printing process is extremely sen-
sitive to the resolution of an image, a
visual with at least 300 dpi (dots per inch)
would be ideal to maintain the quality of
the image. There are plenty of sites on the
Net that offer attractive, high quality pho-
tographs and illustrations. Although ear-
lier many of these image stockpiles were
freely available, the downturn of the
Internet economy forced a change on
their business model, making the seeker
bear the burden.

Among the lesser-known image por-
tals is www.eyewire.com which features
stock photography, illustrations, clip art,
videos and more. Though their offerings
are on the pricier side, the quality justifies
purchase.

If you’re on the hunt for product
shots of consumer electronics, look up
the manufacturer’s home page and 
navigate your way to the Press section of
the site. If that’s not available, the option

would be to contact the public relations
or marketing departments and ask them
for an assortment of images which they
are usually happy to provide.

Searching for images
If you’re tired of expensive licensing fees
for images, there are two other avenues
that might have answers for you. The
most popular search engines on the Web,
Google and Altavista not only catalogue
billions of Web pages, but also index
images. Using these engines to search for
images is quite similar to using them to
hunt for Web pages. All you have to do is

click the Images tab just above the text
box. Once the page is loaded, use the text
box to search for images that suit your
query. Google, for example, analyses text
on a Web page adjacent to the image
itself. It also takes into consideration the
image caption and other factors to right-
ly determine the image content.

The drawback? Neither search engine
can determine whether the images being
displayed are copyrighted material or not.
If you see an image that you like and wish
to use, open the Web page of the image to
verify its exact status. Copyrighted images
would require the authorisation of the

Once you’ve downloaded a massive album
of fonts and typefaces, you’re going to
need some help in keeping them neatly
arranged and organised. Printers Apprentice
is a comprehensive tool for managing font
files on Windows systems. Features include
an Explorer-style interface for viewing fonts
on your system, the ability to view fonts
from any media without installing them,
the ability to view character sets and key-
board layouts, batch font install/uninstall,
and more. You can print eight different font
catalogues and font sample sheets, as well
as the entire contents of a disk or CD.

Another useful tool for font manage-
ment is FontAgent, a font utility for repair-

ing, organising, and maintaining font col-
lections. It quickly finds all fonts and iden-
tifies corrupt, duplicate and unmatched
fonts. With the click of a button, it moves
all the problem fonts into a special folder
and organises all the good fonts any way
you want: in one folder, in alphabetical
sub-folders, and more.

If you’re looking for a way to browse
through the fonts installed on your com-
puter, there is a freeware solution for you.
Fontastic is a font viewer with capabilities
that your common font viewer lacks. It
gives you the ability to preview fonts using
text that you type and not some prepared
text such as Aa, Bb or that jaded ‘The

quick brown fox’ text. You can scale a font
up to 500 points and easily rotate through
the fonts as you wish.

Managing Fonts

Sometimes, clarity is hard to find amid
all the verbal gymnastics that image
repository sites such as Corbis and
Imagebank, the leaders in stock photog-
raphy carry. At first glance, the term
‘royalty-free’ might appear to suggest
that an image is free, with no strings
attached. Well, you couldn’t be further
from the truth. We’ve elaborated on a
few terms and their implications.

What the expression ‘royalty-free’ really
means is you can use such images without
having to pay for them on a per-use basis.
But to get the images, you have to shell
out a one-time fee that can range from
tens to hundreds of dollars depending on
the photograph and its resolution. Images
that are classified under the royalty-free
license can be altered and freely used in a
wide variety of commercial purposes.

A traditional license requires you to
outline how and when you wish to use
the images and the fees will be based
upon such information. Under this
scheme, images are generally used only
once, though deals can be arranged for
time bound or unlimited usage. Of
course, the more control you want over
the images, the more you’re going to
have to pay. You can also request exclu-
sive rights to an image, and although you
won’t own it, at least you can keep your
competitors at bay. Sites such as Gettyim-
ages use a similar method of licensing
called ‘rights & clearance’ wherein a deal
is negotiated between the site and the
creator of the images on your behalf.
Usually, clearance like this is required only
in special circumstances outside the realm
of ordinary license schemes.

Royalty Blues

Printer's Apprentice is a power tool for
managing font files and type faces
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owner before you can use them. And even
if what you’ve found is not copy-

righted, don’t assume that either
Google or Altavista provides
legal permission for you to use

them.
Image searches come equipped with

filters that omit mature images and con-
tent. Users can easily toggle the filters on
and off. But because of the nature of the
search, some images might slip through
the cracks.

Designer tips
Aside from resources for
designers you can also find
expert design tips online.
Whether it has to do with
the slightly more mun-
dane issue of pagination
or advice on how to best
exploit your genius, there
is a liberal amount of
material online to help
you.

A sure stop for graph-
ics designers who wish to
accentuate their skills by
means of a simple, yet meaningful
approach through art is www.graphicde-
signbasics.com. The site carries numerous
articles that bring out some interesting
content pertaining to the elements and
principles of design including insights on
colour, line, texture and more. All this is
coupled with an online image gallery that

authors contribute and use to illustrate
the meaning of each rule. 

Loaded with goodies, www.photo-
shopcafe.com is one of the most use-
ful resources on the Web for Pho-
toshop users. The site is packed
with information, especially for
those wanting greater control and

flexibility from their soft-
ware. Tips and tutorials
suited for the beginner as
well as the advanced user
are coupled with down-
loadable examples so that
users can easily take on
and use some of the more
fancy aspects of Photo-
shop. An online design
gallery features some of
the talents behind the
site’s expert community.
And speaking of commu-
nity, the discussion group
maintains a collection of
various forums making
Photoshop Café one of the
most essential bookmarks
for anyone who cares to
expand their talents.

So here you have it,
some of the best and most
balanced online resources
pertaining to design. From
advice to fonts, just about
every aspect of design lies
a click away. Plenty of

pieces to the design puzzle are here, free
for the taking, but if it’s quality you’re
looking for, don’t shy away from letting
your money speak the words of art. After

all, it’s more affordable than your own
studio and let’s face it, there’s no such
thing as a free lunch.

PRASHANT MASRANI

Graphics Design
Basics (above) is a
good start to
absorbing the
essentials of
graphic design. 
Photoshop Cafe
(left) has its foun-
dation on thou-
sands of users who
contribute to the
art and cause of
everything 
Photoshop

Working with a large collection of images
can be a mind-numbing experience to say
the least. If a picture is worth a thousand
words, then how much justice will a 30-
character filename do? Tame those vague-
ly named images with software that con-
verts, organises and catalogues the album
of images on your machine.

If you find it increasingly difficult to
remember the name and location of saved
files, then try out eGems Collector Pro.
One of the most useful features is its abili-
ty to store the source of the electronic file
in a field it calls ‘bibliography’. 

ThumbsPlus is a tool used by profes-
sionals for image browsing, viewing and
organising. It includes some strong image
cataloguing features as well as high-end
relational database support. It features
numerous small yet nifty additions such as

Auto Clip Save, which automatically saves
clipboard content to files, and automatic
saving of photo scans. 

FotoStation is a more balanced soft-
ware package, offering impressive image
editing features and satisfactory browsing,

viewing, and publishing options to profes-
sionals and novices. Its powerful text
annotation abilities make it an excellent
choice if you need to store a great deal of
text information with your images.

If you’re averse to buying such soft-
ware, there are a couple of good free
options available. PhotoShoot maintains
an accurate inventory of all your photos
and other image files. You can easily
locate a picture by category, subject,
photo ID and the date the picture was
taken on. 

Another more popular free utility is
Ulead Photo Explorer, a visual file manager
that works with images and multimedia
clips. The software allows you to organise
and share your digital files quickly. A digi-
tal camera wizard lets you upload your 
pictures quickly too.

Managing Images

Organise and manipulate digital images
and video clips with Ulead Photo Explorer
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Changing BIOS settings isn’t an act for
the faint hearted. The BIOS gives
users an avenue to change the most

basic processes in a PC. It’s also one of the
most frequented stops when installing hard-
ware. Unfortunately, the whole subject
remains as obscure to many today, as it has
always been. But with the right under-
standing, and possibly some tolerance on
the side for good measure, you’ll be able to
tailor your computer to your way of work-
ing. Want to change the way your PC loads?
Need to install a hard drive? Read on.

Getting through
In most PCs, particularly of the assembled
variety, simply depress the [F1] or [Delete]
key (a directive onscreen usually says
which) a brief moment after you power up
your computer. Usually, you have only a
few seconds to take action, so make sure
you’re standing by.

■ The Standard Options menu offers the
simplest level of setup for users. You can
access basic settings such as the time and
date, and even set up your floppy drive
through this menu.

One of the most common problems
faced by users has to do with fixed devices.
This would include hard drives, CD and
DVD drives or any other mass storage
drive that is installed in a similar fashion.
At times, when the computer’s battery is
weak or has been changed, the BIOS 

settings revert back to the
default settings, which may
or may not comply with your
specifications. As a result,
hard disk error messages will
arise. Drive models that date
after 1997 should face no
problems at all if you change
the drive type to ‘Auto’. In
case you have a rather dated
hard disk attached to the sys-
tem, it’s best to manually
enter the drive’s details such
as sectors, cylinders and so
on. You can usually find
these settings listed on the hard disk itself.

■ In the Advanced BIOS category, you will
be presented with a higher level of control.
You can choose to have the booting process
start from either a CD-ROM or alternative
storage devices such as a Zip drive. Enabling
anti-virus protection won’t help you much
with common viruses as it simply ensures
that nothing can be written to the boot sec-
tor, a place where only the most dangerous
of viruses encroach. With the Internet and
its worms and Trojans, this basic level of
protection does practically little.

■ Power Management helps your PC
operate independently of you. There are a
number of nifty things you can do by sim-
ply tweaking the settings in this area.
Putting your computer off to ‘sleep’ and
waking it up later is a clever principle for
saving power and loading time. You can
specify the exact time and date you want
to power up or power down the system.

The key power saving modes are stand-
by and suspend. When the PC goes into
standby, the hard drive and monitors are
turned off while everything else remains
fully operational. The suspend mode com-
pletely shuts off the PC except for the
CPU, which operates in minimal mode.
Newer machines have the benefit of ‘Sus-
pend-to-RAM’, which saves a snapshot of
the current working environment to

memory, which can be instantly recalled
by a mouse click, or by hitting a key.

An easier way of managing these set-
tings is through Windows itself. If your
BIOS is ACPI-compliant, you can enable
this option to easily configure through
Windows as to how you want your com-
puter to handle power saving issues.

■ PC Health Status essentially monitors
the thermal condition of your PC. It basi-
cally shows a quick status of CPU and sys-
tem temperature, voltage levels and fan
speeds. Some computers come with a facil-
ity to set an alarm and turn off the PC in
case the temperature exceeds a specified
limit. In short, it’s a simple way of making
sure that nothing goes wrong, and noth-
ing usually does.

■ Passwords lets you keep your comput-
er as secure as possible by setting a pass-
word at a much lower level than the oper-
ating system. BIOSs generally impart two
levels of security, one at the user level and
the other at a system level.

A user-level password will let you boot
up the computer as you normally would
with restricted access to the BIOS. It is the
system password that grants such author-
ity to open and modify the BIOS. It’s a per-
fect setup for PCs that have a supervisor
with multiple users.

PRASHANT MASRANI

Harmonise that BIOS!

A typical view of the BIOS main menu

Commonly experienced problems, such as
hard disk errors, can be easily fixed through
standard BIOS options
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MODEM & INTERNET 
No connection

My modem handshakes but it refuses
to connect. What could be the problem?

There can be several reasons for this.
The most prominent reason is usually
the slow response from the local and
remote server. Line noise (disturbance)
can also hamper the connection
between your modem and the modem
used by the ISP.

Lower the connecting speeds—this will

make you log on to the Net at lower speeds
and take care of the problem. To set the
modem speeds, go to Start > Settings > Con-
trol Panel > System > Device Manager, right-
click on Modem and click on Properties.
In the window which opens up, click on
the Modem tab and under ‘Maximum port
speed’, select the slowest speed (300 bits
per second).  

Slow transfer rates
I have a 33.6 kbps modem but it still

has slow transfer rates. How do I fix this?

Internet speed depends on many fac-
tors such as the speed of your modem,
the condition of the telephone line and
bandwidth provided by the ISP. If you
want faster transfer rates, go in for a
56.6 Kbps modem. 

Make sure your telephone line is
properly wired. If you still feel the rates
are not fast enough, then the fault lies
with the telephone which is not capable
of supporting more than 6 kbps transfer
rates. In that case the only alternative
left is either a DSL or a cable connection.

Your answer to the most common computer ailments as well as tips on how to increase 
productivity and enhance the entire computing experience

■ troubleshooting

Like it or not, PC troubleshooting has always been part
and parcel of the overall computing experience. A major
hurdle with PC troubleshooting in India has been the
paucity of professional call centres and guidance from

expert solution providers. Even if someone is there to help, the
experience can prove to be frustrating, expensive and sometimes
of no practical use. 

The sheer variety and gamut of peripherals available today
means that tracking down the root of the cause is always time-
consuming and exasperating. Little wonder then that solutions
from most dealers and so-called experts tend to be catastroph-
ic— “you will have to change everything here” or “nothing can
be done at all.” 

The good news is that almost 90 per cent of all PC-related

problems are easily solvable and you needn’t pick up the screw-
driver every time you want to troubleshoot. All you need to
apply is a little common sense and track down the source of the
problem. Once you’ve tracked the problem, the solution rarely
involves any major system overhaul.

PCs are like individuals with varying characteristics and
behavioural patterns. Only those users who really use their PCs
can observe the quirks and performance oddities peculiar to
their PC. The ability to diagnose these faults takes a little expe-
rience (and time) and this is where the Troubleshooting Guide
steps in: to help you find easy solutions to common problems
as well as long-drawn ‘if and then’ solutions for complicated
and confusing problems. All you need is an open mind and a
desire to troubleshoot. Ready?
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Low download speeds
I use 56 Kbps modem yet I get only 2-

3 Kbps download speed. Why?

It seems the ISP you have subscribed
to offers less bandwidth and yet allows
more people to log on. As a result, you
get low download speeds. Try changing
your ISP.

Connect-reconnect
My modem keeps dropping the line no

matter which number I dial. What do I do
to stay connected?

The problem could be your telephone
itself; get the line checked by a lines-
man. Putting aside this probability, you
could try this setting: go to Start >
Settings > Control Panel > System > Device
Manager, right-click on Modem and click
on Properties. Here click on the Advance
tab and empty the field under Extra

Initialization Command. Type in the
string ATS10=250. If this changes to 255,
your modem will never hang even if the
modem used by the ISP hangs. 

No connection between modems
My modem works fine but when-

ever I try to connect to another
modem, the only thing it does is

ring. The problem persists
even after trying many ter-

minal programs.
However, my friend
who uses the same
model does not face

any problem. Why is
this so?

In this case the
error most probably

lies in the S0 register.
With this register, you define

the number of rings before the
modem can react. However, if one adds
‘0’ in this register then the modem does
not record the connection. 

Go to Start > Settings > Control Panel > Sys-
tem > Device Manager, right-click on Modem
and click on Properties. Here click on the
Advanced tab and in the empty field
under Extra Initialization Command, type
in the string ATS0=6. If there is any other
string already there such as ATS10=250
just continue by adding the above string
without any space. This specifies that the
call should be received after six rings.

Downloading Web mail to the e-mail
client

How do I configure my e-mail client to
download my mail?

Your ISP must have provided you the
incoming and outgoing server names
used to receive and send e-mail. If your
ISP is VSNL, for example, then config-
ure the e-mail client as POP3. To do so,
in Outlook Express go to Tools >
Accounts. There you should add mail,
the necessary details, and when you are
prompted for the server name, select
POP3 and type pop.vsnl.com or
bom7.vsnl.net.in (depending on the serv-
er name allocated to you) for the
incoming and smtp.vsnl.com for the out-
going server.

If you want to download mail from
Yahoo!, the incoming server should be put
in as pop.mail.yahoo.com and the outgoing
server should be set as smtp.mail.yahoo.com.
If you have an account with Hotmail, fol-

low the same procedure for adding an
account. Outlook Express will automati-
cally configure the same as an http
account and also allow you to download
mail from hotmail. 

Connecting to another PC through a
modem

I use Windows 98. How can I connect
via a modem to another person’s comput-
er (without connecting to the Internet)
and share my files?

You will have to install Dialup Server
Utility on one of the machines. You will
have to configure this by setting the
default server type as PPP: Internet,
Windows NT Server, Windows 98. If you
want you can assign a password. Install
the TCP/IP on both the machines and
assign a static IP address to Dial-up
adapters. 

To share files you will have to install
‘File and Print Sharing for Microsoft 
Networks’ on both machines. All these
components can be installed and config-
ured from Start > Settings > Control Panel >
Network.

Once this is set up, you will have to cre-
ate a dial-up connection from your
machine. In the TCP/IP settings put the IP
address of the server you are connecting
from. If access password is assigned,
enable Require Encrypted Password. You
can provide a password in the Connection
dialog box itself or you will be prompted
for it once you are connected. To be able
to browse the remote machine from Win-
dows Explorer, click on ‘Map network
drive’ from the Tools Menu. In the path

Adding a simple string will fix your
connection problems

Using your e-mail client to download mails
will require the POP3 settings of your ISP

ILLUSTRATIONS: Mahesh Benkar
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field, type the IP address as the machine
name and the shared resource as a UNC.   

Enabling auto complete
I use Windows 98 and IE to browse the

Net. I shut off the auto complete feature
by mistake and would like to enable it
again.

In order to enable the auto complete
feature in Internet Explorer, go to Tools
> Internet Options > Content. Here, click
on the Auto Complete button and
enable the options. You will also be
prompted to key in user name and pass-
word. 

HARD DISKS
Hard disk capacity shows less

I have recently purchased a 15.3 GB
hard disk but my system does not display
it as 15.3 GB. Has my dealer cheated me?

No, your dealer has not cheated you.
But your system is not lying either
because 1 GB is equivalent to 1024 MB
(raw, unformatted). Also, when you for-
mat your hard disk and install your
operating system, the file allocation that
is done is such that it always puts some
blank space before placing data for
another file. As a result, the blank space
is considered as having been utilised
and hence, the actual size of a hard disk
would always be lesser after you’ve for-
matted it.  

Setting multiple primary partitions
I want to have multiple primary parti-

tions, one per operating system. Is there
is any utility which will ask me which OS
to use at boot time?

You can do this with a utility called
Boot Manager. This utility inserts itself
into the beginning of the boot process,
sets up a special boot manager partition
and then makes itself the active partition.
When you boot up the PC, the code in
this partition runs. It analyses the pri-
mary partitions on the disk and then
presents a menu and asks which operat-
ing system you want to use. It marks the
one you select as active, and then contin-
ues the boot process from there.

System Commander 7 and BootIt
Direct are some other boot managers that
can handle this task efficiently.

BIOS shows less hard disk capacity
The BIOS detects the hard disk drive

but does not recognise the actual capaci-
ty. Why is it so? 

It’s quite frustrating to find that not
all of your hard disk is actually accessi-
ble, especially when you are trying to
add a new hard disk to an older system.
This is almost always due to the BIOS
not properly recognising the hard disk
structures and access routines. This prob-
lem can be rectified by upgrading the
BIOS or by using third-party disk man-
agers. In some cases, these problems are
due to actual hardware or software bugs
that are not detected until hard disks
grow in size beyond a certain point.

Check documentation to see if your
motherboard supports LBA mode. This
allows recognition of hard drive sizes

greater than 528 MB. If LBA mode is not
supported, the system will only recognise
a maximum 528 MB, regardless of how
large the hard drive is.

Non-LBA systems require a driver to
be loaded to overcome the 528 MB barri-
er. Most large hard drives come with a
driver disk and instructions for loading
it, or have the driver already installed on

the drive. Driver procedures vary, but
generally the driver will load before DOS
or Windows, enabling the system to see
more than a 528 MB drive. The same goes
for systems in which the BIOS recognises
a maximum of 8.4 GB even in LBA mode.

Damned by DMA
After enabling the DMA for my hard

disk drive, I can’t boot Windows in the
normal mode, get too many errors, and
also cannot uncheck the DMA option in
the safe mode. How do I uncheck the
DMA option?

Booting into safe mode is usually the
fail-safe method for changing settings
back to the default. If you cannot deselect
the option in safe mode, go to the page

in the CMOS Setup that sets the operat-
ing parameters for your hard drive and
temporarily disable the DMA mode. Run
Windows in Normal mode and every-
thing will operate normally, although
disk performance will be reduced. 

After starting Windows in the Normal
mode, deselect the DMA option that you
had enabled initially.

There are plenty of tools that can check
and ensure that your PC gives you 
trouble-free performance. For exam-
ple, Norton System Works
2002 provides good
diagnostic utilities like
Norton Disk Doctor,
which constantly
monitors the health of
your hard disk, prevents
deletion of system
files and fixes
registry errors,
and has a special
disk defragment-
ing utility to
speed up your
machine.

Tools like
motherboard

monitor (mbm.livewiredev.com) display your
motherboard temperature and the inter-

nal fan speeds, and even allow you
to set alarms for overheat and fan

failure protection. 
There are tools avail-

able to free up memo-
ry. One such tool is
RAM Optimizer which
allows one to see how
much memory is
being occupied by a
particular program,
and root out pro-

grams that are
no longer

being used
but still
o c c u p y
RAM.

Getting Help

The BIOS on older motherboards
have problems detecting high
capacity drives“ ”
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Invisible data
I have two hard drives, one is a 20 GB

drive and the other is 40 GB. I had to
transfer some of my files on to my friend’s
PC for which I detached my 40-GB drive
and took it to his place. After transferring
the files, I fixed it back on my machine.
The problem is that now the drive fails to
show any of my data in Windows environ-
ment but while booting, the boot-up
screen shows that the hard drive is being
detected. What could be the problem?

It seems your FAT table has been cor-
rupted. As a result, in spite of your hard
disk being detected in the BIOS, it fails
to show any data on the PC. You should
try to recover the data by using reliable
data recovery software. (Refer to the

February issue of Digit for the story,
Surviving a Hard Disk Crash) 

FLOPPY DRIVE
No read-write floppy drive

I use Windows 98. My floppy drive
does not read or write to floppy disks.
What could be the reason and how do I
solve this problem?

This is a very common problem with
floppy disks. The troubleshooting tech-
nique is as follows:

Start by checking the floppy, as this is
the first point from where the problems
begin. You could try changing diskettes a
few times unless you are sure that the
floppy disks are not faulty. Try a properly
formatted diskette in your suspect drive.
A faulty disk can generate some very
inconsistent read and write problems.

Try cleaning the floppy drive next.
Clean the read/write heads thoroughly.
There are head cleaning disks available in
the market that do a decent job of clean-
ing the drive. However, make sure that
you do not run the drive with a head-
cleaning disk inserted for more than 30
seconds at a time, or you could damage
the heads with excessive friction.

Your next suspect should be the signal
cable. Make sure that the drive’s 34-pin
ribbon cable is attached securely at the

drive and at the drive controller. Try re-
attaching the signal cable if it is loose, or
rather, try another signal cable to be sure
that the cable is not the problem.

Finally, you could try replacing the
floppy drive. If the problem persists,
chances are that the floppy drive is defec-
tive. It could be that the head read/write
system has failed. Try replacing the floppy
drive with an optimal drive from another
system to check if this is the problem.

If changing the floppy drive too does
not resolve the problem, you may have a
defective floppy drive controller circuit. If
this is the case, you may also receive a
floppy drive or controller error from the
system BIOS while booting. Disabling the
existing floppy controller and installing
an expansion card controller can solve

this; the floppy controller portion is left
enabled.

Floppy drive LED stays on
I recently upgraded my system. Ever

since, as soon as I boot my PC, the floppy
drive LED stays on. Is this some kind of a
virus?

No, this is not a virus. The problem
here is that one end of the drive cable
has been inserted backwards. Open the
CPU case and make sure that pin 1 on
the 34-pin cable is aligned properly
with the connector on both the drive
and controller. This usually solves the
problem in most of the cases. The fail-
ure of the drive controller can also
cause this problem, although this is
somewhat rare.

GRAPHICS CARD
Only 256 colours displayed by 
systems

My system is unable to display more
than 256 colours. How do I get it to dis-
play more colours?

First, for your system to display more
than 256 colours, you should have at
least a 1 MB graphics card. In today’s
time, a 4 MB graphics card is the lowest
configuration card available in the mar-

ket. Hence, we suspect you are facing a
driver problem. Either you’ve removed
or installed incorrect drivers. In case
you have upgraded your operating sys-
tem from Windows 98 to Windows
2000, you will need to load the set of
drivers specially developed for this OS.
You can install the drivers from the
diskette that came with the graphics
card or download these drivers straight
from the developer’s Web site. Once you
have installed the appropriate drivers,
you will automatically get an option of
16, 24 or 32-bit, depending upon the
type of graphics card you use. Now your
graphics card will be able to display
more colours. 

16 MB card shows as 8 MB 
I have a 16 MB TNT2 graphics card but

my system shows it as an 8-MB card.
Why?

The RAM on your card may not be
functioning properly, hence it would be
better if you sent it back to the dealer
for testing. However, before you send it,
open the PC and remove the graphics
card and check if rust or dust has affect-
ed the chips. Clean the chips gently and
then reinsert the card. Now start your
machine and if it still shows as 8 MB on
boot up, then you will have to replace
your card. 

Monitor goes on the blink when
playing games

I have a Trident 9750 3D accelerator
graphics card. However, whenever I try to
play games such as Quake III or Need for
Speed, my monitor automatically goes in

Adjust your colour settings for proper display

Older graphics cards do not 
comply with the latest versions
of the OpenGL and DirectX API “ ”
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standby mode—I can’t see anything but I
can hear sounds pretty well. Sometimes I
get a ‘3D device error’ too. Has my
graphics card gone kaput?

The AGP card that you have is a very
low-end 3D-accelerator. Apart from pro-
viding basic 3D acceleration, there isn’t
much else that this card can do for
advanced games such as Need for Speed
and Quake III, which incorporate fog
effects, specular and dynamic lightning,
and tri-linear filtering. Additionally,
new graphical programs also use Open
GL and other standards, which require
much more power in the graphics
processor. Hence, this card will allow
you to play only very low-end 3D
games. If you’d like to play high-end
games, buy a graphics card like the
GeForce2 or the GeForce3.  

Blank screen when playing 3D games
While playing 3D games, the screen

suddenly goes blank while I am playing.
Sometimes my PC hangs when I close the
game and return to my desktop. Why
does this happen?

Check to see if the graphics card is
being sufficiently cooled. Make sure
that there are no loose wires or a cable
obstructing the fan on the graphics
processor. Remove any dust/grime
from the fan. You could try to reduce
the quality and resolution settings in
the game/Windows environment (dis-
play properties). The problem could
also be because of incorrect/outdated
drivers. See that you are running the
latest drivers.

Another reason could be that the
motherboard is not able to supply suffi-
cient/correct voltage to the AGP port. In
which case, you will have to replace the
motherboard.

Detonator drivers
What are Detonator drivers and what

kind of graphics cards are they meant for?

These drivers are for nVidia graphics
processors only. They go hand in hand
with DirectX drivers of version 6 and
above. These drivers increase the graph-
ics card’s performance. Some of the
Detonator’s features include DVD and
HDTV playback, advanced Digital
Vibrance Control (DVC) user interface
for products that support DVC, and
improved FSAA control panels. It also

No POST (Power On Self Test)
■ First and foremost check if the power
cable is properly fitted.
■ Then check if the toggle switch is on
(found behind the computer cabinet,
SMPS).
■ After this try switching on your
machine and check for signs of life
(lighting up of the Power LED on the
front panel).
■ If you can hear a whirring sound
(fans and the hard drive rotating)
then it means that the SMPS
(Switch Mode Power Supply) is
fine. If not and the machine
sounds dead with no signs of
power then try replacing the
power cord, otherwise it
means that the
SMPS  is dead.
■ If the machine shows
signs of power and still
does not POST then either
some PCI device has come
loose or some component has
failed.
■ You can investigate the problem fur-
ther if your BIOS emits a peculiar beep
code. The following is a common list of
beep codes for the popular Award BIOS:
1. One long beep: Memory problem
2. One long, then two short beeps: Video
error
3. One long, then three short beeps:
Video error
4. Continuous beeping: Memory problem
5. Alternating high-low beeps: CPU not
working

POSTs, but hangs too
If1 the system POSTs but hangs on the
POST screen, check for the following:
■ Bad memory timings in the BIOS or
bad RAM. Try changing RAM slots and
the RAM module. Revert to default set-
tings in the BIOS.
■ Corrupt BIOS (if the POST screen
becomes garbled). You will have to
change the BIOS EPROM chip.
■ Processor is overclocked. Check in the
BIOS for the processor and frequency
settings. If you are not sure then you
can revert to default settings for the
BIOS

General guidelines
While it is almost impossible to pin

down to a specific problem and a spe-
cific solution, there are broad guidelines
that you can follow while troubleshoot-
ing:
■ Boot into Windows using the step-by-
step confirmation method if you are
using Windows 9x. 
■ Go through your BIOS settings, and
turn everything at the default settings. 
■ Remove all PCI cards, even the sound-
card and try booting only with the video
card, hard drive, floppy drive and CD-
ROM installed. You then add one card at
a time, until the boot problem shows up. 
■ Long boot times suggest that Windows
is most probably trying to resolve an IRQ
conflict. You can manually assign IRQs
to the PCI slots from the BIOS but do
this as a last resort as this can sometimes
cause more trouble.
■ Try booting into safe mode—if you
can, then it’s most probably a conflict or
a driver-related issue. 
■ Try uninstalling the last driver you
installed or perform a system restore. All
versions of Windows after 98 have some
form of system restore utility—Windows
XP has the best, of course. Try creating as
many system restore points when your
system is working fine.

‘My System won’t Boot, What do I do?’



103 MARCH 2002

features an easy-to-use antialiasing con-
trol user interface, and optimisations for
Intel i815 and Pentium 4 processors and
AMD Duron and Athlon processors. You
can download them from
www.nvidia.com/Products.nsf/htmlmedia/soft
ware_drivers.html.

Continuous beep on power up
I assembled a PC on my own, but

whenever I power it up, I get a strange
continuous beep and nothing shows on
the monitor. Please explain why this hap-
pens.

Your video card is not fitted in right.
Make sure the card connectors are snug-
ly fitted in the respective slots, and see
to it that the RAM and the processor are
properly seated. 

Linux incompatible
My graphics card doesn’t work in

Linux. How can I fix this?

Make sure that your graphics card is
supported under Linux, and that X-
Windows is configured properly (just
type setup in the console). If your graph-
ics card is not supported, you should
download the latest Xfree86-SVGA file,
which is available at
ftp://rpmfind.net/linux/caldera/LTP/col/install/RP
MS/XFree86-SVGA-3.3.6-6.i386.rpm. 

The latest version has support for most
of the cards. However, if you find that
your card is supported under Linux and it
is still not detected, it means that you
have not configured your X-Windows
operating system properly. To do so, log in
as root and at the terminal type setup and
press [Enter]. Go to X configuration and
press [Enter]. The Linux OS will either
detect your card or ask you to configure it.
If it does not detect your card, you can
choose Custom. Now you would need to
know your monitor’s refresh rates, which
can be obtained from the monitor’s man-
ual. If you can’t determine the refresh
rate, use a refresh rate of 60 Hz, which is
supported by most monitors. Then, using
a trial-and-error method you can find the
best resolution for your PC. 

Need for Speed doesn’t work in
Windows XP

I love playing racing simulations and
have the entire Need for Speed series (2, 3,
4, 5) on CDs. But my problem is that
none of my games work with Windows
XP. What’s the problem?

The Need for Speed series does not
natively support the Windows 2000/XP
environment. But you can try using the
program compatibility mode offered in
Windows XP (right-click the Program
file, go to Properties, and select
Compatibility) and run the games in

Windows 98 mode. Now your games
should work fine. 

CD-ROM/DVD/CD-RW
DRIVES
Long time detecting CD-ROM at
startup

My computer takes a very long time
searching for the CD-ROM during startup.
How can I avoid this?

You will have to make a few changes
to your CMOS in order to solve this
problem. Press ‘Del’ on startup; it will
lead you to the CMOS. Choose the
Standard CMOS option and select ‘Auto
Detect Hard Disk’ and check whether
the CD-ROM is set as slave to your hard
drive. Now set the ‘Primary Slave’
option on ‘Auto’. With the exception of
hard disk and CD-ROM drive, set all
other options of IDE device to none.
Now save the configuration and exit by
returning to the main setup.   

CD tray behaves erratically 
I experience a strange problem. When-

ever I insert a CD in the CD tray, the CD
tray comes out automatically after a
while. Sometimes, it refuses to eject,
while other times it refuses to go in.
Please help me fix this erratic behaviour.

This behaviour is often caused by
dirty sense switch contacts or bad con-
nections in the CD drive. Other reasons
could be worn out or stretched belt of

the drive, poor or gummed up lubrica-
tion, defective motor or bad connec-
tions to the motor, stripped gear or
other mechanical damage, defective
micro-controller or other logic circuitry.
Chances are that none of these prob-
lems can be fixed by you, nor are they
easy to diagnose. Your best bet would be
to get the drive and the system serv-
iced/checked by an authorised service
engineer.

A slow CD-ROM drive 
When I insert a disk in my CD-ROM

drive, the operations take too long to
complete. For example, Windows Explor-
er takes a long time to show the contents
of the disk. Sometimes, this simply fails
and I end up rebooting the PC. Please
help me fix this problem.

If this problem occurs only with a sin-
gle disk, chances are that this disk is
dirty, scratched, or defective. If this prob-
lem occurs with most of the disks, then
you could try cleaning the drive first,
which could be dirty or have a damaged
objective lens. If these two suggestions
don’t fix the problem, then there’s a seri-
ous problem with the drive, such as a
faulty sled motor or drive IC, faulty con-
trol logic, bad cables, faulty tracking or
CLV servo, or an engaged transportation
lock. In this case you will have to get the
drive checked by a technician. 

CDs don’t autorun 
My CDs do not autorun in my PC.

However, the same CD autoruns on my
friend’s machine. How do I fix this?

The problem occurs if there is an
incorrect entry in the registry. Be careful
while editing the registry, it’s advisable
to make a backup first. Go to Start >
Run, type regedit, and click OK. Navigate
to the following key: HKEY_CUR-
RENT_USER\Software\Microsoft\Windo
ws\CurrentVersion\Policies\Explorer
and modify the binary value for the
NoDriveTypeAutoRun key to 0000 95 00
00 00. This should take care of the 
problem.

Poor DVD playbacks 
I have a problem with performance

issues while playing DVDs on my DVD
drive. The most common problem is a
poor playback while playing any movie—
even though the DVDs are of fine quality.
Apart from this, I frequently come across

Accumulation of dust on the
lens in the CD drive is the
primary cause of read errors“ ”
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error messages when using the drive.
What is the problem?

The problem does not lie in the
drive. Actually, this is a problem faced
by many DVD drive users. Your first
move should be to check whether you
have the right and/or the latest drivers.
Driver problems are the major cause of
all playback-related issues—freezing
screens while playing DVDs, poor
sound, error messages, and so on. You
will usually find the latest drivers on
the Web site of the manufacturer of
your drive. At the same time, also make
sure that you have the right drivers for
your graphics adapter and DVD
decoder.

Next, you should check if the DMA or
Sync Data Transfer box is checked in Win-
dows. Go to Start > Settings > Control Panel
> System > Device Manager. Here, choose
CD-ROM, click on Driver Properties, and
choose the Settings tab. Make sure the
appropriate box is checked, depending on
whether it’s an IDE drive or a SCSI drive.
If you face any problem (which generally
happens when you use an AMD proces-
sor or a VIA chipset) uncheck the DMA
option and restart.

Finally, you could try a few basic tips
while playing DVDs that are known to
help: 

Close any unwanted programs that are
running in the background. Allocate more
memory to the DVD player, if there is an
option for the same. SCSI DVD-ROM
drives should either be the first or last

device in the SCSI chain with appropriate
terminations. 

If you are viewing the DVD on a TV,
the problems could also be due to a long
cable or poor contrast settings. 

Cannot play copy-protected files
I recently copied a movie file from a

DVD to my hard disk drive. Now I have
the essential software to play it, but when
I tried to play it, I got an error message
saying, “Cannot play copy-protected
files.” What’s wrong?

DVDs store DVD video as a .VOB file,
which is essentially a specialised MPEG-
2 file.  Most MPEG-2 decoders and play-
ers can play them. However, all movies
on a DVD are encrypted with CSS copy
protection. This is an encryption tech-
nique, with the corresponding decryp-
tion keys being stored in the normally

inaccessible lead-in area of the disc. If
you copy the contents of an encrypted
DVD to a hard drive, these keys are not,
or rather, cannot be copied. So when
you try to play the VOB file, the soft-
ware decoder tries to request the keys
from the DVD-ROM drive, which fails,
and then shows the error message. 

Buffer under-run error when burning
CDs

When I try to write to my CD-R using
my CD-Writer, I get a buffer under-run
error. Please tell me what this means and
how it can be solved.

A CD-RW requires an uninterrupted
data stream from the hard drive to write
successfully to a CD. A buffer under-run
message appears when the data stream
is interrupted. This may also occur if
another program interrupts the writing
process or if your writer’s write speed is
set too high. To solve the problem,
there are a few things you could try out:

Try recording at a lower speed. Make
sure that no other program is running
which could possibly interfere with your
CD-writing process. Examples of such
programs are usually fax and e-mail pro-
grams, screensavers, etc. Close or disable

any such programs. Also turn off the
power saving features of the PC. You can
also indulge in some tweaking up and
basic maintenance of your PC. This
should include regular scanning and
defragmenting of the hard disk, as well as
cleaning files and folders in the Windows
temp folder that you do not require often.
These simple tips usually do the trick and
fix the problem.

Recording more than the stated disc
capacity

Most CD-Rs allow a recording time of
some 74 minutes. I have been told that it
is possible to record more than this time.
Is it true? If yes, how can I record more
than the stated disc capacity? 

CD-Rs allow enough space to hold at
least 74 minutes of CD-DA audio CD
format. The format defines the number
of tracks on the disc which contain digi-
tal audio data and error correction rou-
tines that save sound from minor data
loss. The format allows for a total of 74
minutes of digital sound to be trans-
ferred at a rate of 150 kilobytes per sec-
ond (KBps) and 90 seconds of digital
silence. The silent area, called the ‘lead-
out’, is included so that a CD player

Eliminate buffer underruns by
experimenting with lower
burn- speed settings”

Make sure you do all this before baring
your computer: 
■ Unplug all power sources
and remove all
power cables
from the mains
and from your
SMPS. 
■ Unplug all
peripherals from
the computer and
make sure no remaining
cable is left hanging from
the PC. 
■ To safeguard against
damage from static elec-
tricity touch your hand to
another metal surface (non-

powder coated surface of the computer
cabinet will also suffice).
■ Check your computer’s manual, for
the proper way to remove your case. If

you don’t have a manual, look at
the back of the computer. You

should see about
four-six screws
holding the case
to the frame.
Simply remove

the screws.
The cover
s h 1 o u l d

slide off the
computer eas-

ily with little
effort.

Before you Open your Cabinet

“
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realises that it has reached the end of
the disc.

Your recording software does not
include the area reserved for the lead-out
when it tells you the capacity of the disk.
Thus data can be burnt on the reserved
area, and possibly into a few blocks past
the end of it. This is referred to as ‘over-
burning’ a disc. Overburning again would
depend on factors such as the CD-R disk
and the writer unit. If a writer isn’t able to
overburn, it will usually reject the cue
sheet before writing begins.

To overburn a CD you need to use soft-
ware that will not refuse to exceed the disc
capacity. For example, CDRWIN warns
you that the write may fail, but will allow
you to continue anyway. Nero offers the
option, under Expert Features, called
‘Enable oversize disc’, which allows for
longer write. 

Be warned that overburning can cause
write errors. Depending on the disc and
your player, the disc surface past the end
of the area reserved for the lead-out may
be unreliable and you may have trouble
seeking out your tracks near the end of
the disc.  

RAM
System does not detect new RAM
module

I recently installed a new RAM module
but my system refuses to detect it. What
could be the problem?

There are two reasons for such an
incident to occur. The newly installed
memory module may not have been
correctly placed in the memory bank in
the first case. In such a situation, the

computer will report a relevant error
message in the form of a beep. To 
fix this you will have to open the com-
puter and reinsert the RAM in a 
different slot.

However, on restarting, if the RAM is
still not detected, chances are that the
RAM might be defective. Try using the
same RAM on your friend’s machine and
if the result is still the same, then you
should ask your dealer to replace it with a
new RAM module. 

Installing different RAM modules
I have a motherboard that supports PC

133 MHz RAM. However, one of the RAM
modules is PC 133 MHz and the other is
PC 100 MHz RAM. Can I install them
together and will it work fine?

If your CPU is running at 133 MHz
then by default both your RAM mod-
ules will be forced to run at 133 MHz
inspite of one being a 100 MHz module.
Now whether the latter can take the
extra load depends on its type and 
quality.

MONITORS 
A distorted display

My monitor looks slightly distorted or
appears in a single-edge colour. How do I
fix it?

If your screen has developed scat-
tered spots of discolouration then you
will have to make use of the degauss
function which will cleanse the build
up of stray magnetic fields on your
monitor. To degauss your monitor, press
the menu button on your monitor and
get to the degauss function, which is
indicated as a horseshoe magnet crossed
under the circle. Press the menu button
again and the complete screen will get
displaced for few seconds.  

A flickering monitor
My monitor flickers quite

a bit when I try to increase
the refresh rate (it only
offers a setting of 60
Hz). What can 
I do? 

There is nothing
wrong with your
monitor. The flick-

ering is caused due to
a low refresh rate. In

order to prevent the flickering,

your monitor should be set at a refresh
rate of at least 75 Hz. You will be able to
adjust the refresh rate depending upon

the limitation of the monitor and the
graphics card. Sometimes, when
Windows does not find the right moni-
tor drivers, it installs the default moni-
tor drivers because of which you may
not be able to push further a particular
refresh rate. Therefore, first try and
install the right drivers for your monitor
and see whether you can increase the
refresh rate. If you still can’t, then try
running at a lower resolution. 

SPEAKERS
A sound problem in XP

I have a system running on Pentium III
700 MHz with 256 MB SDRAM on an
ASUS CUSL2 motherboard. My graphics
card is a GeForce-2 MX400 with 32 MB
RAM. I have a four-channel soundcard
based on the CMI8378 chipset and a 4.1
speaker system. I am running Windows
98 SE. All was fine until recently when I
upgraded to Windows XP Professional.
Now the rear channels of my speakers fail
to give any output when I am running XP
but when I switch back to Windows 98
SE, they work fine. What could be the
problem?

The drivers that you are using are
meant for Windows 98 and not
Windows XP and as a result you are fac-
ing this problem. 

You can download the appropriate
drivers for the CMI chipset from
www.pcdrivers.com. 

Select the right resolution for a flicker-free
display
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PRINTERS
Printer shows ‘out of memory’ 

My LaserJet printer has suddenly start-
ed giving me an error saying, “out of
memory.” What could be the problem?

There could be many reasons for
receiving this error. Each printer has a
distinct set of printer drivers which
instruct on how the task is to be han-
dled. This particular driver may have
been changed or swapped or the set-
tings might have been changed.

Some of these devices require the user
to specify the amount of RAM available.
Hence, check the settings for the printer.
Go to Start > Settings > Printers, right-click
on Printer Driver and go to Properties.
There you will be able to see this option.

The setting here should match the rated
setting of the printer. If this is not a prob-
lem, then it may be that the printer
spools all tasks to the hard disk before
printing any task and over a period of
time your hard disk may have become
clogged with all this data, leaving you
with no space to spool the task. This can
be fixed by clearing some space from
your hard drive.

There’s another remote possibility: the
memory chips might have become loose
or perhaps been damaged. In that case,
you need to contact a technician to get
the problem solved.  

Prints garbled text
My printer prints garbled text. What

could be the problem?

There could be two reasons for such
behaviour: either the drivers you
installed are not correct or are corrupt, or
there could be a fault in the printer head
such as worn out pins or badly rotating
pin cushion rollers. If the problem does-
n’t disappear even after reinstalling the
drivers, call a technician for help.

Error writing to LPT1
Whenever I try to print documents, I

get a message saying, “Error writing to
LPT1”. What do I do?

This is a very common error and
there are quite a few ways to fix it. First,
make sure that the printer is online and
that there is sufficient paper loaded in
the trays. Then clear the printer’s 

What’s an IRQ?
Most hardware devices on your computer
need attention from the processor on a fair-
ly regular basis and the mechanism for
doing this is called Interrupt Requests
(IRQs), which are dedicated hardware chan-
nels over which devices can send interrupt
signals to the CPU.

The sad part is that there are only 16 of
them, and some of them are reserved for
specific devices. This means devices will
have to share IRQs and sharing can be a
real problem if your hardware doesn’t
want it to share it with another. 

Common IRQ assignments
Go to the System Information tool in Acces-
sories. Proceed to Hardware Resources >
IRQs and you shall find a list of all
hardware that is mapped to IRQs in
your system. The following is the
most common mapping of IRQ
assignments. Open signifies that the
IRQ is free for the taking. As you can
see, there are five IRQs
free. Disabling the
COM2 and COM1 ports
from the BIOS will get
you two more!
1. System Timer
2. Keyboard
3. Open
4. COM port 2
5. COM port 1
6. Open 
7. Floppy
8. Parallel Port 1

9. Real Time Clock
10. Open 
11. Open
12. Open
13. PS/2 Mouse
14. Math Coprocessor/FPU
15. IDE controller 1
16. IDE controller 2

Intelligently reallocating valuable IRQs to
the needy will solve 90 per cent of all con-
flict-related problems. 

Common symptoms of IRQ conflicts
■ Modem won’t echo commands back to
the screen or simply won’t work
■ Hard lockups and system freezes
■ Frequent data corruption while 

transferring data 
■ Crackling, skipping or stut-

tering of audio playback;
system freezes when
audio playback is initiated
■ Sluggish I/O response

(extremely slow input
command cycles and

keyboard/ mouse
response on screen)

■ Windows boots
only in Safe mode
■ Mouse freezes
randomly 
■ Garbled or
incomplete 

printing
■ Lockups or freezes

while starting or run-
ning games

Troubleshooting  IRQ conflicts
■ Keep the first PCI slot free as it generally
shares an IRQ with the AGP slot. Graphics
cards are notoriously bad at sharing
resources and will usually hog the IRQ.  
■ Swap devices around on the mother-
board. If device A and B are conflicting then
change device A with device C. This is time
consuming, since you have to uninstall/rein-
stall drivers. 
■ If all else fails, the only way out is to
remove a device that you don’t use or could
do without. Alternatively, exchange it for a
different model with different resource
requirements. 
■ Windows 98 SE handles IRQ sharing much
better than Windows 98. Also Windows
2000 and Windows XP handle resource allo-
cation completely differently from previous
Windows versions and probably have the
best chance of getting your combination of
hardware to work. The advantage they have
is that they simply refuse to install on detect-
ing conflicting devices. 
■ It is always a good idea to free up as
many unused resources in the system as
possible before you start trying to resolve a
conflict. You should be able to disable allo-
cation of resources such as IRQs to COM
ports, USB ports and Printer ports (LPT) in
the BIOS if you do not use them. 
■ Refer to your motherboard manual for
IRQ assignments for specific PCI slots. You
will find that certain PCI slots will share 
IRQs irrespective of the component
installed. Avoid installing problem devices 
in these slots.

Irqued by IRQ
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memory by turning off the printer and
check whether the printer cable is prop-
erly connected. If you still get the error,
remove the printer drivers by going to
Add/Remove Programs and reinstall
them. If you still can’t print, then check
the parallel port settings by right-click-
ing My Computer and selecting
Properties. Go to Device Manager, dou-
ble-click ‘Ports (COM and LPT)’ and fur-
ther double-click ‘Printer Port (LPT1)’.
Select the Resources tab and check the
‘Conflicting device list’ box for an IRQ
(Interrupt Request line) or DMA (direct
memory access, a fast link to your com-
puter’s RAM) conflict. If another device
is using the printer port’s IRQ, disable
that device or assign it a new IRQ. To
disable the device, locate it in Device
Manager, open its Properties dialog box,
select the General tab, and check
‘Disable in this hardware profile’. To
look for a DMA conflict, first check
whether your printer port is configured
as an ECP port (the latest parallel port
technology designed to speed up print-
ing by using a DMA; older settings are
Standard, Bi-directional, and EPP). If
yours does support ECP, assign the 

parallel port to an unused DMA, usually
done in the PC’s CMOS setup program.
If your printer doesn’t support ECP, con-
figure the parallel port to a slower, com-
patible setting. The next-best option is
EPP. If your printer doesn’t support that
either, go with Standard—the slowest,
yet the most compatible setting.

WINDOWS 9x
Fatal exception errors when restart-
ing Windows 98

I have Windows 98 and I keep getting
fatal exception errors while restarting. The
error looks something like this: “Fatal
Exception OE occurred at 015:BFF712B.
The current application will be terminat-
ed. Press Ctrl + Alt + Del.” My machine
then automatically restarts in Safe mode
and I can’t do anything. Help me.

It seems one of the critical files have
been corrupted and this error message is
a result of that, as well as the reason
why your machine automatically boots

in safe mode. To solve this problem,
simply reinstall Windows. 

Incomplete defragmentation in
Windows 98

I use Windows 98 but am unable to
defragment my hard disk completely. As
soon as it reaches 10 per cent, it begins
restarting the program. What can I do?

This is a common problem faced by
most Windows 98 users and it usually
occurs when some program is running
in the background. In order to com-
pletely defragment your hard drive,
boot in Safe mode and run the defrag-
ment program. 

Windows protection error
Whenever I boot my PC I get an error

saying, “Windows Protection Error while
Initialising Device.” Restarting or rein-
stalling does not help.

You might have installed incorrect
drivers for one of the devices of your
system, or the drivers might have been
corrupted. You can boot in Safe mode
and remove the device. If you cannot
boot in Safe mode, you will have to
remove and reinstall Windows. 

System hangs on shutdown
I use Windows 98. Often when I shut

down the system, it hangs leaving me
with a blank screen and a flashing cursor. 

This problem occurs because the
‘Disable fast shutdown’ option is
unchecked. To enable this option, go to
Start > Run and type msconfig; press
[Enter]. Then select the Advanced but-
ton and check ‘Disable Fast Shutdown’.
This will solve your problem.

Associating applications with 
file type

How do I associate the original applica-
tion with a given file type? 

To associate an original application
with its file type you should go to
Windows Explorer and choose Tools >
Folder Options > File Types to display all
the registered file types. To change an
application launched with these file
types, select the file type, say, GIF,
HTML or JPEG, and choose Edit. In the
Edit file type box, manually type in the
name and the path of the application
you wish to launch with the file type
you have chosen. In this manner you

can change the file association with any
application.

Backing up the registry 
How do I backup my registry?

It’s quite easy to back up the
Windows 95/98/Me registry. Open the
Registry Editor by typing Regedit in the
Run dialog box under the Start menu.
Click on the Registry menu, and select
Export Registry File. Verify the following
items in the Export Registry File dialog
box: 

Save in: Desktop (for example)
File name: Registry Backup
Save as type: Registration Files
Export range: All
Click Save and Exit the Registry Editor.

Check that an icon labelled ‘Registry
Backup.reg’ is on the desktop.

Once you have made a backup of the
registry, you can make whatever edits you
had set out to do. It is always advisable to
make one edit at a time since it is easier to
rectify. 

If the change you made works fine
then delete the .reg file on the desktop. If
the change you made is not desirable,
then your backup will come handy. Dou-
ble-click on the registry file backed up on
the desktop—it will restore the registry to
its previous state.

Windows 9x has a feature in which
after each successful start, a backup of that
registry is made and saved. Just in case
something does go wrong, this backup
can be used to restore the system to a pre-
viously known ‘good’ state. 

To restore the registry, restart in 

Your printer refuses to print

Associate the right file extension with the
program 



108 MARCH 2002

insight ■
■ troubleshooting

MS-DOS mode and change to the Win-
dows folder,

C:\>cd windows
C:\windows>
Type the following commands and

press [Enter] after each one. Note that the
extension is .da0 and is the number zero.

attrib -h -r -s system.dat
attrib -h -r -s system.da0
copy system.da0 system.dat
attrib -h -r -s user.dat
attrib -h -r -s user.da0
copy user.da0 user.dat
Now restart your computer. This will

restore your registry to when you last suc-
cessfully started your computer. 

Windows 98 has an additional means
of backing up the registry. This is done by
using the scanreg command. This com-
mand is not available in Windows 95 and
NT. Here is what you do: 

Restart in MS-DOS mode and run the
scanreg command by typing scanreg
/backup at the command prompt.

The registry will be backed up and will
return to DOS prompt. If you need to
restore the registry, you have to type the
following command in DOS prompt.

scanreg /restore
Scanreg will check your registry and

display the list of available backups. Select
the backup at the top of your list. This is
the backup you made earlier. Press [R] to
restore the backup. When the restoration
is complete, type win and press [Enter] to
start Windows.

These methods will not work for Win-
dows NT/2000. Windows NT/2000 has
additional security protection that pre-
vents this backup from being restored. 

Windows NT provides many ways to
backup the registry, one of them being the
rdisk utility. Go to Start > Run and type
rdisk /s. Click OK and the Saving Config-
uration window appears. When this is
completed, the setup window opens.
Click Yes to create an Emergency Repair
Disk (ERD). When you have finished fol-
lowing the onscreen prompts, label the
disk ‘Emergency Repair Disk’ and include
the current date. Keep this disk along with
the three NT setup disks. These will come
in handy (the setup disks and the ERD) if
Windows NT becomes unbootable.

If you want to restore the registry to its
previous state, boot with the first disk of
the three Windows NT setup disks. When
the computer has booted, click Repair and
choose Registry. You will have a choice of
which parts of the registry to restore.

In Windows 2000, go to Start > Pro-

grams > Accessories > System Tools > Back-
up.  Click on Tool and then on Create an
Emergency Repair Disk. When prompted,
insert a disk into the floppy drive and
click OK. Label this as ‘Emergency Repair
Disk’. 

To restore settings from the ERD, you
will need your Windows 2000 CD, the

Windows 2000 setup disks, and the ERD.
During the restoration process, you can
press [F1] for more information about
your options. Using the ERD will restore
your settings to the time Windows was
first installed. Using the setup disks will
restore the settings to the last time you
updated the setup disks.

Drivers essentially translate commands
back and forth between the hardware in
question and the operating system, there-
by allowing different components of
your computer system to work together. 

If you haven’t installed the right driv-
ers for the right operating system, your
hardware will fail to function optimally.  
■ For the most part, you will need only
the motherboard chipset and graphics
card drivers for your system’s basic func-
tionality. 
■ Additional CI device or peripheral
components will require additional driv-
ers.
■ Remember to install service packs
and OS level patches before you
install any drivers.
■ All drivers are always
available on the manufac-
turer’s Web site.
■ This is important. If the
current drivers are giving
you optimum performance
and stability, do not
change them. Newer
drivers will always
promise better perform-
ance but can also
have bugs.
■ Always unzip
and maintain all
the drivers you
require for your sys-
tem in one specific
folder. If possible,
write them onto a CD-RW which
you can keep updating. 

Installing and updating drivers 
If you plan to install a new device or
component then the OS will detect the
new device and will prompt for suitable
drivers. If the OS fails to show you the
newly installed device, you need to man-
ually check the device manager for its
presence. If the device manager also does
not show any sign of new hardware (with
an exclamation mark) then it means that

the new device is either not powered on
or is not properly seated in the PCI slot.  

Usually, the driver that is shipped
with the hardware/peripheral is the one
that is most reliable. All revisions there-
on are just basically fine tuning the core
for better performance or stability. Unfor-
tunately, performance is always given pri-
ority, sometimes at the cost of stability.
■ Make sure you have successfully down-
loaded and unzipped (without CRC
errors) the new drivers into a temporary
directory. 
■ If you are upgrading from an older
driver, make sure you still have a copy of

the old drivers in case some-
thing goes wrong.

■ Make a back up of
your key Windows sys-
tem files and registry
settings.

■ Read the
readme.txt before
you install the new

drivers. It is very
important to go through

the readme.txt for
a potential heads
up on problems
that the manu-

facturer foresees or
otherwise.

■ Remove all traces
of the older driver.

For most drivers you
will have an entry in the

Add/Remove Programs in the
Control Panel. Once you’ve uninstalled
the driver, remove all remaining traces by
deleting residue directories.
■ You can now point Windows to the
right folder containing the driver and
proceed with the installation. 
■ For manual upgrades, you will have to
go to Start > Settings > Control Panel > System
> Device Manager, select Properties for the
specific component, and click on update
driver. Windows will then lead you
through the process.

Driver Troubles?
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Speedup the Start menu
The Start menu takes

quite a while to display the
list of programs installed. In
order to get Windows XP to
display the list faster, you
will have to edit the registry
settings. But before you set
about doing this, remember
to back up your registry
before making any changes.
To speed up your Start
menu, go to Start > Run and
type regedit. This will open
the registry window. Then
navigate to the following
key: HKEY_CURRENT_USER
\Control Panel\Desktop
folder. Thereafter, scroll
down in the right panel and
double-click on the menu
‘Show Delay File’. In the
Value Data box, change the
default value for the menu
speed from 400 to a lesser
number, such as 1 or even 0.
Click OK. You should now
find a significant increase in
the Start menu speed. 

Switching users
XP allows you to switch
users without actually quit-
ting programs and logging
off. To make use of this, go
to Start > Log off. You will be
greeted with an option of

‘switching user’ wherein
another user can log on
without you having to quit
your program(s).

Modifying visual 
settings 
If you have only 128 MB
RAM, your machine might
be a bit sluggish after
installing Windows XP. So
to achieve optimal perform-
ance without buying addi-
tional RAM, disable certain
visual settings and free up
some precious memory. Go
to the Control Panel, click

on the Advanced tab in Sys-
tem, and choose Settings
under the Performance
option. Change various
graphical effects. Uncheck
the animation and shadow
options as they tend to
consume a lot of memory.
You should get a better
response from your OS now

without spending any
money on RAM.

Enabling/dis-
abling Clear Type
text
Microsoft has introduced a
new technology called
‘Clear Type’ with Windows
XP. However, it is not
enabled by default. To
enable it, right-click on a
blank area of the Desktop
and choose Properties. Click
on the Appearance Tab and
click again on Effects. Check
the box ‘Use following
method to smooth edges of
screen fonts’ and in the
drop-down box select ‘Clear
Type’. 

Clearing Document list
The Start menu of Windows
XP has been completely
revamped and made
extremely customisable. If
you want the Start
menu to display
only the
applications
that you
want, right-
click in an
empty sec-
tion of
the Start
menu’s left column and
select Properties > Start menu >
Customise. Then go to the
General tab, click on Clear
List, and set the counter to
zero. Now no one can keep
track of the programs or

applications you’ve recently
used. 

The ‘Classic Look’
If you are not comfortable
with the new look of Win-
dows XP, you can easily
switch back to the old clas-
sic look of Windows. Right-
click the desktop, select

Properties, click the Themes
tab and choose Windows
Classic from the drop-down
list. The old Windows 2000
look is ready.

Grouping/ungrouping
taskbar items
Try opening more than
three windows of any pro-
gram, for instance Internet
Explorer, and you will see
them automatically
grouped together under a
single button. This happens

insight ■
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Boost performance by reducing
visual settings

INTERFACE AND PERFORMANCE

Start off your XP experience with tips on enhancing its looks and performance

Invoking
Windows

classic look



MARCH 2002111

19

because Windows XP, by
default, enables the option
for grouping similar pro-
grams on the taskbar. To
uncheck this option, right-
click on a blank area of the
Taskbar and select Proper-
ties. Under Properties, dese-
lect ‘Group Similar Taskbar
Buttons’, and then click OK. 

If you want to specify the
number of windows before
Window XP groups the pro-
gram windows, you will have
to navigate to the registry key
HKEY_CURRENT_USER\Soft-
w a r e \ M i c r o s o f t \ W i n -
dows\CurrentVersion\Explo
r e r \ A d v a n c e d \ Ta s k b a r
Groupsize. Now right-click
on Taskbar Groupsize and
change the hexadecimal
value to whatever you like
(for example, 4 or 5 or even
10). XP will now group the
programs according to the
number you set. 

Hiding inactive icons
After installing Windows XP,
if you log on to the Internet

and surf for a while,
you’ll find that your
Internet icon has dis-
appeared. This is not
an indication that you
have been disconnect-
ed; it merely means
the icon is hidden
since it’s been lying
idle in the System
tray. If you so wish,
you can disable this
option by right-click-
ing on the Taskbar,
choosing Properties,
and disabling the
‘Hide Inactive Icons’

option. You can specify the
ones you would not like to
be hidden.

Disabling Automatic
Windows Update and Sys-
tem Restore 
There are certain services
such as Windows Update
and System Restore, which
are automatically loaded and
occupy a lot of space. If you
would like to disable them,
right-click on My Computer
and choose Properties. Click
on the System Restore tab

and check the box
‘Turn off System
Restore’. This will
increase Windows per-
formance and save disk
space. 

Similarly, locate the
‘Automatic Update’
option just next to
‘System Restore’. This
option will periodically
ask you to update the
OS. You can go ahead
and disable this, but
remember that you will
have to update Win-
dows manually after
applying this option since
there will be no reminders.

Change the picture on
the welcome screen
Want to add your own pic-
ture in the Startup menu?
Well, who wouldn’t? Here is
how you go about doing it.
Go to Start > Control Panel
User account > Administrator.
There you will see an option
to change the picture on the
welcome screen. On clicking
it, you will see an option
from which you can select
the picture already present
or you can browse to the
folder where you’ve saved
your photograph.

Creating personal
screensavers  
You can use your photo-
graphs for creating slide
show presentations or even
creating a screensaver. Right-
click an empty spot on your
desktop, choose Properties,
and click the Screensaver tab.
In the Screensaver list, click

on ‘My Pictures Slideshow’,
and click ‘Settings’ to make
any adjustments such as how
often the pictures should
change, their size and
whether you would like to
use transition effects
between pictures. Click OK
to finish. The screensaver
that will now be generated
will display photographs
from the My Pictures
folder in a random manner.

Windows XP makes things
easier by allowing you to
view all images in one go.
But in order to do that you
will have to go to the folder
where the images are stored
and then go to View >
Filmstrip. The images will be
neatly arranged in a straight
line just like a filmstrip thus
letting you preview each one
of them.  

View Images
as Filmstrip

Ungrouping the taskbar items

Disable the System Restore feature

Use images to create your own personal
screensaver
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Tweak XP
This tweak utility allows
you to not only tweak Win-
dows XP but also your sys-
tem settings. You can
optimise your system by

freeing RAM, applying
tweaks to your CPU, tweak-
ing your Internet settings
by blocking advertise-
ments, shredding files,
allowing certain programs
to be used by certain users
only, and so on. With this
software you can make
your Windows taskbar
transparent by going to Sys-
tem + Files Tweaks >Make the
taskbar transparent. 

Power Toys
This program bundles a set
of small programs such as
Tweak UI, Image Resizer,
Super Fast User Switcher,
Power Calculator, etc
which let you perform
functions such as switch
users without having to go

to the logon screen, create
graphs and evaluate func-
tions, among others. 

Customiser XP
Customiser XP is a special

utility designed
to optimise the
performance of
Windows 2000
and XP. Using a
graphical user
interface, it
allows you to
modify many
hidden Windows
registry settings
by simply click-
ing the provided
checkboxes. Cus-
tomiser XP helps

you improve your Internet
connection as it sets all
recommended settings for
you at the click of a speci-

fied button. It also offers a
wide range of possibilities
to customise your Win-
dows program, such as
choosing a background of

your choice at
pre-logon and
automatically
restarting Win-
dows Explorer
when it crashes
while you’re
working to avoid
losing your work.

Styles XP
Windows XP has
a limited set of
themes. In order
to add more themes
you can use Styles XP
which provides a good vari-
ety of colours and themes.
In order to change the vari-
ous themes supported by
this program, right-click on
your desktop and go to
Properties > Themes, and
select a theme of your
choice. You can change the

colours from
the Appearance
tab, which is
right next to the
Themes tab. 

Windows
Blind
Want to give
your OS a Mac
look? You can
do so through

the Windows
Blind program.

All you need to do is install
the program and navigate
to the themes. You will
find the option for loading
a Macintosh theme. If your

machine does not have
enough memory, put it on
enhanced mode or opt for
‘High performance’ if you
have a powerful machine. 

Desktop X
This program lets you
build your own customised
desktop. As is the case with
all third-party software
which let you change the
style, this one lets you load
a particular style as well,
except that here you can
also edit the style, change
the buttons, make particu-
lar themes for particular
programs, and more.
Right-click on the desktop,
go to Properties > Appear-
ance, and click on the Win-
dows Blind button. This
will let you modify the set-
tings. In case you don’t
want to use any of the
styles but want to keep the
program, then just unload
Windows Blind. 

THIRD-PARTY TWEAK UTILITIES

Make your taskbar look transparent with Tweak XP

Set a Mac theme for Windows with Windows Blind

Here are third-party tweak utilities that allow you to further enhance the performance of Windows XP

Automatically restart Windows using Customiser
XP in case of a crash
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Group Policy Editor
Microsoft bundles a nifty
utility (only in the 

Professional Edi-
tion) which allows you
to change almost every set-
ting of the OS without hav-
ing to manually edit the
registry. In order to access
the program go to Start >
Run and type gpedit.msc.
Now you can navigate and
change the options as you
wish. We have some exam-
ples here, but you can also
try changing other settings.

Disabling MSN Messen-
ger from starting auto-
matically 
Navigate to User configuration
> Administrative Templates >
Windows Components > Win-
dows Messenger. On the right-

hand side, you will find
options to change the set-
tings for this program. Click

on ‘Do not automatically
start windows messenger
initially’ and enable this rule
to prevent starting MSN
Messenger when you start
Windows. This would lessen
your boot up time and also
save memory.

Disabling 
Windows update
If you wish to
remove the Windows update
option, go to User Configura-
tion > Administrative Templates >
Windows Components > Windows
Update. You can completely
remove this option by
enabling ‘Remove access to

all update features’. Windows
will not prompt you to
update now and you cannot
update manually from the
Web site either.

Removing unnecessary
options from Task Manager
If you want to remove some
options from the Task Manag-
er, navigate to User configura-
tion > Administrative Templates >
Windows Components > System >
Ctrl+Alt+Del option. In the
right-hand pane disable any
option that says ‘Remove
logoff’ by checking it. 

Customising IE 
interface
Tired of the same old IE inter-
face? Customise by going to
User configuration > Internet
Explorer Maintenance > Browser
User Interface. Change the
browser title name and man-
ually add the name you want
to see on the browser. You
can even add a customised
animated logo and change
the background of the tool-
bar by going to ‘Browser tool-
bar customisation’.

Disable list of startup
programs
Want to disable the list of
startup programs? Go to User
Configuration > Administrative
Templates > System > Logon
and enable ‘Do not process
the run once list’. This pre-
vents programs from start-

ing up automatically, thus
giving you a faster boot 
up time.

Removing inactive
icons from system tray 
XP hides inactive icons in
the system tray by default.
In order to remove this facil-
ity completely, you will
have to navigate to User con-
figuration > Administrative tem-
plates > Start menu and
Taskbar. On the right-hand
side, scroll down to ‘Turn off
notification area clean up’.
Now your icons cannot be
hidden at all.  

BOOSTING PERFORMANCE
It’s easy to tweak the performance of Windows XP further. All you need to do is 

follow these instructions
XP provides a software for

burning. But if you don’t have
a CD-Writer, disable it by going
to User configuration
>Administrative Templates >
Windows Components >
Windows Explorer. Enable the
‘Remove CD burning features’
option.

Remove Burn 

You can create, delete or
rename your partitions in
Windows XP. Go to Control
Panel > Performance and
Maintenance > Administrative
Tools > Computer
Management. You will now be
able to access the Disk
Management program. Right-
click on the hard disk partition
and rename or delete it.

Disk 
Management

The Group Policy Editor allows tun-
ing XP for perfection
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Turn the firewall on
Microsoft has included a
firewall in Windows XP to

keep you safe from hackers
while on the Net. It’s quite
easy to enable the firewall.

Just click on the
dialup icon, which
you must have cre-
ated to dial to your
ISP, and go to Proper-
ties > Advanced. Now
check the box
‘Internet Connec-
tion Firewall’ and
you are done.

Sharing Internet 
connection 
If you are connected to a
network and want to
enable Internet connection
sharing, it’s easy with Win-
dows XP. Simply go to Con-
trol Panel > Network
Connections and click on ‘Set
up or change your home or
small office Internet con-
nection’. A wizard will
guide you through the
process of creating a con-
nection. 

If you want this connec-
tion to dial automatically
when another computer on
your home or small office
network attempts to access

external resources, check
the ‘Establish a dial-up con-
nection whenever a com-
puter on my network
attempts to access the
Internet’ check box. 

If you want other net-
work users to enable or dis-
able the shared Internet
connection, select the
‘Allow other network users
to control or disable the
shared Internet connec-
tion’ check box. 

The Services program lets you manual-
ly stop or start various services XP
offers. If you’re a home user not con-
nected to the Internet through a LAN,
disable some of the Net-related services
which occupy memory, slow down
boot up time, and are probably of no
use to you. Go to Control Panel > Perfor-
mance and Maintenance > Administrative
Tools > Services. You should make the
following services manual (do not dis-
able any service) to free up some of
your RAM.
First Time User
■ Automatic updates  
■ Computer browser
■ Remote registry
■ Windows media time
■ Task scheduler 
■ System event notification
■ Indexing service

Advanced User
■ Automatic updates  
■ Computer browser
■ Remote registry
■ Windows media time
■ Task scheduler 
■ System event 

notification
■ Indexing service
■ Error reporting 

service
■ Printer spooler (if you

have not installed a
printer)

■ System restore service
■ Portable media player
■ Windows image 

acquisition
■ Wireless zero 

configuration
■ Upload manager

Services you can use

The Internet Connection
Firewall gives protection
when you are online

NETWORKING AND INTERNET

Here’s how you can get the surfboard up to gear and ride the waves 



MARCH 2002115

23

Controlling cookies
Whenever you visit a Web
site, it sends a cookie in
return, which is placed on
your hard disk. Through
the cookie, the site may
misuse and steal informa-
tion from your computer.
To prevent this, Internet
Explorer 6 comes with an
option for blocking these
cookies. In order to change
this option to suit your
requirements, right-click
on Internet Explorer, go to

Properties, and click on
the Privacy tab. Here you
can select the option you
want. For instance, in
order to ensure maximum
privacy, you can keep it on
‘High’—all the cookies that
contain your personal
information and are sent
to third-party Web sites
without your consent are
now blocked.

Increasing connection
speed
Some of us may
find that after
installing Win-
dows XP, the Internet
connection gets slower. A
possible reason for this is
the QoS (Quality of Service)
installed. This service
reserves 20 per cent of the
bandwidth for itself, even
with QoS disabled. In order
to remove this reserved
quota, you will have to

make sure you are logged
on as Administrator. Go to
Start > Run and type gped-
it.msc. Expand the ‘local
computer policy’ branch,
the ‘administrative tem-
plates’ branch, and the
‘network’ branch. Highlight
the ‘QoS Packet Scheduler’
in the left window and in
the right window double-
click the ‘limit reservable
bandwidth’ setting. Then,
on the Setting tab, check
the ‘enabled’ item and
change the ‘Bandwidth
limit %’ to read 0. After
doing this, you should
immediately notice a boost
in your Internet connec-
tion speed. 

Speeding up network
browsing
A bug in Windows 2000
would cause the scheduled
tasks folder to be searched
whenever the user browses

network drives. While
Microsoft has developed a
fix for this bug, the fix
slows down the browsing
of Microsoft networks. In
order to fix this problem,
go to Start > Run and type
in regedit. Navigate to
HKEY_LOCAL_MACHINE/
Software/Microsoft/Win-
dows/Current Version/
Explorer/RemoteComput-
er/NameSpace. Then find a
key named {D6277990-
4C6A-11CF-8D87-
00AA0060F5BF}.
Right-click on it and delete
it. Restart the computer
and now you will be able
to browse the network a
lot faster.

Bridging connections
If you’d like to connect
two or more computers via
LAN, then you should
utilise the Network Bridge
option provided in Win-
dows XP. There is no con-
figuration required and
you do not need to pur-
chase additional hardware
such as routers or bridges.
IP addressing, address allo-
cation, and name resolu-
tion is highly simplified in
a single subnet IP network.
To use this feature you 
will have to open 
Network Connections.
Under LAN or High-Speed
Internet, select each of the
private network connec-
tions that you want to be
part of the bridge. Right-
click one of the highlight-
ed private network
connections and click
Bridge Connections. 

■ Check the Internet for
updates or fixes: Check the Web
site of the program’s manufactur-
er to see if an update or patch is
available. Refer to the Microsoft
Windows Update Web site to 
see if a fix is available for the 
program. 
■ Use an Administrator
Account to install the pro-
gram: Many programs must be
installed by using an administra-
tor account. This is because
many programs were written for
use with Windows 95, Windows
98, Windows 98 Second Edition,
or Windows Millennium Edition

(Me). These operating systems
did not have an administrator or
limited user account. 
■ Log off all users except the
account that will install the
program: The Fast User
Switching feature is new to
Windows XP and because of
this, most older programs were
not designed to support this
feature. If you have multiple
users logged on to the comput-
er, log everyone off except the
account that will install the 
program.
■ Use the Program
Compatibility Wizard: You can

use the Program Compatibility
Wizard to test your program in
different modes (environments)
and with various settings. For
example, if the program was
originally designed to run on
Windows 95, set the compati-
bility mode to Windows 95 and
try running your program
again. If successful, the pro-
gram will start in that mode
each time. The wizard also
prompts you to try different
settings, such as switching the
display to 256 colours and the
screen resolution to 640 by 480
pixels.

Troubleshooting Program Incompatibility

Get professional help
with XP. Go to Start >
Help and click the
Support button. It will
give you access to help
straight from Microsoft,
provided you are con-
nected to the Net.

Direct Help
from Microsoft
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Removing MSN Mes-
senger 

How do you remove
MSN Messenger in Windows
XP? Not from the
Add/Remove program list
but by locating SYSOC.INF
in the \Windows\INF fold-
er (hidden file and folder).
Open it in Notepad and
locate the line: msmsgs=
msgrocm.dll,OcEntry,msms-

gs.inf,hide,7
Remove the word

‘hide’ from the line
and save the file. After

making the necessary
changes, you’ll be able to see
MSN Messenger in the
Add/Remove Windows com-
ponents list. You can then
remove it for good.

Disabling error
reporting
Like Windows 2000,
even Windows XP provides
a report of errors that are
generated during a session.
For most home users this
service might be practically
useless. In order to disable
it, right-click on the My

Computer icon, go to Prop-
erties, and click on the
Advanced tab. At the bot-
tom of this tab, you will
find an ‘Error reporting’
option. Click it and you
will get an option to enable
or disable it. Click Disable
and you are done.

Using onscreen key-
board
An onscreen keyboard is in-
built in Windows XP. It can
be useful if you have mobili-
ty impairments, especially if
you are using a tablet PC or
if your keyboard goes on the
blink. To access the key-
board, go to Start, click on
Run, and type osk. Alternate-
ly you can go to Start > Run >
Programs > Accessories > Accessi-
bility > Onscreen keyboard. The
keyboard opens up on your
computer screen, featuring
three typing modes you can
use to type data:
Clicking mode: you click
the on–screen keys.
Scanning mode: you press
a hot key or use a switch-
input device to type high-
lighted characters. 
Hovering mode: you use a
mouse or joystick to point to
a key, which is then typed. 

Renaming multiple
batch files
In Windows XP, you can
easily rename multiple files
at a single go and save a lot
of time. Click Start and click
My Pictures or the folder

where you have saved the
pictures. Switch the view
from the default Filmstrip to
Thumbnails by clicking the
Views button on the tool-
bar. Select all the pictures
you want to rename by
highlighting the last picture
you want, then press and
hold down the [Shift] key
until you include all the pic-
tures that have to be
renamed, ending with the
first picture in the list.
Right-click the first picture,
and then click Rename.
Rename the first picture,
and then click in the white
space next to one of the pic-
tures. The pictures are
renamed all at once! 

Creating boot-up disk 
In order to create a bootable
floppy disk in XP, insert a
floppy and go to the floppy

icon in My Computer. There
you will have to right-click
the floppy drive icon and
click on the Format option.
You will see the option ‘Cre-
ate MS-DOS Start up Disk’.
After creating the boot up
disk, you will be able to boot
into Windows XP using this
disk.
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Remote Desktop in Windows XP Professional gives you access to a
Windows session running on your PC while you are at another com-
puter. This means, for example, that you can connect to your office
computer from home and have access to all your applications, files
and network resources. You can view the desktop and programs
running on your office PC on your home computer. When you con-
nect to your computer at work, Remote Desktop automatically locks
it so no one else can access your applications
and files while you are gone. You can later
unlock your office PC by pressing [Ctrl] +
[Alt] + [Del]. To access this service, go to
Start > Programs > Accessories >
Communications > Remote Desktop
Connection.

Remote Desktop Connection

Get rid of irritating error reporting

Create a boot-up disk

MISCELLANEOUS
Some last minute tips on other XP nitty-gritties
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PC gaming is back with a bang and guarantees to make this year one big head rush

W
ithout a doubt, gaming consoles dominated
2001. With the Xbox, Gamecube and the
PlayStation 2 garnering most of the atten-
tion, PC gaming took a back seat. While titles
such as Return to Castle Wolfenstein, Com-

mandos II and Max Payne made some noise, for the most part
2001 was a pretty quiet year for PC gamers. Older heroes such
as Counter-Strike, Red Alert II and Quake III continued with their
domination of gaming. 

With the hype around the game boxes finally behind us, the
spotlight is shifting back to the PC platform. As online gaming
continues to gain popularity worldwide, we can expect most of
the games to include single and multiplayer action. Medal of

Honor: Allied Assault made the first draw by coming out in Jan-
uary. Get ready for 2002: the year is chock-full of gaming action.

AGE OF WONDERS II
Fans of real-time strategy games are in for a real treat. Age of
Wonders II (AoW II) packs in even more role-playing compo-
nents than the previous version. Not only does the title feature
totally revamped graphics that boast some radical visuals, it also
adds a random map generator and enhanced audio that go a
long way in enticing you to play the game over and over again.

AoW II’s terrain is incredibly detailed and certain elements
such as new and tougher character races have been added to
make gameplay more challenging. But the most impressive trait
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of this sequel is the map editor which gives you the same tools
as developers to create the maps and stories that unfold within
them. If you’re a fan of myth, magic or plain old tactical com-
bat, AoW II will definitely have something for you to chew on.
Genre: Real-time Strategy
Developer: Microsoft
Estimated release date: Second quarter of 2002

COUNTER-STRIKE: CONDITION ZERO
After dominating multiplayer gaming for the last couple of
years, Counter-Strike advances to the desktop—reason enough to
cheer for anyone deprived of the thrills of counter-terrorist
action against bots and human adversaries. 

A robust single-player campaign, improved Half-Life graph-
ics engine, superb AI programming and a slew of new weapons
make Counter-Strike: Condition Zero truly worth the wait. You
start as a lowly foot soldier fighting your way through military
jungle camps and moving up in the ranks as you bag more and
more successful missions.

Just to make life interesting, the game lacks a ‘save game’ fea-
ture, which will make completing each level a real challenge.

Keep your sniper ready for this one.
Genre: Tactical Action FPS

Developer: Gearbox Software
Estimated release date: Third quarter of 2002

DOOM III
Revisit the sinister and scary, dark and shadowy world
that Doom unleashed on PCs back in 1995. The
single most anticipated game in the foreseeable
future comes from the demigods of game devel-
opment—id Software. New game code builds on
the strengths of the OpenGL-based Quake III engine
and will bring the current generation of gaming hardware (yes,
even the GeForce3!) to its knees. Legend has it that the game is
being built on prototype graphics hardware running on mas-
sive server farms just to emulate the new game engine.

Expect lifelike characters that have never been seen before,
as well as gripping single-player missions that have been notice-
ably absent from the recent id titles.

Cross your fingers and hope that Doom III is out by the end
of 2002.
Genre: FPS/Action
Developer: id Software
Estimated release date: End 2002

DUKE NUKEM FOREVER
3D Realms hopes to bring the original mean-
mouth of PC gaming back to life. Last seen in
action during the third chapter of the Duke series
about six years ago, Duke will take on an old foe in Dr
Proton, a cyborg who made an appearance in the first Duke
Nukem title. 

Wondering when it’s expected? The official stand on an
expected release date has been the same for the last couple of
years, during which it moved from using a Quake II engine to a
more advanced Unreal-based graphics engine.

While many feel that the game is vaporware, having already
taken ‘forever’ to make an appearance, Duke, who is one of the
original icons of action gaming, never seems to go out of fash-
ion. Duke is forever!
Genre: FPS/Action
Developer: 3D Realms
Estimated release date: Whenever it’s ready

GRAND THEFT AUTO III
Driving, adventure and a heavy dose of violence and gore come
together, perfectly balanced for your hidden, menacing side.

With its unique perspective, Grand Theft Auto III (GTA III) puts
you right in the middle of harm’s way while you peddle drugs
and kidnap your way to mo’ money. The blatantly offensive title
has taken a huge step by offering a fully 3D street experience to
become one of the best action games yet to arrive for the PC
platform. Another first-time highlight in this ‘three-quel’ is a
fast-paced story line with the twists and turns you’d expect from
a Pacino flick. The game is expansive; you can spend hundreds
of hours roaming the streets and not know where time went.
With GTA III, you don’t have to worry about wetting your pants
after getting busted for a hit!
Genre: Arcade/Racing
Developer: Rockstar
Estimated release date: September 2002

HALO
Released on the Xbox last year, Halo will cross over to the PC in
2002. This action-adventure title allows players to switch
between first-person and third-person perspectives.

You play the part of a cybernetically enhanced commando
who is trying to protect the earth from a rampaging alien race
called the Covenant. A sci-fi shooter that takes place on a mys-
terious alien ring-world, Halo will have you battling through
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amazing indoor and outdoor environments, in vehicles, and on
foot with the largest arsenal of futuristic weapons, vehicles, and
combat roles of any shooter ever.
Genre: FPS/Action
Developer: Bungie
Estimated release date: Mid-2002

MEDAL OF HONOR: ALLIED ASSAULT
World War II games seem to be the latest fad in shooters, but
no other game stands taller in the quest for best FPS of 2002
than Medal of Honor: Allied Assault. The game goes beyond the
run-and-gun theme with an assortment of missions to carry
out. The environment is totally immersive and facets of war are
highlighted beautifully. There are soldiers everywhere—shout-
ing, giving orders, running for their lives, and fighting. 
So while you go on sniper hunts, driving tanks and setting up
beach heads just like Private Ryan once did, you’ll be happy 
to know that this is just the tip of the iceberg—the fun 
lies inside.
Genre: Tactical Action
Developer: Electronic Arts
Release date: January 2002

SOLDIER OF FORTUNE II: DOUBLE HELIX
Double Helix is the sequel to the grossly violent FPS hit of the
year 2000. You play the part of John Mullins and embark on an
intercontinental mission to fight against an organisation of bio-
terrorists who plan to unleash a deadly virus on the world’s
populace.

This anti-terrorist thriller uses the Quake III: Team Arena
engine. It will offer wannabe warriors with an expanded arsenal
and perhaps even a beefed up multiplayer experience. A random
scenario generator which lets players create random single-play-
er missions and superior enemy AI will make playing Soldier of
Fortune II an even greater challenge when it hits the shelves some-
time in April 2002.
Genre: FPS/Action
Developer: Raven  
Estimated release date: April 2002

UNREAL II
One of the most anticipated titles of this year
comes from Epic Games and is the latest reincar-
nation of the Unreal series which is expected in
March 2002. The Unreal II graphics engine is based on the Direct

3D API and incorporates higher polygon counts and greater
detail. 

In the elaborate single-player missions, you find yourself
caught in the middle of a full-scale interstellar war in a fictional
universe. You have to fight your way through to discover the
source of conflict and bring peace to the universe.

In addition to the gripping single-player missions, gamers
expect Unreal II to include the gripping multiplayer component
that made Unreal Tournament a smash hit.
Genre: FPS/Action
Developer: Epic Games
Estimated release date: March 2002

WARCRAFT III
In a poll at Voodooextreme.com, Blizzard ranked as the most
respected game development outfit among gamers. For anyone
who’s been impressed by Blizzard’s line up of games, there’s
bound to be profound anticipation when WarCraft III comes
out. Remember, these guys made Diablo. 

It’s humans versus creatures, magic mixed with metal, in
the third installment of the WarCraft franchise. The success
behind this series is a perfect blend of real-time strategy with

role-playing elements for plenty of zest. In Warcraft III, the
game has departed from its 2D platform and entered a full-
fledged 3D environment overflowing with smooth and crisp
animation. 

Generating characters that garner new abilities along with
experience and know-how to use them is the key strategy in War-
Craft III. 
Genre: Real-time Strategy
Developer: Blizzard
Estimated release date: March 2002

This year’s harvest is by far the most bountiful as far as the
gaming world is concerned. From action to strategy, role-play-
ing to racing—each genre of gaming has evolved many steps
further. Not only are the graphics visibly superior than in the
earlier games, but the developers have also remembered well
the value that gameplay really holds, not to mention the fact
that God really does lie in the details.

Also, with the release of next-generation graphics cards from
nVidia and ATi, the time couldn’t be better for lower-end cards
such as the GeForce3 to shed prices for those lean on budgets.

So all of you who had to sit back and wait for a reason to
upgrade the GPU, it’s time for action! Dust that PC and fire up
the graphics card—the gaming drought is over.
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Diablo II improves upon Blizzard’s orig-
inal success formula with a multitude
of spells, items, weapons, and monsters
thrown in the mix. Control  one of five

diverse, new characters and nurture their skills to
their full potential. On the masculine side
are the magical, death-dealing Necro-
mancer, the ever-blessed Paladin, and
the abnormally strong Barbarian as some
of your picks. The feminine selection fea-
tures the nomadic warrior Amazon and the
lethal, yet sultry, Sorceress.

5 Diverse Characters to
tame the devil. Choose
your destiny! 

PALADIN 
The Paladin is a natural
party leader, holy man, and
blessed warrior. His offensive
and defensive auras affect
the entire party (within a
particular radius)—certainly
a bonus against the tougher
monsters you’ll face in mul-
tiplayer games. The key to
playing well with the Pal-
adin is to be quick with your
hot keys and use him in tan-
dem with other characters. 
Strength: 25, Dexterity: 20,
Vitality: 25, Energy: 15

SORCERESS 
The Sorceress and her plethora of elemental
spells fulfil the role of chief magic user. Per-
haps the most difficult class to use, particu-
larly early in the game, without access to
high amounts of mana and powerful spells.
The Sorceress requires patience and tremen-
dous amounts of mana. 
Strength: 10, Dexterity: 25, Vitality: 10,
Energy: 35

■ tactics

AMAZON
At ease with the spear, bow and javelin, the
Amazon specialises in long-range weapon-
ry. Invest in her skill tree, either with the
spear or bow, and watch her stomp out
monsters. Hit-and-run attacks work well
with the Amazon, while you are dishing it
out from long range.
Strength: 20, Dexterity: 25, Vitality: 20,
Energy: 15 

SRIRAM SHARMA

BARBARIAN 
The Barbarian is an ace at hand-to-
hand combat and boasts of a
multitude of skills including the
bash, double swing, leap
attack and whirlwind. Seek
out the best hand-to-hand
weapons, get the best armour and fight
toe-to-toe with Diablo II’s fiercest creatures.
Strength: 30, Dexterity: 20, Vitality: 25,
Energy: 10

NECROMANCER
The Necromancer doesn’t like to get his
hands dirty. He summons skeletons, skele-
ton magi, golems and other creatures in the
game. His curses can cause devastating
effects on monsters, while his poison and
bone spells carry some of the most offensive
and defensive powers. 
Strength: 15, Dexterity: 25, Vitality: 15,
Energy: 25

Single Player Tips

If your body is surrounded by hordes of
baddies, simply rush in and then rush
out. Some of them will follow you, allow-
ing you to pick them off one at a time. 
Don’t underestimate enemy AI in Diablo
II. Use smart tactics and hot keys, and
don’t just run in blind. Stick and move.
This may be one of the best tips for real-
time RPGs—always attack once, back
away, and attack again. This works for
incredibly hard bosses and for enemies

that have high-attack statistics. 
Use your items. You may die in combat
before ever even using them, so it’s
always better to use your items than to
conserve them.
Communicating with NPCs (non-player
characters) can be very helpful on quests.
NPCs usually divulge all kinds of informa-
tion needed for your quest that may help
you kill a boss or get a certain item with-
out getting killed.
Hack and Slash away! Before facing a
boss, make certain you are wearing the

largest belt you can find or purchase. This
will allow you to carry more healing
potions, and make certain you are fully
stocked. The potions are hot keyed, so
punch away. Also, the health that you
gain from the potion takes a second or
two to actually build up. So make sure
you punch early! 
Keep all your gold in your stash box and
a backup weapon with armour. So if you
die, you can simply grab the extra equip-
ment from the stash box and recover it
all in one go.
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To call Civilization III a game is like
looking at the ocean and saying that

the water is wet. There are strategy games,
and then there’s ‘the Civilization experi-
ence’. Crafted by Sid Meier, the creative
genius behind Civilization and Alpha Cen-
tauri, here’s a sequel that continues the
highly addictive journey through history. 

Civilization III is a game of epic propor-
tions where players can match their wits
against the greatest leaders of the world in
an all-out quest to build the ultimate
empire. Elements such as Culture, Nation-

ality and the Arts can help play-
ers plan a new peaceful pathway
to victory. The concepts of bor-
ders and a living map have
advanced significantly since
Alpha Centauri. Winning the
game is not dependent on mili-
tary power, but rather on culture.
A 3,000-year-old city with an
ancient coliseum, cathedral,
library and university will have a higher cul-
ture rating, whereas a new backwater vil-
lage with a small temple will barely register. 

You can lure people from other coun-
tries around you simply on the basis of the
strength of your culture. With enough 
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From the creators of the famous railway
simulation Railroad Tycoon II, comes

this game with a difference. Take a city
management game, give it a deep tan in
the Jamaican sun, add some rum and

calypso beats and you get Tropico. The goal
here is to rule a small tropical island. As
the ‘El Presidente’, you take control of the
working of your island and further its pros-
perity along with yours. 

Tropico doesn’t take itself too seriously.
At the start of the game you are given the

choice of which dictator you want to
play—Fidel Castro, Evita Peron, Pinochet,
and well, Lou Bega. Yes, Lou Bega of
Mambo No 5 fame. The tongue-in-cheek
humour makes the gameplay more absorb-

ing. You might hear one of the
citizens moan “Work, sleep,
eat, sunbathe, there must be
more to life”. 

You start off with a hand-
ful of islanders, and try and
build your economy and pro-
vide better amenities to your
citizens. Soon you change the
occupation of the people from
farming to those of exports,
distilleries, cigar factories and
so on. At the same time, you
have to meet the demands of
the people with entertain-

ment, education and health care. If you
don’t, there’s always another fascist dicta-
tor ready to take over. Playing Fidel Castro
teaches you a lot of lessons, and it is up to
you to use some of Machiavelli’s tactics 
to win. 

The graphics are nicely detailed and

well-animated, with the ability to zoom
right in on individual buildings and peo-
ple or pull back your view until you can
see the entire island below you. The game
uses the same graphics engine as Railroad
Tycoon II, which adapts itself to this game
quite well. 

The control system uses a fairly simple
interface, allowing you to place new build-
ings, set construction priorities, adjust
wages, fees and rents, fire people, issue
edicts and limit the number of workers in
a particular building. If you can overlook
the minor annoyances in the island’s econ-
omy and trade system, this game is a win-
ner. Tropico is a politico-economic simula-
tor and one of the best city building simu-
lations in recent years. For any of you who
have harboured secret ambitions of being
a dictator, this game can give you vicarious
pleasure.  
Developer: PopTop Software
Genre: Strategy/Management 
Contact: E-xpress Interactive, 022-887 0017
Web site: www.poptop.com/Tropico.htm
Price: Rs 699
Rating: ★★★★✩✩

CIVILIZATION III

Electrifying!

➜

TROPICO

You rule

Manage a city or build the ultimate empire. Plus book reviews to help you keep up to date 
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culture pushing your borders
outwards, they can swallow
neighboring cities, bringing
them under your flag. 

The game is turn-based,
which makes it slower and
more longwinded than the
new run of real time strategy
games. While a game such as
Command and Conquer allows

you to manage a whole bunch
of things at the same time, the
turn-based element will bog
you down with micro-man-
agement, especially during the
later stages of the game. The
gameplay though slow is chal-
lenging and compelling, like a
game of chess. 

The game ships with a

decent and weighty (200
pages) manual with a lot of
tips and tactics. The graphics
and artwork are top notch too.
Firaxis has decided not to go
with a multiplayer mode,
although it might be added in
later; this is a sore spot, in a
way, in this day and age.
Everything about this game

will endear itself to fans of the
turn-based genre.
Developer: Firaxis
Genre: Strategy/Management
Contact: Milestone Interactive
Phone: 022-8381614
Web site:
www.civilizationIII.com
Price: Rs 1,299
Rating: ★★★★★

Windows XP makes a gen-
uine attempt to bring

networking out of its realm of
confusion and onto the desks
of home users.
Though the
informed user
will celebrate
the improve-
ments in XP’s
ability, it’s the
home users at
large who
still find the
whole thing
arcane, rigid
and way
over their heads.

For those looking for a
clear and easy to understand
guide, this book is an excellent
purchase, only if you’re fresh
and new to computers. The
book rivets down the basics
starting with what a network
is and does, and leads you
through to the practice of sim-
ple network security. The book
hides the heaviness of its sub-
ject with its liberal use of

images and large type, and is
phrased in a way that is easy
to understand.

This Windows-centric
handbook makes a good acces-

sory for the 
software, giving
helping tips 
and advice to
consider. 

If you know
your way around
XP and know a lit-
tle something about
networking, you
might want to look
the other way. Begin-
ners though, can
think of it as a primer

designed to edify you in the
fundamentals of home net-
working.
Publisher: Prentice-Hall of India
Private Limited
Contact: Computer Book Shop
Phone: 022-2070989/2076556
E-mail: cbsbom@giasbm01.
vsnl.net.in
Price: Rs 395
Rating: ★★★

Simplifying Networking
2002. The first section of the
book deals with databases,
the second with interface cre-
ation and the third is about
building Web interactive
databases.

And if you’re the kind to
fret over computerese, this
book is a no jargon guide and
explains everything in simple
and easy-to-understand lan-
guage. Learn all about creat-
ing forms and reports in a
jiffy. This book is an all user

guide and applies to all levels
of readers. 

A good companion for
those of you looking to
embark on a database voyage!
Publisher: Prentice-Hall of India
Private Limited
Contact: Computer Book Shop
Phone: 022-2070989/2076556
E-mail: cbsbom@giasbm01.
vsnl.net.in
Price: Rs 225
Rating: ★★★

Although the title may
scare you off, this is a very

good book for
A+ certification
aspirants. It
manages to
address almost
all the objec-
tives that are
required for
the A+ Core
and OS
e x a m s .
Even if you
don’t want
to do an A+ certifica-
tion, this book is an excellent
guide for getting to know and
resolving your PC’s hardware
and software problems. All the
important steps have been
clearly explained in detail with
excellent photos and screen-
shots to ensure that you don’t
goof up. Distributed over 20
chapters, the book starts right
from the basics of computer
operations and moves on to

hardware, troubleshooting,
software problems, network-
ing and Internet fundamen-

tals, building a PC,
etc. It also
comes with a
CD that has
course prepara-
tion software sim-
ilar to the online
examination. Nuts
& Bolts 98 is a good
utility on the CD
that helps you prac-
tice what you’ve
learnt on the practi-
cal level. A+ certifica-

tion won’t be that much of a
problem with this book as a
starting point. 
Publisher: Thomson Learning
Contact: Computer BookShop
Phone: 022-2070989,
2076356
E-mail:cbsbom@giasbm01.
vsnl.net.in
Price: Rs 817.60
Rating: ★★★★

Get to know your PC

Are you looking for
a simplistic and

explanatory guide to
learn Access 2002?
Then this is just the
book to get hold of.
Kick start your learn-
ing exercise with con-
cise and lucid explana-
tions on how to create
databases using Access

Access as Simple as Possible
MICROSOFT ACCESS 2002 PLAIN & SIMPLE

STEP BY STEP HOME NETWORKING WITH WINDOWS XP

134 MARCH 2002

ENHANCED A+ GUIDE TO MAINTAINING YOUR PC
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How to score over
those who swear by
the searching
prowess of Google

March 2002

Everybody uses Google. Probably the
only search engine to have inspired
verbs like ‘googled’ (when you
scour the Net for stuff on that

handsome boy you once met) or ‘Google
whacking’ where you tempt Google with
unique entries that return only one result.
But your quest for knowledge need not be
limited only to the pages indexed by
Google. Other search engines have tiptoed
into the search domain and have, at some
point, even been touted as Google-killers. 

www.vivisimo.com 
Vivisimo (Spanish for very lively, clever), is a
search service with a unique ability of index-
ing and clustering your search results. Vivisi-
mo prevents you from link overloads and
takes you directly to the information you
need. Type a query, the software calls other
search engines (most major ones, a few gov-
ernment sites, and many corporate, news
and university sites), extracts relevant infor-
mation (titles, URLs, and short descriptions)
and groups the results. Which means you do
not have to go through each and every result
thrown up by the search to find the one that
fits the context you are keen on. Also, the
results that would otherwise be buried deep

come into easy view. Another plus is the
‘open in new window’ button which is

a great tedium-reducer, one-right-
click-less option.

www.wisenut.com
Type a question in the query
box of WiseNut and the
answer pops up in the
headline or description of
documents, so if you do
not need more informa-
tion, there is no need to
click any of the results.
For those who want to
delve deeper, WiseNut

organises results into neat
folders, and even offers you

a sneak-a-peak view, in
which the home page of the

results shows up within a win-
dow within the search results
window itself. You can move on if

the page does not match your
interest. WiseNut claims to

index 50 million Web doc-
uments a day. You can

keep track of its
progress by look-

ing at the top
left corner of

the home

page—it read ‘1,571,413,207 Web pages and
counting’ the last time we stopped by.

www.teoma.com
Teoma, derived from the Gaelic word for
expert, takes Google’s searching strategy to a
higher rung—it ranks your search results
based on topical directories created by
experts, which translates to more usable
searches from a user perspective. The results
to any query will not only get you Web
pages neatly classified into folders and a
ranked list of Web pages (the way Google
does) but also recommended 10 ‘expert
links’ specially created or favoured by the
enthusiasts on the subject. 

The same sparse look of Google shows
up in Teoma. Its home page loads quickly,
the results are delivered quickly. The main
limitation, however, is that the index is rel-
atively small at about 100 million pages
(Google is close to 1.5 billion). Also, Teoma
is currently in public Beta release. It is possi-
ble that the current site may not be the
incarnation that survives. 

www.ilor.com
iLOR, which calls itself a research engine,
combines the power and relevancy of
Google’s results with some nifty features that
searchers are bound to love. Hover the mouse
over the listings and ‘LORlinks’ show up. The
‘Put In My List’ option adds the listings to a
new browser window allowing you to pick
out the listings that interest you to build a
custom list. The ‘Go Now’ option ‘anchors’
you to the original search results; use the
anchor window to get back instantly to the
original search results. Click on ‘Open In Task
Bar’ option and iLOR opens the listing in a
new window, but immediately minimises the
window, so you can still see the original
results list. 

www.surfwax.com
Surfwax searches 14 leading search services,
including Northern Light, and handles syn-
tax reasonably well. But what makes it use-
worthy is its unique display of results (just
titles), summaries of some pages (SiteSnap),
and focus words to aid in refining the search.
This meta search engine analyses both the
search statement to create FocusWords—the
lists of words that pick out the main topics
and concepts and then displays results,
offers a definition and sets of broader and
narrower words for each. Another amazing
feature is SiteSnaps—you click on the lens
icon in the results page and on the right half
of the page, you get to see a ‘snap’ of the
result page.
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www.abcdv.com
Dedicated to the DV filmmaking
community. Includes news,
updates, shooting and equip-
ment reviews.
www.adobe.com/motion/main.h
tml 
An information warehouse full of
case studies, demo software,
and tutorials for the initiated
and uninitiated. 
www.dv.com
A brilliant forum for creative
professionals to learn new visual
communication techniques. 

www.creative-
cow.net
A relatively
new forum for
professional
ideas and tech-
niques with a
close-knit com-
munity where
bonhomie cuts
across profes-
sionals and
geographical
boundaries. 
www.belief.com
Renowned Santa Monica-based
design house with their work
mantra as “Immerse in sensory
culture.” The videos are worth
checking out.
Also Mentionable
www.methodstudios.com:
Design studio (videos)
www.wwug.com/forums/index.h
tm: Discussion forum
www.spon.com: Spontaneous

combustion (Design house)
www.2-pop.com: Resource
forum (like abcdv)
www.videography.com: Maga-
zine home page
www.365post.com: Resource
forum
www.epanorama.net/links/video
.html: Descriptive encyclopaedia
of video technology

Acquiring knowledge is still
a passion. But now you’re
reluctant to spend your
own hard earned money!
Never fear though, for you
can find a vast repository of
information on the Net.
Provided you own a PC or
have access to one at a
nearby cybercafe, you can
now feed your grey cells by
simply logging on to sites
such as www.howstuff-
works.com!

Bimal Unnikrishan is the
video guy—the director,
filmmaker and digital
artist—all rolled into
one; the man who does
all of Jasubhai Digital
Media’s shoots, ad
films, animation, you
name it. This time, with
some prodding, he
divulges his favourite
picks from the Web on

TECHWAY

If there's one thing we’d agree
on, then it would be the fact
that we’re pathetically short of 
bandwidth in India, right? 
Wrong! 

Nasscom has a totally 
different viewpoint. It says India
is swimming in an excess pool
of bandwidth, that the country 
has a whole of 1.2 GBps of

bandwidth and is not using it in
the first place! Well, is it a sur-
prise that with the cost of
setting up an infrastructure and 
leased lines the country’s 
bandwidth lies under-utilised?
Perhaps the  surprising part is
that this still doesn’t stop us 
from crying hoarse about our 
bandwidth requirements, right?

N
E

TF
A

C
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Think back to your
school days—acquiring
knowledge on all and
sundry was a passion. But
in order to fulfill this
desire your most viable
option was spending
your parents’ hard earned
money on expensive
books such as the entire
Encyclopaedia Britannica
series so you could get an
insight on how a grenade
works!

Gaining an education
OLD WAY

Team’s Top Picks

Bandwidth-hungry kya?

Dv.com offers a forum for pros

Stay up-to-date with abcdv.com
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Give a Digster surprise assignments, housekeeping missions involving tagging and organising the huge
stock of magazines and three stories to finish in a week…but waning bandwidth is a little too much!

Ban(ne)dwidth

Access to the Internet for a Digster
is tantamount to a continuous
supply of oxygen. Writers often
carry out vast amounts of research

on the Internet before conducting inter-
views and trying out products for their
stories and lack of bandwidth or even low
bandwidth can seriously throw a spanner
in the works. 

Digsters who pride themselves at
being the first ones to download the lat-
est software every time found their style
somewhat cramped this month as even
browsing turned into a difficult proposi-
tion when our T1 lines went on the blink.
It was worse for our Multimedia team
who found themselves working on dial-
up lines for the CD content of the March
2002 Digit issue. Add to that the fact that
one of our cover stories required down-
loading and trying out several freeware
before we shortlisted 30 of the best, and
you’ll see how much it hurt.

Our hardworking warriors were of

course up to the challenge of making do
with less. Time management acquired a
new meaning with people coming in at
all odd hours to catch, nay trap band-
width when fewer people were likely to
be online. Every little trick in the trade
was tried in order to get work done and
not let schedules slip, punctuated ever so
often with roars of frustration and
uproars of anguish at the floundering Net
connection.

Frayed nerves soon gave way to jokes
as the folks at Digit refused to let the sit-
uation get the better of them. We over-
heard a writer telling another on a par-
ticularly slow day, “Let the page load and
go home. It’ll be complete by tomorrow
afternoon.” Nor was the entrepreneurial
spirit lacking. We found this little note
placed on a PC saying, “Put cash on table
before you check mail or browse”. 

Meanwhile, our IT team got working
on the problem. A new proxy server was
set up and provided some respite in the

interim. Well, now that things are
back to normal, all those who live

by the motto, “will work 
for bandwidth” are

happy again.
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There’s a strange trend going on at
Digit. Now we’re not really super-
stitious, but of late our cover sto-

ries seem to be plaguing us in real life!
When working on our January issue we
had to ‘virus proof’ ourselves against a
common cold virus that took a cue
from our cover story and sought out
the chinks in our armour. 

Well, this month the jinx continued.
If you're reading this bit then you know
that one of our cover stories is ‘The PC
Troubleshooting Guide’ by our Test
Centre. Any story that involves the Test
Centre doesn’t see the light of day
unless it’s been thoroughly scrutinised.
So what better way to serve up a com-
prehensive troubleshooting guide than
to actually get your hands dirty fixing
problems with your own PC? The only
thing wrong here was that this wasn't
included in the initial storyboard! 

The first unlucky Digster was Hatim,
who had to deal with successive
processor malfunctions. The next to fall
prey was one of our most heavily relied
on designers, Shiva, who just couldn’t
keep his QuarkXPress from acting up.
But not one to be easily frazzled, he
confronted the problem by simply
yelling out a warning, “Restarting!”, to
all those connected to his PC.  

The jinx next struck the Multimedia
team when Aichin's hard disk crashed.
She is the lady who does the program-
ming for the Digit Interactive CDs and
her PC is where all the content is
stored. The timing couldn't have been
worse—just one day before the
Mindware CD was to be sent for repli-
cation. Back-ups are a wonderful thing
and came in handy. And the entire
Multimedia team pitched in to redo all
the lost work in one day, without miss-
ing a beat.

Well, as the saying goes, ‘no rest for
the wicked’. But here’s a fun thought—
maybe we should do a story on ‘If per-
sonal robots were freeware’!

Awww Hex!

ILLUSTRATION: Mahes Benkar
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Highlight the lighter side of 
computing. Mail your contri-
butions to  Backbyte
Digit, Plot D-222/2, 
TTC Industrial Area, MIDC, 
Shirvane, Nerul, 
Navi Mumbai 400 706
or send e-mail to
backbyte@jasubhai.com

Your chance to
bite back!

A computer virus as easy as sin
Is gotten fast, as cheap as gin
It drains time, wracks your nerves
It will make you fall short on reserves 
In numbers uncountable, in size small
A virus has one treatment for all
“Badtimes” or “Badtrans”, a worm or a Trojan
It likes to wipe your files, maybe even forge ’em

It was just another ordinary day
Morning rituals—shave and check mail
Common habits of every modern male 
The air we breathe, the food we eat
The daily clicks—send and delete
Who’d guess that a day can be easily spoiled
By a quiet worm so silently coiled?

I did not expect for my system to fold
Apparently, Norton was little too old
Not only did the bug worm its way into my files
It reset my balance, my emotions, my lifestyle

Repairs are costly, support never helps
I pleaded, I cried, and I whelped

Pacing like a tiger around the dark room
Visualizing all around a descending doom

10 hours later I’m still on “Support”
They come on with “Thank you for being a sport
What can we do? You were so patient...
Virus? Sircam? Oh, but that’s so ancient!”

They finally found 12 files, is that better?
What you do next does not really matter,
You must reinstall, no questions asked
Yes, I know, it’s a Machiavellian task

“Oh, and by the way, for reinstallation
We won’t charge much, and you were so patient.
We respect and keep our clients sane
You see, they never complain.”

There’s never any reason, no matter who gets hit
Is there any sense in this Web, a virulent pit?
I woke up screaming from this nightmare
Hoping the Web be more than just viruses and
software
by Lena

Ode to a Virus

Confused by the bombastic names that nVidia and others insist on christening their
graphics crads with? An intrepid gamer takes a dig at nVidia and suggests a simple
method of arriving at future names. All you have to do is put together a combina-
tion using the formula, nVidia + A + B + C + D + E  to make your own killer card! 

Naming Force

ISP Muscle

A
Geforce 5
RDX
Napalm 
Nitroglycerine
Gixpix
D o m i n a t o r
Hellkite 

B
Frenzy
Fury

C
Ti 300
Ti 500
ZI30
Fx2!!!
TFT20

D
MX
DDR
XP
BS
LOL
ROTFLOL

E
Ultra 
Deluxe
Pro
Exxtreme
Blaster

Plug 
& 

Play?

Slowdown Blues?

A PC Pick-me-up

Contributed by Sriram Sharma

Contributed by Leena Nair

Secret formula for perking up
a sluggish machine.
Contributed by Harsh Priyadarshy

A rose by any other name may
smell just as sweet, but we aren’t
too sure the same can be said for
BSNL (Bharat Sanchar Nigam
Limited). Look where the URL,
bsnl.com, landed us.
Contributed by Anil Patrick R.
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